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FOREWORD

The National Curriculum Framework (NCF) 2005 recommends that
children’s life at school must be linked to their life outside the school.
This principle marks a departure from the legacy of bookish learning which
continues to shape our system and causes a gap between the school,
home and community. The syllabi and textbooks developed on the basis of
NCF signify an attempt to implement this basic idea. They also attempt to
discourage rote learning and the maintenance of sharp boundaries between
different subject areas. We hope these measures will take us significantly
further in the direction of a child-centred system of education outlined in
the National Policy on Education (1986).

The success of this effort depends on the steps that school principals
and teachers will encourage children to reflect on their own learning and
to pursue imaginative activities and questions. We must recognise that,
given space, time and freedom, children generate new knowledge by
engaging with the information passed on to them by adults. Treating the
prescribed textbook as the sole basis of examination is one of the key
reasons why other resources and sites of learning are ignored. Inculcating
creativity and initiative is possible if we perceive and treat children as
participants in learning, not as receivers of a fixed body of knowledge.
These aims imply considerable change in school routines and mode of
functioning. Flexibility in the daily time-table is as necessary as rigour in
implementing the annual calendar so that the required numbers of
teaching days are actually devoted to teaching.

NCF–2005 envisages an increase in the optional number of subjects
available for students of Classes XI and XII. This textbook marks an attempt
in this direction. Its subject matter concerns how we work with computers,
rather than about how computers works. It is expected that this textbook
will be used with the help of methods of teaching which might enhance
the flexible and participatory nature of new communication technologies.

NCERT appreciates the hard work done by the Textbook Development
Committee and its Chief Advisor, Professor M.M. Pant, former Pro-Vice Chancellor,
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Indira Gandhi National Open University, New Delhi. We are indebted to
the institutions and organisations which have generously permitted us to
draw upon their resources, material and personnel. We are especially
grateful to the members of the National Monitoring Committee, appointed
by the Department of Secondary and Higher Education, Ministry of Human
Resource Development under the Chairpersonship of Professor Mrinal Miri
and Professor G.P. Deshpande, for their valuable time and contribution.

As an organisation committed to systemic reform and continuous
improvement in the quality of its products, NCERT welcomes comments
and suggestions which will enable us to undertake further revision and
refinement.

Director

New Delhi National Council of Educational

May 2008 Research and Training

(iv)



Computers have become a way of life in the present day world. That everyone
should be educated about the implications of this technology is the need
of the hour.  Till now NCERT has not proposed a course or brought out a
textbook in this area.  The course outlined for this textbook is an attempt
to design a friendly course that would not only be contemporary but also
leave sufficient scope for expansion into unknown realms of computer
activity that may emerge in future.

The National Curriculum Framework 2005 recommends that theoretical
component of Higher Secondary stage should emphasise on problem solving
methods and that the awareness of historical development of key concepts
be judiciously integrated into the content of a subject. It also recommends
that given the pervasive impact of computer technologies, a course related
to this should address this infrastructural challenge seriously and explore
viable and innovative alternatives with regard to hardware, software and
connectivity technologies appropriate for rural and urban Indian schools.

NCF 2005 states that the book should act as an instrument for achieving
social change in order to reduce the divide based on economic class, gender,
caste, religion and region. NCF also speaks about  tremendous  effectiveness
of the computer and computing technology in shaping modern society
which has created the need for an educated public that can utilise such
technology most effectively for the betterment of society and humankind.
This book is aligned to these broad guidelines of NCF.

Presumably, this would be a coveted book for “everybody”, irrespective
of any particular stream of higher secondary stage, for it deals with the
real challenges that the discipline is trying to solve. It emphasises
development of problem-solving and, equally important, problem –
formulating skills.  It reduces the importance of technology and underscores
the need for learning skills to manipulate the technology.  It focuses on
some of the real problems that come up with the expansion of the technology
– security, piracy and digital identity. Above all, the course focuses as
much on the excitements as on the limitations of the new information

PREFACE
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technology. Effective integration of information and communication
technologies into all curricula assists students in developing the abilities
to use, manage, and understand the technologies.

The National Knowledge Commission refers to preparing a work-force
adequately skilled and oriented to actively participate in the emerging
Knowledge Economy. This book would be a major contributor to developing
the skill sets required for all school leavers.

The Class XI textbook contains fourteen chapters under six themes/
units, viz., Welcome to the World of Computers and Communication
Technology; Workplace Productivity Tools; Communication Concepts and
Skills; Web Publishing Technology; Teamwork and Web Based Collaboration
Tools and Emerging Technologies. The book has been conscientiously
designed and is the result of the renewed efforts of the Textbook Development
Team comprising of school teachers, subject experts, academicians and
technical experts from government, non-government and private
institutions/organisations. Some of the members worked at the advisory
level while others worked towards the actual developmental activity. It is
hoped that the students will appreciate the beauty and logic of computers
and communication technology. It has truly been a team work.

 The course is not biased towards any stream; it can be opted as an
elective subject with any other combination, be it science, commerce, arts
or humanities. The students may or may not continue to study about
computers beyond the higher secondary stage but it seems they will find
the inherent logic behind CCT useful in any other branch they may like to
pursue, be it administration, social sciences, environment, engineering,
technology, biology, medicine or any other branch of knowledge. In order
to prepare a child for worldly wise a full chapter is devoted to “Soft Skills
for Effective Communication”. For those who pursue computers beyond
this stage the content of the book will certainly provide a sound base.

In this book we have tried to bring in a conceptual coherence. The
pedagogy and the use of easily understandable language are at the core of
our effort without sacrificing the rigour of the subject. The nature of the
subject of CCT is such that a certain minimum use of mathematics is a
must. We have tried to develop the mathematical formulations in a simple
and logical fashion as far as possible.

This book has some features which, we earnestly hope will enhance its
usefulness for the students. Each chapter is provided with objectives in
the beginning and a summary at its end for a quick overview of the contents
of the chapter. There are some questions which require critical thinking
which would make a student think about real-time application of CCT.
Further, a large number of solved examples are included in the text in
order to clarify the concepts and/or to illustrate the application of these
concepts in everyday real-life situations. Some Practical activities/Case
studies have been included which provokes students for deep thinking.
Some of these are from real-life situations. Students are urged to solve
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these and in doing so, they may find them very educative. Some items
inside boxes are introduced in many chapters either for this purpose or to
highlight some special features of the contents requiring additional
attention of the learners. Some information has been provided in shaded
box which is meant for supplementary reading and not for evaluation.
Glossary of terms and concepts is given towards the end which will act as
a ready reckoner.

Completing this book has only been possible because of the spontaneous
and continuous support of many people. We express our gratitude to the
Director, NCERT, for entrusting us with the task of preparing this textbook
as a part of national effort for improving general/school education. The
Head, Department of Computer Education and Technological Aids, NCERT,
besides being a member of the Textbook Development Team, was always
willing to help us in our endeavour in every possible way.

The draft got excellent academic inputs from teachers, students and
experts who sincerely suggested improvement during the development of
this book. We are thankful to all those who conveyed these inputs to
NCERT. We are also thankful to the members of the Review Workshop
organised to discuss and refine the first draft.

We welcome suggestions and comments from our valued users, especially
students and teachers. We wish our young readers a happy journey to the
exciting realm of CCT.

M. M. Pant

Chief Advisor

Textbook Development Committee
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EXPERIENCING THE

WORLD OF CCT

Introduction

After completing this Chapter, the

student will be able to:

• identify the basic nature  of

computers and communication

technology (CCT),

• explain the  characteristics of

CCT,

• describe applications of CCT at

home, in education, and in other

fields,

• appreciate the importance of CCT

in real life applications,

• notice the changes brought about

by CCT,

• perceive  the problems of the

digital divide and

• recognise  major national

organisations’ contributions  to

the development  of CCT in

India.

1

With an abundance of electronic devices in general
and, in particular, with a proliferation of computer-
supported technologies and easy access to
communication networks, the world today seems
to begin with an e. It is e-mail, e-learning,
e-business, e-content or even e-waste. In short, it
is an e-world! Electronics is the dominant
technology of our times.

From the wake–up alarm in the morning to
the innumerable devices that we use throughout
the day all machines are programmed. The
programmable machine, the computer, affects
almost everybody, in all walks of life. It connects
people all over the world, without the distinctions
of caste, creed, language and culture, supporting
a communication network that was unimaginable
before.

Objectives “Technology happens, it’s not good, it’s not bad.”

Andrew Grove

Co-founder of Intel Corporation
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1.1 THE WORLD IS CHANGING WITH CCT

All over the world, there is a movement towards an information – based
society. Therefore it seems extremely important that the basic nature
and overall capabilities of CCT are understood and appreciated by all
because computers are information processing tools and
communication technologies enable us to share information. Together
they affect all of us. It is also important that we are able to apply the
technology tools in our work, whatever our field of work may be.

The way these technologies affect all of our lives include:

• Educational, in the way we learn and shape the course of our
learning according to our own interests.

• Technological, in terms of knowledge creation, publishing and distribution.
• Societal, in our living, working and growing and looking at ourselves

in a global context.

Today computers are seen as a personal accessory – portable,
powerful and simple to operate. They can work in any place and
connect us with anyone, any time (Figure 1.1). They are seen as an
extension of the human hand and mind and are essential to every
field of work.

1.1.1 CCT IN HOMES

There are three different types of computers and computer applications
that we encounter in daily life. One, those machines which are dedicated
to a limited set of tasks. Familiar domestic appliances like washing
machines or microwave oven are operated by an electronic device

Figure 1.1 :  A man searching for an address

I see the
building!

But where is
the big tree?

Cut down and
vanished? Let’s

report it – I have the
evidence that it was
here three days ago!
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embedded inside these gadgets. Two, those that are used for specific
and limited number of activities, like playing games and other forms of
entertainment. The third category includes  versatile machines capable
of doing a multitude of tasks, including surfing the Internet.

In our day-to-day life, we use various electrical and electronic devices
such as computers, digital watches, audio systems, CD and DVD
players, washing machines and so on.

Outside home we use lifts, metro trains, coin collection systems in
public telephone booths, coffee and tea vending machines and so on.
These are mostly computer controlled devices. We do not see the
‘computers’; they are embedded inside these devices.

Computers have brought in changes in art and music, photography
and animation, editing and publishing. Digital home theatre systems,
DVD players, digital music devices of which the computer forms an
integral part, makes entertainment low cost and of high quality. The
Internet has emerged as a convenient means of global communication,
information sharing and services. The commonest mode of the Internet
use includes e-mail, chat, surfing information, banking, reservations
and many more. A huge network of millions of computer networks
constitutes the Internet. These networks are connected by telephones,
underwater cables and satellites.

1.1.2 CCT IN EDUCATION

Computers are widely used in schools, colleges and universities. They
are used for computer-aided learning, distance education and
administration. E-learning, training programmes and research are other
areas of the educational field where computers are put to use.

When a physics teacher wants to show the different positions of a
particle in a wave motion, a chemistry teacher wants to illustrate
molecular collision or a biology teacher wants to show a beating heart,
a mathematics teacher wants to show how a regular polygon
approaches a circle when the number of sides tend to infinity or when
an economist wants to illustrate an organic market and so on, a
computer can effectively simulate these phenomena.

Conventional libraries can be computerised with library management
software. It provides facilities to create a database of books, assign
accession number, provide content wise, author wise searching facility,
verify stock and issue notices. One could also go for digital libraries
where books are available in an electronic format and are called
e-books. In laboratories, computers are used as tools  essential for
various processes such as recording, analysing and plotting data for
visual display.

From admission to examination, from staff management to parent
interaction, from student information to public transaction, computers
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make possible automated management and administration of
educational institutions. They are used for student enrollment, collection
of fees, keeping attendance of student and staff, conducting
examinations and announcing results. Besides this, all kinds of
information about the organisation are available on the Net so that
they can be accessed from anywhere.

Computers also make possible transaction of distance learning
courses (often called e-learning). Computer programs or web tools
provide step-wise learning. A student can decide the pace of learning
for himself or herself. E-learning is flexible and convenient. A student
can also attend e-classes. A teacher can supplement classroom
instructions by encouraging self-learning of students through e-classes.
Quality educational materials such as, online e-books, on line video-
audio lectures, career guidance are available at the websites of many
educational organisations and universities.

National Council of Educational Research and Training (NCERT),
Indira Gandhi National Open University (IGNOU), National Institute of
Open Schooling (NIOS) and Central Board of Secondary Education
(CBSE) have their own websites which are accessed by thousands of
visitors everyday.

National Council of Educational Research and Training

NCERT has its own website (Figure 1.2). Information about the
organisation, its programmes and activities, school curriculum and
syllabus, information on day-to-day activities of NCERT are available
on the site. All NCERT textbooks, including this one (Computers and
Communication Technology (CCT); Textbook for Class 11) are available
online for reference purposes. Anyone can access these e-books and
download from www.ncert.nic.in or www.ncert.gov.in.

Figure 1.2 : NCERT’s website
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Indira Gandhi National Open University

IGNOU offers distance education degree programmes in arts, science,
commerce, social sciences and information technology. It has
democratised higher education by
taking education to the doorstep of
the learner. It provides educational
opportunities to employed persons
by offering need–based academic
programmes. The courses available
are professional and vocational.
Above all it is an apex body for
setting and maintaining standards
in distance education across the
country (Figure 1.3).

National Institute of Open
Schooling

NIOS, which offers ‘sustainable and
learner centric education,’ was
established by the MHRD,
Government of India as an
autonomous organisation for open schooling in pursuance of National
Policy on Education. In addition to the general and academic courses,
NIOS offers a number of vocational and community oriented courses.
The website of NIOS (Figure 1.4 ) can be accessed at www.nios.ac.in
and www.nios.org.

Figure 1.3 : IGNOU’s website

Figure 1.4 : Website of NIOS
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Central Board of Secondary Education

CBSE has its own site at www.cbse.nic.in (Figure 1.5). This website
provides information regarding
admission, courses offered, syllabi,
examination results and so on.
Various forms like those for
admission, rechecking of marks and
other purposes can be downloaded
from the website. You can fill and
submit the forms online It saves
time for students and their parents.

The Ministry of Human Resource
Development has designed an
education portal* named ‘SAKSHAT’:
One Stop Solution to Education’
(Figure 1.6).  This portal caters to
the needs of students, starting from
elementary students to research,
scholars, teachers and life long

learners. The portal can be accessed at www.sakshat.ac.in.

Figure 1.5 : CBSE’s website

*A portal is used to describe a website that acts as an entry point or gateway to a wide range of services or

resources,  usually including a search facility, directory of other sites, news, e-mail, etc.

Figure 1.6 : MHRD’s website with Portal Sakshat: One Stop Solution to Education – online
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Most universities and school boards conduct some online
examinations. Compilation of results is computerised using refined
statistical tools and facilitating accurate analysis on multiple
parameters. The computerised list of candidates has students’ photos
and finger print identities for computers to assist in detecting
impersonation and other malpractices.

1.1.3 CCT IN PUBLIC LIFE

CCT offers powerful means to make governance transparent and
answerable to the people. Similarly, they can be used to ensure more
transparency in business practices.

With CCT working in tandem with other factors that strengthen
democracy, such as the Right to Information Bill, we can hope to see
increased empowerment of ordinary citizens. CCT could eliminate the
role of the intermediary who makes profit by keeping information secret
and leaking it selectively to those who please them. Ultimately, CCT
may help to balance the sharp socio-economic divides in our society by
giving access to those who were kept away from the mainstream due to
lack of relevant information.

1.2 CCT AND THE DIGITAL DIVIDE

From a relatively slow-changing, multi-structured society where many
disparities co-existed, India is now passing through a period of
transition. At such times there is a lot of pressure on society to become
homogeneous. That is when the inequities between different sections
become all the more evident.

One such inequality, called the digital divide, separates those who
have access to the digital world (computers and related technologies)
from those who do not have this access. While one section of young
people may have access to CCT at home, at school and in their mobile
phones, the majority may get a chance to experience CCT only
occasionally. It is obvious that the ones with the advantage will keep
up with the technological growth while the others would keep falling
further behind in terms of information access.

This divide could cause strain, even conflict, in society. However,
the tension can be eased:

• if everyone knows what they can get out of CCT,
• if we can cut the costs of access,
• if there are enough public Internet facilities available, and
• if enough sites in Indian languages come up.

We may see a great knowledge revolution in our own lifetime. Access
to the global network in particular and acquaintance with
communication network may help us realise a new kind of freedom –
to think independently, collaborate with others to solve common
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problems, to realise what we want and need for ourselves and not
what uptill now someone else thought was good for us.

1.3 CCT AND E-COMMERCE

E-commerce employs computers in different areas of commerce such
as marketing, customer visit, product browsing, shopping basket
checkout, tax and shopping, receipt and process order while e-business
offers services pertaining to processing transactions, documentation,
presentations, financial analysis, home based services, inventory
management and gathering product information using CCT.

All leading banks, including the State Bank of India (Figure 1.7)
provide Internet banking facility. With this facility one can check account
balance and perform bank transactions from anywhere. We can see
account details, pay a bill and print account statement online. Also,
the bank provides SMS alert service, so that, whenever bank transaction
takes place, an SMS is sent by the bank to our mobile phones.

Figure 1.7 : Web Portal of State Bank of India

The digital nature of CCT results in convergence.

Text, photos, statistical tables, maps, music, movies are all produced digitally, in

that they are coded and made up of zeros and ones. This makes it convenient to

bring them together onto common platforms. They can be brought into play,

interchanged and transformed, and also circulated digitally.
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1.4 MAJOR NATIONAL ORGANISATIONS WORKING
IN THE AREA OF CCT

1.4.1 NATIONAL INFORMATICS CENTRE (NIC)

National Informatics Centre (Figure
1.8) of the Department of Information
Technology is providing network
backbone and e-governance support
to Central and State Governments,
Union Territories administrations,
districts and other government
bodies in India. It offers a wide
range of ICT services including
N a t i o n w i d e C o m m u n i c a t i o n
Network for decentralised planning,
i m p r o v e m e n t i n g o v e r n m e n t
services and wider transparency in
national and local governments. NIC
assists in implementing Information
Technology Projects and is also
responsible for bringing computerisation in the lives of the Indian people.

1.4.2 NATIONAL ASSOCIATION OF SOFTWARE AND SERVICES

COMPANIES (NASSCOM)

NASSCOM (Figure 1.9) is the premier trade body and the chamber of
commerce of the IT-BPO industry in India. It is a global trade body with
more than 1200 members who are broadly in the business of services,
products, IT infrastructure management, R&D services, e-commerce and
web services, engineering services, offshoring, and animation and gaming.

Figure 1.8 : NIC’s website (www.home.nic.in)

Figure 1.9 : NASSCOM’s website (http://www.nasscom.in)
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1.4.3 DEPARTMENT OF INFORMATION TECHNOLOGY

Department of Information Technology (Figure 1.10) is under the

Ministry of Communications and Information Technology, Government

of India. Its main objective is to make India a global information

technology super power and a front-runner in the age of information

revolution, to bring the benefits of electronics to every walk of life

and to develop the Indian electronics industry as a global player. Its

website has an important portal, viz., The India Portal

(www.india.gov.in),  v‘single window access’ to information and

government to consumer services to be electronically delivered from

all state sector institutions and organisations. It provides

multilingual content and had received the Best e-Governance Award

in Technology at the national level announced by the Computer Society

of India (CSI) in 2006.

Figure 1.10 : Website of Department of Information Technology

(http://www.mit.gov.in/)
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EXERCISES

1. List some other uses of computers at home which are not mentioned in this
chapter.

2. List different activities performed by a corporate house using computers.

3. Visit any nearby industry and list the use of computers there.

4. List the advantages of computer usage in an industry.

5. List the advantages of computers in commerce.

6. Observe your school carefully and list different departments where computers
are used. Also, state the purpose for which they are used.

7. List the advantages of a digital library.

8. Check which library management software is used by your school ?

9. List the advantages and disadvantages of e-learning.

10. List the advantages of using computers in design and drawing.

REFERENCES

Websites
1. www.mit.gov.in
2. www.home.nic.in
3. www.wikipedia.org
4. www.encyclopedia.com
5. www.onelook.com

Education
1. www.ncert.nic.in and www.ncert.gov.in
2. www.sakshat.ac.in
3. www.ignou.ac.in
4. www.cbse.nic.in
5. www.nios.ac.in
6. www.education.nic.in

Summary

• Powerful technology is within our reach.

• It has overpowered the limitations of time, distance and money.

• CCT links people all over irrespective of distances between them.

• CCT has changed our life pattern.

• Computers have been useful at home as appliances, supporting entertainment/games
and for surfing the Internet.

• CCT are capable of contributing a lot to education, buiseness, e-governance, etc.

• Easier access to CCT can help bridge the digital divide.
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Internet Banking
1. www.onlinesbi.com

Travel Planning
1. www. Indianrailways.gov.in
2. www.india-airlines.nic.in
3. www.yatra.com
4. www.makemytrip.com

Searching
1. www.google.com
2. www.search.yahoo.com

Physics
1. www.jhuapl.edu
2. www.ioffe.rssi.ru
3. www.fzu.cz
4. www.nplindia.org



COMPONENTS

OF CCT

Introduction

After completing this Chapter, the

student will be able to:

• trace the evolution of computers,

• describe the computer and its

devices,

• list the components of a computer

system,

• compare various input and output

devices,

• classify various ports,

• understand  different storage

devices,

• recall the evolution of

communication technology,

• explain computer languages and

their development,

• compare  various types  of

software and

• interpret steps involved in

programming.

2

In the first chapter we were introduced to a device
that has changed the way we work, live and play.
Only once in a lifetime does a new invention come
about to touch every aspect of our lives in this
way. This incredible invention is the computer.

The electronic computer has been around for
over half a century, but its ancestors have been
around for 2000 years. However, only in the last
40 years has it changed society. From the first
wooden abacus to the latest high-speed
microprocessor, the computer has changed nearly
every aspect of our lives for the better.

Objectives I think it’s fair to say that personal computers

have become the most empowering tool we’ve

ever created. They’re tools of communication,

they’re tools of creativity, and they can be

shaped by their user.

Bill Gates
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2.1 HOW DOES ONE PERCEIVE THE COMPUTER?

Let us take a tour to the Computer Laboratory of our school. We may
see an assemblage like the
one shown in figure 2.1. But
then we have also seen
laptops. What differences do
we notice? Let us gather
information about devices
that look different from these
but still are computers.

Computer indeed derives
its name from its essential
function, namely, to compute.
In a rudimentary sense any
c o m p u t a t i o n r e q u i r e s
primary data and operations

performed between them. This would mean receiving data, processing
them, keeping in memory the data at different stages of operation,
having some set of data that is fundamental to all operations and
giving outcomes of operations. Hence, essentially a computer means a
system of components (i) to input data and display output i.e. Input
and Output devices; (ii) processing unit called the Central Processing
Unit (CPU) and (iii) the Memory space which can be Read Only Memory
(ROM) or Random Access Memory (RAM). One should realise that it is
not the external appearance by which a computer is understood in as
much as its functionalities.

In fact, the memory in terms of capacity (space) and speed, and the
processing capacity of the CPU (speed with which it processes)
characterise computers and distinguish them. Also the manner in which
data is presented determines a classification of computers, namely,
analogue or digital computers.

2.1.1 CLASSIFICATION OF COMPUTERS

Computers can be classified into two major types based on their way of
handling data. These are as follows:

1. Analogue Computers : They work on continuous variables like waves
of the signal, their amplitude, etc.

2. Digital Computers : They work on the principle of binary digits i.e.
0 and 1. Any value or symbol is represented through a binary value.

Figure 2.1: A Computer System

Hybrid Computers : They are a combination of good features of analogue and digital
computers. Digital counterparts convert the analogue signals to perform Robotics
and other Process control. Hybrid computers are used to control air traffic and
radar of national defence.
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Digital computers can also be classified according to their physical

structure (size) and the purpose of their use. Based on capacity, speed
and reliability they are classified into three categories:

I. Microcomputer : The term “Microcomputer” was introduced with

the advent of single chip large scale integrated circuit (LSIC) computer

processors. It is the smallest single user computer and its CPU is a

microprocessor. It can perform the same operations and can use the

same type of instructions as other computers. These are the most
frequently used computers, better known by the name “Personal

Computers.”

Types of Personal Computer

In our everyday use, the term “computer” refers to

digital computers, a typical example being the

common personal computer (PC). These can be
classified mainly as Desktop Computers, Laptop

Computers, Palmtop Computers, Personal Digital

Assistant (PDA), Tablet PC, etc.

Desktop Computers

Desktop computers are larger and not meant to be

portable. They usually sit in one place on a desk or
table and are plugged into a wall outlet for power.

The case (chasis) of the computer holds the CPU.

When this case lies flat on the desk then it is

generally referred to as a Desktop Model
(Figure 2.2)  else when  it stands vertically on the

desk in the form of a tower, it is referred to as a
Tower Model (Figure 2.3). The computer usually

has a separate monitor. A separate keyboard and

mouse allow the user to input data and commands.

The main advantage of tower models is that there

are fewer space constraints, which makes

installation of additional storage devices easier.

Laptop

This is a small, portable computer (Figure 2.4),

small enough that it can sit on the lap. Nowadays

laptop computers are also called notebook

computers.

Hand-held Computers/Palmtop

This computer is smaller than a laptop. It is so
small that it literally fits in a palm, hence, referred
to as palmtop (Figure 2.5). Because of their small
size, most palmtop computers do not include disk Figure 2.4 :  Laptop

Figure 2.3 :  Tower Model

Figure 2.2 :  Desktop Model
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Server

The term server actually refers to a computer’s function rather than to a specific
kind of computer. A server runs a network of computers. It handles the sharing of
equipment like printers and the communication between computers on the network.
For such tasks a computer would need to be somewhat more capable than a
desktop computer. It would need:

• more power
• larger memory
• larger storage capacity and
• high speed communications.

drives. Compared to full-size computers, palmtops
are severely limited, but they are practical for
certain functions such as phonebooks and
calendars. Sometimes these are also called pocket
computers.

Personal Digital Computers/Assistants

Palmtops that use a pen rather than a keyboard
for input are often called PDAs (Figure 2.6). This is
a hand–held device that combines computing,
telephone fax and networking features. PDA can
function as a cellular phone, fax sender and
personal organiser. PDA was pioneered by Apple,
which introduced the Newton Message Pad in 1993.

Tablet PC

It is a notebook slate-shaped mobile computer
(Figure 2.7) which is equipped with a touchscreen
or graphics table which allows the user to operate
the computer with a digital pen or stylus or
fingertip. A wireless keyboard can be connected
to this for
extensive text

input. Other models of tablet PCs
are convertible model (screen can
rotate over the keyboard) and hybird
model where the screen is fixed on
the keyboard.

Workstation

A powerful, single user computer, a
workstation is like a personal
computer, but it has a more powerful microprocessor and in general, a
higher quality monitor used in computer aided design and other
applications requiring a high end, usually expensive, machine with
considerable calculating or graphics capability.

Figure 2.5 :  Palmtop

Figure 2.6 : Presonal Digital Assistant

Figure 2.7 : Tablet PC
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II. Mini Computer : It is a multiuser computer capable of supporting
up to hundreds of users simultaneously. They are usually more powerful
compared to microcomputers. Minicomputers are also known as mid
range computers as their cost and computing powers lie in the middle
range between micro and mainframe computers. Minicomputers are
used for multiusers and interactive applications.

III. Mainframe Computer : A powerful multiuser computer, the
mainframe computer, is capable of supporting many hundreds or
thousands of users simultaneously. They are capable of faster processing
and greater storage area. They are used in research organisations,
large industries, large businesses and government organisations, banks

and airline reservation where a large database is required.

Figure  2.8 :  Super Computers

Super Computer

There is another category of computers, the Super Computer which is somewhat

similar to the mainframe computer. These are largest, fastest and most expensive.
They are used for massive data processing and solving very complicated problems
like weather forecasting, weapons research and development, rocketing, atomic,
nuclear and plasma physics. The processing speed of super computers lies in the
range 400-10000 million instructions per sec (MIPS). Examples of the
supercomputer are Eka which was developed by the TATA Group, Pune (India) in
November 2007. It is the first in Asia and the 8th fastest supercomputer in the
world as of June 2008 (Figure 2.8 (a)) PARAM (Figure 2.8 (b)) developed by CDAC
in Pune (India), CRAY 3 (developed by control data corporation, JAPAN), SX-3R
(25.6 GIGA Flops, NEC make) HITAC S-300 (32 GIGAFLOPS, HITACH make) etc.
HITAC S-300 is the latest and the fastest Super Computer.

(b) Param (a) Eka
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Table 2.1 : Evolution of Computers

Electrical

Electronic

Component

Vacuum tubes

Transistors

Integrated

circuits (ICs)

Very large

scale

integration

(VLSI)

Ultra–large

scale

integration (ULSI)

Main Features

Bulky, slow,

unreliable,

consume more

space and

power

Less power

consumption,

smaller in size

More memory

capacity,

much smaller

in size and

weight

Development

of

microprocessor,

more speed

and reliability

Much faster

and very

powerful

Software

Machine

language and

assembly

language

High level

languages (HLLs)

like FORTRAN,

Pascal,

COBOL, etc.

General

purpose HLL,

concurrent

programming

Webbased

technologies,

very user

friendly and

sophisticated,

artificially

intelligent

software

Being

Developed

Memory and

I/O Devices

Limited core

memory,input

through punch

cards

Magnetic core

memory as

main memory,

magnetic tapes

and disks

Semiconductor

memory as

main memory,

hard disks as

secondary

Optical disks,

VCDs, DVDs,

blue ray disks

and high

capacity hard

disks

Being

Developed

Type of

Computer

Analogue

Analogue

Digital

Digital

Digital

The future is promising for the computer industry and its technology.
The speed of processors is expected to double every year and a half in
the coming years. As manufacturing techniques are further perfected,
the prices of computer systems are expected to steadily fall. However,
since the microprocessor technology will be advancing, its higher costs
will offset the drop in the price of older processors. In other words, the
price of a new computer will stay about the same from year to year, but
the capacity of the technology will steadily advance.

2.1.2 EVOLUTION OF COMPUTERS

Table 2.1 gives a glimpse of the evolution of computers.
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2.1.3 LET US KNOW THE COMPUTER

A computer is basically a device that can respond to a specific set
of instructions in a well – defined manner, execute a prerecorded
list of instructions (a program) and quickly store and retrieve large
amounts of data. Since a computer is understood more by its
functions than its appearance, let us see what functions each of
the components performs.

2.1.4 ORGANISATION OF THE COMPUTER SYSTEM

A computer system (Figure 2.9) is usually defined as a combination of
hardware and software. Computer hardware is the physical equipment.
Software is the collection of programs that make the hardware do its job.

Each of the hardware and software components has undergone
refinements and modifications depending upon the limitations encountered
by the users and the endeavours to overcome these limitations to meet
new requirements and challenges. Let us therefore understand the
computer from two perspectives, namely, the general functions of its
components and the evolution these components have undergone.

Figure 2.9 : Components of a computer system

2.2 HARDWARE

In order to accomplish a particular task the computer performs a series
of jobs, namely, Input, Storage, Processing and Output, which it handles
in a very special way as follows:
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• It accepts the data (input) from the user.
• The computer has memory chips, which are designed to hold data

until it is needed.
• It processes this data into information. The computer has an electronic

brain called the Central Processing Unit, which is responsible for
processing all data into information according to the instructions
given to the computer.

• It then returns the processed information (output) to the user.

For performing each of the jobs listed above, every computer has
special parts/components, for Input Device, Storage Device, Central
Processing Unit and Output Device.

2.2.1 INPUT DEVICES

General Functions

It provides a means for the machine to communicate with its external
environment by accepting (or reading) data and the program.

1. It converts the data based on the program into computer acceptable
form through an input interface.

2. It supplies the converted instructions and data to the computer
system for further processing.

The very scope of computers is enough to understand that there is
no limit to the form and type of data that serves as an input. Sometimes
the input is in the form of text in normal language, sometimes it is a
picture, sometimes it is a voice input like a song. Selection of an
appropriate input device will improve efficiency and keep human
interaction minimal.

Types of Input Devices

On-line or Direct Data Entry Devices : These devices are under the
control of the CPU and communicate directly with the CPU, that is,
these are connected via cable to the CPU. This process of data entry
may be time consuming and may have errors but by using these devices,
we can avoid having to capture data from paper. These are also known
as Interactive Input Devices and are classified as:

(a) Keyboard
(b) Locator devices
(c) Interface or pick devices.

(a)  Keyboard

The most common input device is the keyboard (Figure 2.10). The
modern keyboard generally contains 104 keys and is called the
QWERTY keyboard because of the sequence of keys in the top row,
which are similar to those of a standard typewriter. A keyboard is
used for a wide range of tasks but is well known for its capability to
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enter data, which is copied from the original paper
documents (such as name and address details on
a form). Keyboards are also used for typing letters,
memos, reports and other documents using word
processing software.

(b)  Locator devices

Locator devices are used to control the location

or position of the cursor on the screen and they allow us to provide

the necessary input. Generally, locator devices are good for gross

movement but not for precision work. Different locator devices are

discussed in Table 2.2.

Figure 2.10 : Keyboard

Table 2.2 : Various Locator Devices

Mouse It is a small hand-held device used to

indicate a position or movement on a

computer’s display screen by rolling it

over the mouse pad/flat surface. There

are different types of this device like

physical, optical and laser mouse.

Physical mouse works on the principle

of the movement of a ball, whereas

optical and laser mouse works on the

bases  of light signals (i.e. have no

mechanical movement inside.)

Trackball It is a movable ball mounted on top of

a stationary base, which can be rotated

manually using a finger and it also has

two buttons like a mouse for performing

operations similar to mouse. Three

dimensional track balls are available

that allow the movement not only the

traditional left/right and forward/

backward movement but also up and

down as well.

Touch pad It is a flat touch sensitive rectangular

surface performing similar operations

as a mouse or a track ball.

Mouse, track ball and touch pad are point and click devices and are used to start

the task by positioning the pointer, selecting and dragging items/objects. They

can also be used to draw various simple/complex graphic images/pictures.

Name of Description Picture/
the Device Diagram
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(c) Interface/Pick Devices

Pick devices are used to select an object on the screen. The object may
be text or graphic. Examples of pick devices are light pens and touch
screens.

Light Pens

The light pen is a pen-like light-sensitive device that feeds a narrow
electrical pulse generated by  a pointing device directed towards the
screen. It is connected by a wire to the computer terminal that detects
the signals from the screen. Light pens may be used in place of a
mouse or a keyboard, particularly for menu based applications where
an option may be selected by pointing on it. They are used for Computer
Aided Designing  (CAD) and drawing purposes. Moreover, with the help

Digitising Tablet Digitising tablet is an electronic plastic

board, on which specifying a location

corresponds to a location on the

computer screen. It  is considered to

be an absolute locator because it is very

precise and when a stylus (pen) is

placed in a particular position the same

signals are produced each time. It is

in this that it differs from other locator

devices. Digitisers are used by

architects and engineers in Computer

Aided Designing (CAD) for designing

buildings, cars, mechanical parts,

robots, etc. Moreover, they are used in

the Geographical Information System

for digitising of maps.

Joystick Joystick is a wired/wireless control

device which is usually used for playing

video games. These are relative locators

in which the direction of the push

determines the change of position and

the amount of deflection determines a

change of speed (see Figure).

A joystick not only indicates two

dimensional positions by moving the

ball rotationally but also three

dimensional position, where the third

dimension is indicated by the rotation

of the rod. Games software, flight

simulators, etc. often use joystick as

the input device.
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of a light pen, engineers, architects or fashion designers can draw and
edit the designs directly on the screen, though for editing a drawing
keyboard may be used to select colours, lines with varying thickness,
cropping or enlarging the drawings. It is also used to read bar codes
from products that are available in big departmental stores.

Touch Screens

Touch screens are monitors on which the user makes selections by
touching the screen, rather than moving a cursor to the location with
external locator devices.

Touch screens are often used in situations where users are likely
to have a low level of competence in using computer keyboards. Touch
screens are sometimes used in restaurants, building societies and
travel information systems.

Source Data Entry Devices : We have observed that in  grocery stores, the
clerks merely wave the product over a laser scanner/barcode reader, which
automatically enters the product code and retrieves the corresponding price
of the product automatically. The earlier practice was to enter the code/
product name by using a keyboard (a time consuming process). The laser
scanner/barcode reader comes under Source Data Entry Devices category,
which increases the efficiency of a user. These devices help us in entering
the data directly from the source, without any human intervention.

The devices used in this category are:

(a) Video digitiser
(b) Digital camera
(c) Scanning devices
(d) Voice input
(e) Remote control
(f) Magnetic stripe reader
(g) Sound sensor – microphone
(h) MIDI instrument.

Source Data Entry Devices

(a) Video Digitiser

A video digitiser captures television pictures from devices such as a
TV set, video camera or video recorder and converts them into a digital
format that a computer can use for display, storage or general
manipulation. A video digitiser is an ideal tool for capturing images
from real-life scenes to incorporate into computer work. It is used to
convert still or moving images into a digital format required for
computerised presentation. Taking video pictures or frames from video
files is known as ‘frame grabbing’.

A video digitiser may be required for video conferencing. (If a digital
video camera is used there will be no need for a video digitiser.)  It can
also be used to make television advertisements and pop videos, etc.
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Advantages

• Video digitisers allow us to capture real-life images which are often
more appropriate than drawings.

• Captured images can then be transferred to paper.

Disadvantages

• A fast computer with a large memory capacity is required to cope
with the large amount of data involved.

(b) Digital Camera

A digital camera (Figure 2.11) stores images (digital pictures) in the
memory and does not use celluloid films as in the case of ordinary
cameras. Each digital picture is made up of thousands of tiny dots,

called pixels (picture elements), and the camera
stores data about the colour of each dot. The
picture quality is determined by the number of
dots representing a specific picture. The
resolution of the image is expressed in Dots Per
Inch (DPI) defines. Higher the DPI, better the
resolution . Most cameras allow the user to choose
the resolution needed for a picture. Once the
photograph is stored in the camera it can be
transferred to a computer where it can be edited,
printed or more permanently stored. Some
cameras store images on a floppy disk or memory

card so that they can be easily transferred. Other cameras are
connected to the computer with a lead (cable) and special software
is used to transfer the image.

Advantages

• There is no developing cost, no film is needed and we can insert
images directly into a document on the computer.

• You can edit, enlarge or enhance the images.
• An image can be saved with multiple shots and the best one can be

saved. That is, there is no wastage like a miss-shot in ordinary
cameras.

Disadvantages

• Digital cameras are generally more expensive than ordinary cameras.
• When the memory is full they can be connected to a computer to

download the stored images (or the images can be deleted from
memory) before they are used again. This is not as convenient as
simply changing a film.

Figure 2.11 : Digital Camera

(Some digital cameras overcome this problem by using floppy disks or other storage
devices to store images before they are transferred, but floppy disks cannot hold
many images and other devices are expensive).
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(c) Scanning Devices

(i) Scanner

A scanner is a device which can capture still images
or even text, to be stored and used on a computer.
The scanner throws a light beam onto the paper
and measures the amount of light reflected back by
each part of the page. Like a digital camera, the
page is split into tiny pixels (dots) and a number
representing the colour of each dot is sent to the
computer. Scanner software usually allows the user
to choose between high and low resolution. Very
high quality images take up a lot of memory.

Most scanners need to place the paper on a
glass plate inside them for scanning similar to  a
photocopier machine. These are called flatbed
scanners (Figure 2.12) and typically use a charge–
coupled device (CCD) as a image senser. This
usually come in A4 size or larger (such as A3), but
there are also some small hand-held ones (Figure
2.13) often used to read text such as bar codes.

Another type of scanners used to capture the
highest resolution from an image are called drum
scanners (Figure 2.14). These scanners spin the
film around on a drum while a fixed laser or other
beam of light looks at the art as it spins. The beam
is then picked up by a very sensitive vacuum tube
called a photomultiplier tube (PMT). This big single,
fixed tube is much more sensitive to light than
any of the tiny pixels on CCD and therefore can
see a broader range of light from white to black.
At also sees it without the noise of a CCD. Drum scanners are good
because the image is picked up by a much more sensitive PMT.

Advantages

• Any image can be converted from paper into digital format and
later enhanced and used in other computer documents.

Disadvantages

• Images take up a lot of memory space, but it is possible to reduce
the size of the data file by reducing the resolution (number of dots
per inch) or by using different ways of storing the data i.e., different
file formats.

Whether to go for a flatbed or a drum scanner depends upon the
objectives of our scanning. Table 2.3 gives the comparison of flatbed
and drum scanners.

Figure  2.12 : A flatbed scanner

Figure 2.13 :  A hand held scanner

Figure 2.14 : A drum scanner
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Table 2.3 : Flatbed Scanners Vs. Drum Scanners

Flatbed Scanners

Line-at-a-time scanners

High end flatbeds scan at resolution
range from about 1500 to 5400 dpi

Illuminate the original with a whole line
of light at a time that lights up a long
thin strip of the original

Reasonable cost

Smaller in size

Drum Scanners

Flying-spot scanner

Good drum scanners can resolve 8,000
to 11,000 dpi optically

Illuminate the original with a tiny spot
of light, which effectively flies across
the original

Expensive

Very large size

Hand-held digital cameras and camcorders are field scanners because they scan
a whole 2-dimensional field at once.

(ii) Optical Mark Readers (OMR)

Optical Mark Readers are able to detect marks on paper. A pre-printed

document is prepared for users to select certain areas to put a line or

a mark. A document like this is scanned using reflected light to detect

dark shadows.

Universities and educational institutes often use pre–printed

enrolment forms where students have to enter a mark with a medium

or soft pencil. Multiple choice questions in entrance examination papers

often require a candidate to make a mark to indicate the answer. The

student will pencil a line through the option of their choice.

Questionnaires and surveys may also use this technique.

Advantages

� Simply selecting and marking a choice in the right location on an

OMR form is easier than typing writing in data.

• Documents can be checked evaluated very quickly by scanning

them with only a few chances of error (only 2–3% with modern

OMR machines).

Disadvantages

• Careful handling of forms is needed. Badly damaged, creased or

folded forms may be rejected.

• They can only be used when the data to be input can be selected by

marking with lines. Because every option must be catered for, the

forms are sometimes not very easy for the user to understand. This

may introduce errors.
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(iii) Optical Character Readers (OCR)

Optical Character Readers (OCR) are devices that can detect patterns
of marks which are in character format (numbers, letters, punctuation
and some special characters like ‘ – , @ ’, etc.). Only printed characters
can be recognised because it is not easy to cater for different styles of
handwriting. The characters are converted by a scanner from picture
format into coded characters that the computer can work with. This is
normally in ASCII format (American Standard Code for Information
Interchange). OCR software can be purchased separately for use with
a standard A4 scanner. OCR is often used to scan text for use in a
word processor.

Advantages

• When a computerised document has not been saved and only printed
text is available, it is possible to use OCR to scan in the text for
later editing and re-arrangement.

Disadvantages

• Some characters cannot easily be interpreted and errors occur
during conversion. This is especially true if there are a lot of
diagrams and characters laid out in a way the software cannot
interpret.

(iv) Magnetic Ink Character Recognition (MICR)

Characters which have been printed using magnetised ink can be recognised
using a Magnetic Ink Character Reader device. This type of data collection
has limited use and it is mainly restricted to banking systems because of
the expensive equipment involved. Cheques are pre-printed with some
code and account number. When a cheque has been written the data
input clerk also has to mark the cheque amount in magnetic ink.

MICR is used for Bank cheque processing.

Advantages

• Fast processing of large volumes of data.
• It is a fairly secure method of data collection as the shape of the

characters cannot be changed without expensive equipment.
• This method of input is very reliable as the number of errors

generated during the reading of documents is negligible.

Disadvantages

• MICR is expensive to use because special equipment is needed to
create the characters as well as to read them.

(v) Bar–Code Readers

Bar-codes (Figure 2.15) are a series of thick and thin vertical lines
grouped together. Bar-code readers (Figure 2.16) are the devices used
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to input data from such sets of Bar codes. The
reader uses a laser beam to read the series of
thick and thin lines which represent the barcode
number. Almost every product we see on
supermarket shelves has a barcode. The barcode
is 13 digits long and there are four main
divisions. The first part of the barcode (two digits)
represents the country, the second part
represents the manufacturer’s code (five digits),
the third part represents the produce code (five
digits) and there is a final digit, which represents
the check digit. This last digit is a calculated
digit to ensure that the barcode is read properly.
If there is an error, the reader usually beeps and
the operator must key in all the digits manually.
When the barcode is read, it locates the correct
product on the inventory file, stored on the
computer’s disc. The price is read from the file
and a sale is registered, producing a record on
the customer’s receipt. The number filed in the
inventory file is reduced by one.

Bar codes are used on library tickets, airport
baggage labels, books, supermarket products,

clothes and on many other retail items. Barcode readers are used in
most situations where there is an Electronic Point of Sale terminal
(EPOS terminal), for example: department stores, supermarkets.

Advantages

• Fast and accurate data entry.
• It is possible to store all the details about the country of origin and

manufacturer as well as the product code itself. These are recorded
in a standard format within the barcode.

Disadvantages

• If the barcode is damaged the barcode reader cannot read it. It is
then time consuming to enter all the separate digits using a keypad.

(d) Voice input

We can now input data by simply talking into a microphone and using
special software to recognise the voice. Users should be trained in
the software regarding correct pronunciation of the words before the
speech can be interpreted and transferred to the computer. Some
computer systems can respond to voice commands and can carry out
tasks because the spoken word is interpreted by the software and
converted to instructions. These can be used for inputting text to
word processing software, controlling devices such as electronically
controlled doors and machines.

Figure 2.16 : Bar code reader

Figure 2.15 : Bar  code
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Advantages

• Voice input is extremely useful for those users unable to use
keyboards or mouse.

Disadvantages

• The system must be able to recognise the voice of each user. ‘Teaching’
the software can be tedious and time consuming.

• Speech recognition software is still not very accurate.

(e) Remote Control

Remote control devices are used for transmitting data when the user
is at some distance from the processor. Devices such as video recorders
can accept data which is programmed into the system from a remote
handset. Special keys for certain tasks or selections are usually found
on the handset. An infrared sensor on the main processing unit picks
up the signals when keys are pressed. It is used to enter data from a
distance.

Advantages

• The device provides the user with the convenience of inputting and
working, away from the processing unit.

Disadvantages

• Small remote devices can easily be misplaced.
• The unit and remote need to be quite near to each other and should

have no other objects between them which may interfere with the
signals sent.

(f) Magnetic Stripe Reader

Magnetic stripes are the dark-looking stripe that may be seen on
the back of many plastic cards, for example, bank cards. The magnetic
stripe holds data about the owner of the card, a bank card will
contain details such as the bank account number (the card owner’s
individual account number) and sort code (the code that identifies
the branch of the bank where the account is held).
The device (Figure 2.17) reads the data on the
magnetic stripe and money can be taken from
the correct account to pay the bill. The money is
taken from the bank account, not from the card.
Data on a magnetic stripe does not change and
there is no balance recorded on the card. It may
be noted that the card does not contain details of
the credit limit. Magnetic stripe readers are often
seen at supermarkets and in many different types
of shops, in fact anywhere where there is a ‘point
of sale’ (somewhere we pay for our purchases).

Figure 2.17 : Magnetic stripe reader

and debit card
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When the data is read electronically, the point of sale is called EPOS
(Electronic Point of Sale).

Advantages

• The card can be read many times without damaging the stripe.
• The data is not visible to people because a machine is needed to

read the data (although with debit cards the bank details are
actually displayed on the card as well).

• Putting magnetic stripes onto cards is not expensive so the cards
are quite cheap to produce.

• The data from the stripe is read very quickly and more conveniently.

Disadvantages

• Magnetic stripes may get damaged or the magnetic stripe reader
could break down.

• The biggest disadvantage of magnetic stripes is that ordinary
equipment can read but not change the data. That is why Smart
Cards are gaining more popularity. These cards contain a small chip
(or tiny processor with some memory) instead of a magnetic stripe.
The data on the chip may then be changed as the smart card is used.

(g) Sound Sensor Microphone

A sound sensor, which is a microphone (Figure 2.18), is a device that
detects sound and inputs it to the computer, and then
the sound which is analogue in nature is converted
into digital format.

The person using the computer speaks into the
microphone. Speech recognition software on the
computer converts what the person has said into
text. The text is displayed on the screen and can be
saved as a word-processed file. Speech recognition
is getting more reliable though it is necessary to
spend some time ‘teaching’ the system to recognise
the user speech. Remember, it still does not always
make accurate conversions to text.

Some users record special sounds, both voice
and music, from any source. These sounds may be

used in computerised presentations, for example, multimedia teaching
software.

Advantages

• People with a range of disabilities can be benefited from the use of
microphones and speech recognition, for example, those who cannot

use a keyboard. They can create word-processed documents by
speaking instead of typing. Moreover, many devices in the home
can now be controlled by voice.

Figure 2.18 : A sound sensor–

microphone
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• Recording our own sounds means that we can add spoken messages

or music to our own presentations or even e-mails.

Disadvantages

• There should be no background noise while recording, otherwise
sound may become distorted. Cutting down the background noise
is sometimes difficult and the sound recorded using a microphone

is often not very good.
• Sound sampling (converting the analogue sound to digital format

using software) often produces very large data files.

(h) MIDI (Musical Instrument Digital Interface) Instrument

It is a serial interface standard that allows
connections of music synthesisers, musical
instruments and computers.There are a

variety of musical instruments such as
keyboards, guitars and drums, which send

and receive electronic messages. If a musical
keyboard is connected to a computer using a
MIDI instrument (Figure 2.19), the musical

information such as pitch is converted to digital
data which can then be stored on the computer.

The music industry uses MIDI to input
music directly into a computer so that it can

be edited and developed, often by mixing it with other sounds which
are input from a microphone. Some programs allow its user to enter a
tune from a musical instrument, then convert this into written music,

which can even be printed out.

Advantages

• Once the tune has been played on the musical instrument, all the
details are held on the computer. These details may then be changed.
It is possible to speed up the tune, slow it down or even make it

sound like a completely different instrument.
• The data stored is very compact and takes up about 1/20th of the

space taken up by even the lowest quality recorded sound samples.

Disadvantages

• A musician is required to play the instrument to acquire the input,
so some musical knowledge is required.

• To take advantage of the digitally recorded sound, knowledge of
software and music is required to edit recorded tunes.

2.2.2 MEMORY OR STORAGE DEVICES

Memory is required in a computer to store programs and the data
processed by programs.

Figure 2.19 : Musical Instrument

Digital Interface
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Computer memory is made up of a large number of cells. Each cell is
capable of storing one bit of information in the form of binary numbers.

Memory System

Memory in a computer system is required for the storage and subsequent
retrieval of instruction and data. A computer system uses a variety of
devices for storing instructions and data required for its operations.
Normally, the information to be stored on a computer is classified in
two basic categories – data and instructions.

Although a memory system is a very simple system, it exhibits a
wide range of technology. But unfortunately, faster memory is more
costly. On the other hand, memories with smaller cost have very high
access time. This is the time taken by the CPU to access a location in
memory. This results in slower operation of the CPU. Thus, the cost
versus access time has led to a hierarchy of memory where we
supplement fast memories with larger, cheaper and slower memories.
Therefore, memory system may have different types, costs,
organisations, technologies and performances. (Figure 2.20)

Computer Memory Hierarchy

Figure 2.20 : The Memory Hierarchy

Types of Memory

A memory system can be considered to consist of three types of
memories. These are as follows:
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1. Internal processor memories
2. Primary memory or main memory
3. Secondary or auxiliary memory

Any storage unit of a computer may have the following characteristics:

Storage capacity is the amount of information/data a storage unit
can hold. Accessing the data to/from these memories may be fast or slow.

The speed and availability of inexpensive memory has had enormous
impact on computer technology. The high speed memory devices are
more expensive and occupy less space in comparison to the slow speed
memory devices.

Internal Processor Memories

These consist of the small set of high-speed registers and high speed
buffer memory (cache) which are internal to a processor and are used
as temporary locations where actual processing is done.

Register is a small amount of storage available on the CPU whose
contents can be accessed more quickly than storage available elsewhere.
Processor registers are at the top of the memory hierarchy and provide
the fastest way for a CPU to access data.

The important registers, within the CPU are:

Program Counter (PC). A program counter keeps track of the next instruction to be

executed.

Instruction Register (IR) is a register which holds instruction to be decoded by the

control unit.

Memory Address Register (MAR), is a register which points to the memory location

which the CPU plans to access, either for reading or for writing.

MBR (memory buffer register) which is also referred to as memory data register

(MDR) is used for storage data either coming to the CPU or data being transferred

by the CPU.

Acculmular (ACC) is a general purpose register used for storing variables, temporary

results and results produced by arithmetic logic unit of the CPU.

Besides these, a processor can have many other registers. But these are the most

basic and most essential registers necessary for any CPU.

Cache Memory

Cache memory is a small high speed buffer memory used to hold
instructions temporarily during processing.

The CPU of a computer system commonly uses cache memory
(Figure 2.21) where it holds or buffers the contents of the main memory
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because the CPU runs much faster than the main memory. Thus to
reduce the waiting time of the CPU the cache is used. Cache memory
reduces traditional system bottlenecks because system RAM is much
slower than CPU. This prevents the processor from having to wait for a
program and data from slower main memory.

A cache typically operates by retaining copies of blocks of storage,
each containing recently used information. This memory (or caches) is
usually transparent or invisible to the processor.

Figure 2.21 :  Cache memory

Cache  is a collection of data duplicating

original values stored elsewhere or

computed earlier, where the original data is

expensive to fetch (owing to longer access

time) or to compute, compared to the cost of

reading the cache. In other words, a cache

is a temporary storage area where frequently

accessed data can be stored for rapid

access. Once the data is stored in the cache,

future use can be made by accessing the

cached copy rather than refetching or

recomputing the original data, so that the

average access time is reduced.

Figure :  CPU memory cache

Primary Memory

It is a large memory which is fast but not as fast as an internal processor
register. The processor directly accesses this memory. It is mainly
based on integrated circuit.

The primary memory or the main memory is part of the main
computer system. The processor or the CPU directly stores and retrieves
information from it. This memory is accessed by the CPU, in a random
fashion. That means any location of this memory can be accessed by the
CPU to either read information from it, or store information in it. The
primary memory itself is implemented by two types of memory
technologies. The first is called Random Access Memory (RAM) and the
other is read only memory (ROM). A more appropriate name for RAM is
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RWM (read write memory), the CPU can write and read information
from any primary memory location implemented using RAM. The other
part of primary memory is implemented using ROM which stands for
Read Only Memory.

There are two types of built-in memory, permanent and temporary,
known as ROM and RAM, respectively, details of each given below:

Read Only Memory (ROM)

As we know, in the computer terminology, read means transferring
data instruction from an input source to the computers, main memory
(or CPU) and write is transferring data/instruction from computer’s
main memory to an output device. Therefore, read only means data/
instruction can be retrieved from the ROM chip but cannot be modified.

Types of ROM

Basically, there are two types of ROM, namely, manufacturer
programmed and user-programmed.

Manufacturer–Programmed Read Only Memory

Manufacturer-programmed ROM is one in which data is stored in it
permanently by the manufacturer of the ROM. For example, a computer
manufacturer may store the system boot program permanently in the
ROM chip used on the motherboard.

User–Programmed Read Only Memory

User-programmed ROM is one in which the user can load and store
“read-only” programs and data. Such a ROM is commonly known as
PROM (programmable read-only memory), because, a user can program
it. PROM (programmable read-only memory) is a memory chip on
which we can store a program. But once the PROM has been used, we
cannot wipe it clean and use it to store something else. Like ROMs,
PROMs are non-volatile.

Other kinds of user-programmed ROM are EPROM and EEPROM.
Both of these are special types of PROM.  EPROM  (erasable
programmable read-only memory) can be erased by exposing it to
ultraviolet light while EEPROM (electrically erasable programmable
read-only memory) can be erased by exposing it to an electrical charge.

Flash EEPROM memory works much faster than traditional EEPROMs because instead

of erasing one byte at a time, it erases a block or the entire chip, and then rewrites it.

The electrons in the cells of a Flash-memory chip can be returned to normal (“1”) by

the application of an electric field, a higher-voltage charge.

Random Access Memory (RAM)

RAM chips are meant for primary storage. They hold temporarily
(a) software/program instructions and (b) data before and after processing.
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“Random Access” means that any location can be referenced in the
same time and in the same manner, as it is independent of the address
or location in the memory. It is a volatile memory. It holds data and
instructions, during their execution. The additional RAM chip can be
plugged into the special socket on the motherboard known as Single
In-Line Memory Module (SIMM). Random Access Memory capacity
ranges from 16 MB to 4 GB on personal computers.

Types of RAM

RAM chips are of two types, namely, static RAM (SRAM) and dynamic
RAM (DRAM).

Static RAM (SRAM)

The SRAM can store data as long as power is applied, without the need
for periodically rewriting the data into memory. Contents (memory cell)
of this RAM will stay in a given state (store a bit) indefinitely, provided
that power to the memory circuit is not interrupted. The main
applications of SRAM are in areas where only small amounts of memory
are needed or where high speed is required.

Advantage

SRAM can provide very high speed.

Disadvantage

SRAM is costly and has low power packing density.

Dynamic RAM (DRAM)

This memory stores data as charges on capacitors. With Dynamic RAM,
the stored data will gradually disappear because of capacitor discharge,
so that it is necessary to periodically refresh the data (i.e. recharge
the capacitors). In the process of refreshing, the information is read
from the memory cell and written back in the same position. Typically,
each memory cell of a DRAM must be refreshed at least every 2 to 10
millisecond or its data will be lost.

Advantage

It has high capacity and power consumption is low.

Disadvantage

The need for refreshing of dynamic RAM because some external
refreshing circuits is required.

Complementary Metal Oxide Semiconductor Memory (CMOS)

Besides RAM and ROM there is a third type of primary memory or storage called as

CMOS. It is used to store the system configuration, date, time and other important

data. When a computer is switched on, BIOS matches the information of CMOS with

the peripheral devices and displays error in case there is any mismatch.
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RAM

Random Access Memory

It holds information temporarily.

Information is lost when power supply
is switched off.

Known as volatile memory.

Holds operating system and application
programs which are currently in use.

Types of RAMs are Dynamic RAM and
Static RAM.

ROM

Read Only Memory

It stores information permanently.

Information is not lost even if the
computer is switched off.

Known as non-volatile memory.

Holds system software such as Boot
Loader.

Types of ROMs are PROM, EPROM
EEPROM.

Table 2.4 : Comparison between ROM and RAM

Secondary or Auxiliary Memory

Auxiliary memory is much larger in size than main memory but is
slower than the latter. It normally stores system programs and data
files. These cannot be accessed directly by the processor.

Secondary or auxiliary memory, also known as  secondary storage,
is the memory that supplements the main storage. This is a long-term,
non-volatile memory. The term non-volatile means it stores and retains
the programs and data even after the computer is switched off. Unlike
RAM which looses the contents when the computer is turned off and
ROM to which it is not possible to add anything new, auxiliary storage
device allows a computer to record information semi-permanently. This
is to ensure that this information can be read later by the same computer
or by another computer. Auxiliary storage devices are also useful in
transferring data or programs from one computer to another. They also
function as backup devices which allows backup of the valuable
information that we are working on. So, even if by some accident our
computer crashes and the data in it is in unrecoverable mode, we can
restore it from your backups. The most common types of auxiliary storage
devices are floppy disks, hard disks, magnetic tapes and magnetic disks.

Sequential and Random Auxiliary Storage Devices

Based on the type of data access, sequential and random, auxiliary storage devices
can be classified as sequential access media and random media.

In case of sequential access media, data stored in media can only be read in sequence.
To get to a particular point on media, we have to go through all the preceding points.
Magnetic tapes are examples of sequential access media.

In contrast, disks are random access media, also called direct access media, because a
disk drive can access any point at random without passing through intervening points.
Other examples of direct access media are magnetic disks, optical disks, etc.
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Floppy Disk

Floppy disk (often called floppies or diskettes) is a soft magnetic disk.

It is called floppy because it flops if we wave it (atleast the 5¼ inch

variety does). The data on the floppy disk is organised in terms of

tracks and sectors. Unlike most of the hard disks, floppy disks  are

portable because these can be removed from a disk drive. Disk drives

for floppy disks are called floppy drives. Floppy disks are slower to

access than hard disks and have less storage capacity but are less

expensive and are portable.

There are two basic sizes of a floppy, namely 5¼ inch and 3½ inch.

5¼ inch : This is the common size floppy for PCs made before 1987.

This type of floppy is generally capable of storing between l00K and

1.2MB of data. The most common sizes are 360K and 1.2MB.

3½ inch : Floppy (Figure 2.22) is something of a misnomer for these
disks as they are encased in a rigid envelope. Despite their small size,
these floppies have a large storage capacity than their cousins – from
400K to 1.4MB of data. The common sizes for PCs are 720K (double
density) and 1.44MB (high density).

Figure 2.22 : Floppy

Optical Disk

An optical disc is an electronic data storage medium that can be written
to and read using a low-powered laser beam. Optical disk can store
much more data, i.e. upto 6 GB. There are three basic types of optical
disks namely, CD–ROM, WORM and Erasable.

CD-ROM : Like audio CDs, CD-ROMs come with data already encoded
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onto them. The data is permanent and can be read any number of
times but CD-ROMs cannot be modified (Figure 2.23).

WORM : This term stands for “Write Once, Read Many” with a WORM
disk drive. One can write data only once onto a WORM disk. After that,
the disk behaves just like a CD-ROM.

Figure 2.23 :  Optical disks

Erasable : Optical disks that can be erased and loaded with new data
are just like magnetic disks. These are often referred to as EO (Erasable
Optical) disks.

Hard Disk

Hard disk is a magnetic disk (Figure 2.24) on
which computer data can be stored. Hard disks
hold more data and are faster than floppy disks.
A single hard disk usually consists of several
platters. Each platter requires two read/write
heads, one for each side. All the read/write
heads are attached to a single access arm so
that they cannot move independently. Each
platter has the same number of tracks. A track
location that cuts across all platters is called
a cylinder. For example, a typical 84 MB hard
disk for a PC might have two platters (four
sides) and 1,053 cylinders.

Magnetic Tape

Magnetic tape (Figure 2.25) is a magnetically
coated strip of plastic on which data can be

Figure 2.24 : Hard disk

Laserdisc CD Mini-CD
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Secondary Storage

It is auxiliary memory which works
under the control of CPU.

Relatively less expensive than primary
memory.

Storage Capacity is in GB and TB.

Retrieval and processing is comparatively
slower.

Based on magnetic or optical technology.

Primary Storage

It is the main memory as part of the
CPU.

It is most expensive.

Storage capacity is generally in MB or GB.

Retrieval and processing is very fast.

Based on semi conductor technology.

Table 2.5 : Primary  Storage vs. Secondary Storage

Figure 2.25 : Magnetic tape

encoded. Tapes for computers are similar to the tapes used to store
music. Some personal computers, in fact, enable one to use normal
cassette tapes. Tapes are considerably cheaper than storing data on
disks but accessing data from tapes is much slower than accessing
data from disks. Tapes also have large storage capacities, ranging from
a few hundred KB to several GB. These are generally used only for
long-term storage and backup.

2.2.3 CENTRAL PROCESSING UNIT

The central processing unit is one of the two most important components
of the microcomputer.  It is the electronic brain of the computer.  In
addition to processing data, it controls the functions of all the other
components.

The Central Processing Unit (CPU) or the “Central Processor” carries
out a variety of essential data manipulation (including arithmetic/
logical calculations, comparisons, sorting, etc.) and controlling tasks
in the computer. CPU consists of Arithmetic Logic Unit (ALU) and Control
Unit (CU).
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Memory Unit Table

1 Bit (Binary digit) 0 or 1

1 Byte 8 Bits

1 Kilo Byte (KB) 210  Byte or 1024 Byte

1 Mega Byte (MB) 1024 Kilo Byte

1 Giga Byte (GB) 1024 Mega Byte

1 Tera Byte (TB) 1024 Giga Byte

1 Peta Byte (PB) 1024 Tera Byte

Every microprocessor contains a system clock. The speed at which
the processor executes instructions is known as Clock Speed and it is
measured in Megahertz (MHz).

Megahertz (MHz): a measure of frequency equivalent to 1 million
cycles per second.

Gigahertz (GHz): a billion cycles per second.

Where mega means millions and Hertz means cycles. Therefore 550 MHz
processor performs 550 million cycles per second. Generally, clock speed
determines the system performance. Technology advances for higher clock speed.
The latest generation of processors operates in gigahertz (GHz) i.e. a billion
cycles per second.

A computer performs its operation in a fraction of a second. The increasing speeds
given below are:

Millisecond = 10 – 3 second

Microsecond = 10 – 6 second

Nanosecond = 10 – 9 second

Picosecond = 10 – 12 second

Arithmetic Logic Unit

The Arithmetic Logic Unit carries out as the name suggests Arithmetic
and Logical operations on the data made available to it. Basic Arithmetic
functions which an ALU can carry out are addition and subtraction.
More powerful CPUs can support additional mathematical operations
like multiplication and division. The logical operation which it can
carry out are greater than, equal to, less than and comparison between
two numbers. Besides these operations some processors also support
operations which check if particular bits are on or off.
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Control Unit

The Control Unit can be thought of as the brain of the CPU itself. It
controls the computer based on the instructions it decodes, how other
parts of the CPU and in turn, the rest of the computer systems should
work in order that the instruction gets executed in a correct manner.

Register

The register is a special, high-speed storage area within the CPU. All
data must be represented in a register before it can be processed. For
example, if two numbers are to be multiplied, both numbers must be
in registers, and the result is also placed in a register. (The register
can contain the address of a memory location where data is stored
rather than the actual data itself.)

2.2.4 OUTPUT DEVICE

The output devices of the computer are used to display results in
electronic or paper medium.

Common output devices which produce output that is easily
understood are Printers and Monitors.

The results generated by the output devices may be of two types:

Hardcopy Output : Such outputs are non-electronic version/permanent,
and thus may be used at later date as and when they are required. They
are usually on paper and are generally used to produce reports. The
devices which are used to produce hardcopy output are printers, graph
plotters, computer output microfilm, etc.

Softcopy Output : Such outputs are electronic, thus they are available
either on screen or may be stored digitally on some storage device. The
softcopy may be directly seen on screen or may be stored on hard disk/
CD/ DVD for further use.

Other output devices used for specific purposes are Projector, Sound card, Speakers
and Video card.

Printers

A printer is an output device that prints characters, images and symbols
on paper. On the basis of the printing technique used, printers may be
classified as impact or non-impact printers.

Impact printers are like typewriters, as they use some sort of striking/
hammering action to press carbon or fabric ribbon against paper to
create a character or a pattern. These devices are noisy and are not
capable of producing high resolution graphics. The most common impact
printers are character printers (e.g. daisy wheel, dot matrix) and line
printers (e.g. chain printers, drum printers). Among impact printers,
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line printers print one line at a time, so, these printers are extremely
fast. Impact printers are ideal to be used for carbon copies.

Dot-matrix Printers

The print head of Dot-matrix printers (Figure 2.26) uses small pins,
which strike on the paper to create a character or image. They are
more economical than most of other types of
printers, with lowest running cost. These printers
are not used much now-a-days. However, at places
where invoices and delivery notes are produced
with a copy and the quality is not important, these
are still used.

Advantages

• The main advantage of dot-matrix printers now
is the ability to produce carbon copies. They
provide a cheap, reliable method of getting
multiple copies of a printout.

• The other advantage is the low cost of printouts. It has low
maintenance and running costs.

Disadvantages

• Dot-matrix printers are noisy, slow and produce a lower quality
output.

Non-impact printers overcome the limitations of impact printers. They
form characters or images without making print heads strike the paper.
They use thermal, electrostatic, chemical or inkjet technology to produce
printed output. They are fast and quiet in operation. The most common
non-impact printers are inkjet printers and laser printers. These
printers can come in two categories, one produces output with only one
colour (i.e. black colour) and the other one produces output in multicolour.

Day–by–day, with advancement in the field of printing technology,
the quality and speed of these printers are going up and prices are
coming down. Colour printers are increasingly being used in homes
and offices alike.

Inkjet Printers

Inkjet printers (Figure 2.27) use liquid ink technology. These printers
are available in comparatively lower prices and are capable of producing
reasonably good quality prints. The running cost of these printers is
very high and so are not preferred by those seeking large volumes of
prints. These printers are relatively noiseless during printing operation.

Advantages

• Inkjet printers are relatively inexpensive to buy, especially if colour
is needed.

Figure 2.26 :  Dot-Matrix Printer
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Figure 2.27 : Ink-Jet Printer

Figure 2.28 : Laser Printer

• Inkjet printers are also lighter in weight

than other printers and some are small

enough to be carried around in a portable

carry case.

Disadvantages

• Inkjet printers are slower than laser printers.

• If left unused for long periods of time the

cartridges can easily dry out.

• Colour cartridges are expensive in comparison.

Laser Printers (Non–Impact Printer)

Laser printers produce high quality paper prints

at a high speed (with an average speed as 6 to 12

pages per minute). They are almost noiseless and

use dry magnetic ink technology.

Advantages

• Laser printers are noiseless, high speed and high

quality printers.

• Laser printers are comparatively economic for

large number of printouts.

Disadvantage

• Initial costs of laser printers are comparatively

high.

• Size of laser printers is comparatively bigger.

• Repair cost and cartridges of these printers are

generally expensive.

Plotter

A plotter (also known as a graph plotter) is an

output device, which produces high quality

diagrams on paper. Colour pens are used to draw

lines on the paper which is placed in the plotter.

Some plotters have a flat area (plotter base) to put

the paper on. These are known as flatbed plotters

(Figure 2.29). There is another type of plotters, the

Figure 2.29 : Flatbed Plotter

Figure 2.30 : Roller Plotter

roller plotter which uses a large roll of paper

mounted on a roller (Figure 2.30). Usually a plotter

is capable of producing prints on very large size paper sheets but have

a speed slower than printers. Graph plotters are used for drawing

building plans, graphs and three-dimensional drawings. They are often

used by architects and engineers designing machines, bridges, etc.
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Impact Printers

Work like typewriter and use striking/
hammering action.

Print in black or single colour.

Are noisy.

High resolution graphics cannot be
produced.

Examples: Dot Matrix Printer,
Character Printer and Line Printer.

Non-Impact Printers

They use thermal, electrostatic
chemical and inkjet technologies.

Produce single colour/multicolour
output.

Almost noiseless.

High resolution graphics can be
produced.

Examples: Inkjet, Laser Printer,
Plotters, etc.

Table 2.6 : Comparison between Impact printers and Non-Impact printers

Control Devices (Lights, Buzzers, Robotic Arms, Motors)

Many other devices may be connected to the
computer to produce output. For example, lights
may be connected to a computer which will respond
to electrical signals that tell them to switch on
and off. Buzzers may also be used for sound as the
computer sends an electrical signal to switch them
on and off.

Also, a computer can control all sorts of devices
which are operated by motors. Robotic arms are
an example of a device which has its movements
controlled by the computer. When an output device
moves something it is called an actuator.

Control devices like traffic lights, buzzers and motors are used
when the computer is controlling a situation such as regulating
traffic lights or assembling cars.

Softcopy Output : Display Devices

Terminals

Terminal is a display device that may be used for entering data online
from a remote location and for retrieving data. Depending upon the
processing capability, terminals may be classified as intelligent or
dumb terminals.

Intelligent Terminal refers to a terminal with its own memory processor
and a firmware that can perform certain functions independently. They
are usually personal computers, having their own local data processing
capability, data storage and input/ouput capability. For a PC to be a
terminal, a communication adapter (may be a modem) is essential. If
terminals are communicating to one or several hosts and peers, then a

Figure 2.31 : Control Devices (Robots)
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network program is also needed. There are two types of intelligent
terminals, namely, General purpose and Job-oriented. The PC is an
example of General Purpose Terminal. Typical General Purpose application
of terminal is the Internet connection. This is the most pervasive terminal
application and comes with modem and browser software. Job-oriented
terminals are designed and developed for specific tasks. Typical job-
oriented application of terminal includes airline reservation system
terminal, a fast forward terminal ATM and a terminal for monitoring of
a hospital patient. In such terminals hardware and software are
customised to fit the application.

Dumb terminals are meant to enter the data and to receive output
from the main computer, as they cannot process data on their own.
These terminals are connected to the main computer through a
communication link.

Video Display System

Video Display System provides a visual link between the user and the
computer. The videos subsystem of a PC consists of two main components:

(a) Monitor and
(b) Video adapter (also called video card or graphic adapter)

A monitor is a display device which can produce text
and graphic as output. A monitor may use different display
technologies like a Cathode Ray Tube (CRT) and Liquid
Crystal Display (LCD). CRT contains a vacuum tube which
is used for display on screen in a computer. LCD is a
technology in which molecules of a liquid crystal line up
in such a manner that it creates images on the screen by
blocking or transmitting light on the screen.

Audio Response Unit

As a voice recognition system allows the user to talk to a
computer, a voice response system permits a computer to
talk back to the user. Many organisations use audio-
response systems to respond to human inquiries that are
transmitted over telephone lines to the central computer.

Voice output is useful for people who are partially sighted.
The computer can read word  processed documents and
communicate by sound output from the computer. Voice
output is also useful for those who are physically
handicapped and cannot speak. By typing on a keyboard
they are able to communicate using the spoken word.
Directory enquiries at Telecom Services use voice output to
tell the caller the number that the computer system has
found. Voice output is also used in multimedia presentations
and provides a valuable means of communication.

Figure 2.32 : Visual display

unit - CRT

Figure 2.33 : Visual display

unit - LCD



4949494949

Components of CCT

Advantages

• The user cannot see the result on the computer screen, but can
know the result even when they are located far away from it, or
when they are visually handicapped.

Disadvantages

• The quality of voice output is getting better but it still sounds like a
set of small sounds strung together and is therefore obviously
electronic and rather unnatural.

• Sound files used for voice output occupy a large amount of memory.

2.2.5 COMPUTER PORTS

The input/output device is a
piece of hardware that can
be used for both providing
data to a computer and for
receiving information from it.
But how does the computer
communicate with these
external devices? There are
input/output interfaces
called ports (Figure 2.34).

A computer port  is a
connecting socket, outside the system into which different types of
cables are plugged. I/O ports are the interfaces through which
computers communicate with external devices such as printers,
modems, joysticks and terminals. Physically, they are distinguished
by their external shape, numbers and shape of contact pins/points.
Different interfaces and ports have different communication speeds
and bandwidths to carry data to and from the CPU. Some such
commonly used ports are explained below.

Parallel Port : A parallel port transmits 8 bits of a byte of data in
parallel as it contains eight or more data lines for control of I/O devices.
It is commonly used to connect the printer to a computer. It is used for
transmitting fast data over short distances because interference among
multiple signals limits the cable to relatively short distances.

Serial Port : A serial port transmits one bit of a byte at a time as a
single stream of bits. It is meant for transmitting slow data over long
distances. Communication over a phone system is an example of serial
communication. A serial port connects a variety of devices such as
modems, scanners, barcode readers and device control circuits.

PS/2 Port : It is one of the serial port connectors used to plug mouse
and keyboards into a personal computer. It consists of six pins in a
small and round shaped socket.

Figure 2.34 : Computer system showing verious ports
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Universal Serial Bus (USB) Port : USB port is the most popular port
used to connect up to 127 peripheral devices such as digital camera,
speaker, scanner, printer, plotter, modem, joystick, pen drive, etc. USB
permits Plug and Play – i.e. it allows us to install device drivers as and
when the devices are plugged on.

Small Computer System Interface (SCSI) Port : SCSI port allows data
transmission in a “daisy chain” to up to 7 devices at a speed (32 bits at
a time) much higher than serial and parallel ports. The devices that
may be connected to SCSI ports are hard-disk drives, CD-ROM drives,
scanners, backup units, network adapters etc. In daisy chain several
devices are connected in series. If data has to reach the seventh device
then it needs to go through, all the six devices first.

Figure 2.35 : Different types of ports

Fire Wire (IEEE 1394) Port : Fire Wire port is a relatively a new
technology for high speed data communication. The need of this arose
due to large audio and video data movement from multimedia devices.
The devices connected via Fire Wire Port are Video Camera, External
Hard Disk Drives, External CD/DVD Drives. Microsoft has developed
device drivers to support IEEE1394 in all the versions after Windows
95. Linux also supports this port. It is extremely fast with Data Transfer
Rate up to 400 Mb/sec.

2.2.6 COMPUTER EQUIPMENT MAINTENANCE

Computer maintenance entails a four-fold attack against deterioration
of hardware, security threats, software bugs and performance
degradation. Each can seem overwhelming or insignificant but,

PS2 Connector

Serial Connector

USB Device/Connector

Parallel Connector

LAN Connector

Ports
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considering the importance of computer systems operations, the cost

and time are trivial compared to the hassle of getting a system up and

running after a crash.

In fact, we should upgrade the computer every three years or so,

but we will have to transfer all the data and software from the original

computer, whereas a hard-drive swap is a transparent upgrade.

Preventive Maintenance

It is important to maintain computer equipment and consumables.

Routine or preventive maintenance ensures that the computer

equipment will remain in good working order. Examples of preventive

maintenance of computer equipment are the cleaning of the keyboard,

monitor and mouse. There are a few important DOs and DON’Ts which,

if adhered to, can save a lot of maintenance and repair cost. This is

known as preventtive maintenance. The basic preventive maintenance

features are given in Appendix 2.1.

2.3 COMMUNICATION TECHNOLOGY

Letters and telegrams have been the modes of communication for a

very long time. They require setting up of post offices in various regions

and then a hierarchical level of post officers and transport systems to

carry the mails. Such a huge infrastructure is required for the mail

delivery system. This was a sort of manual technology for mail delivery.

Then telephones were made more accessible to the common man.

Communication through letters reduced considerably. The e-mail has

simply revolutionised our lives, conquered time and space and

communication is instantaneous and cheap.The scope of message that

could be communicated through e-mail in comparison to postal or

telephone mode is mind boggling.

The e-mail enables one to send message content of any size

consisting of video, photographs, graphics, and audio. One can even

keep track of sent messages and received messages. Another

communication technology is chat where two persons can communicate

by sending instant messages to each other; they can even see each

other using web cameras. E-mail and chat technology are based on

the Internet. This technology provides all options under one roof with

security provisions.

Communication is essentially exchange of information and

information by its own right has evolved as an independent technology.

With the kind of information explosion that has happened globally

and the logical thirst for knowledge, computers have an eminent role

to play in view of their capacity to generate and store information as

well as their essentiality in the broadband technology on which the

Internet works.
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2.3.1 COMPUTER TECHNOLOGY IN EDUCATION

Computer technology promotes independence and self-assessment. It
stimulates the interest of the students. The various programs in the
system help students in self-assessment. Word processor programs
help students in organising their written work letter. Interactive
computers also help students with their pronunciation. Computer
technology assists people in learning languages. Teachers may evaluate
their teaching methods with the help of computers. They may also
effectively use computer technology to enhance their teaching skills.
Computer technology assists people with learning disabilities. The
physically challenged may use graphics software and word processor
to express themselves. Computer technologies also benefit people with
speech disability by replaying film clips of their speeches and helping
in practising their speech skills.

2.4 SOFTWARE

A computer is a programmable device. A program is a stepwise
organisation of the different steps in which an event happens. When
these steps are predetermined and incorporated in a device we have
actually programmed the device to perform the job. Our human brain
also functions as a programmed device. But it is uniquely endowed
with the power of altering a program with which it initially started if
the situation demands. It is in this that the computer is different from
the human brain. The computer does not have its own intelligence. It
can as an obedient servant, execute instructions. But it has tremendous
potential to execute them with an accuracy and speed far exceeding
the domain human physical capabilities.Hence with increasing
requirements, the human brain has worked out complex programs to
make best use of the capabilities of a computer, at the same time
overcoming its limitations.

Figure 2.36 : Classification of software
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Software is usually divided into two major categories:

System software

Application software.

2.4.1 SYSTEM SOFTWARE

System software is a set of one or more programs, which are designed

to control the operation and networking of computers. It acts as an

intermediary between computer hardware and application program. It

can further be divided into three types: Operating System, Language

Processing and Utilities.

Operating System : An operating system is a set of instructions

that manages overall performance and functioning of the computer

system by controlling the resources such as CPU, memory, I/O

devices and overall flow of information within the system. It acts

as an interface between the machine and its users. Some examples

are Linux, MS/PC-DOS, Mac OS, Windows 95/98/NT/ME/

Millienium/VISTA.

Language Processors : For program execution, instructions must be

converted into the machine language. Language processors are used

to convert assembly language and high-level language programs into

machine level language. Examples: assemblers, translators and

compilers.

Utilities : These are designed to aid, manage and tune the computer

hardware, operating system or application software. These are also

known as service programs, service routines, tools, or utility routines.

Examples: disk defragmenter, disk compression, disk cleanup, disk

checkup etc.

2.4.2 APPLICATION SOFTWARE

Application software is a set of one or more programs designed to do a

specific task such as processing of student admission examination

result, pay calculation, payroll, general accounting, inventory control.

Different organisations need different application programs. The special

purpose programs are also known as “packages”.

A computer system comprises not only of hardware or software but

of both. Hardware is generally controlled by the software. Software is a

set of instructions called a program. British sp.–programme. Computer

related spelt as program. In general, the word program means a

sequence of steps, like come home, wash hands, have a cup of tea or

lunch and like this we  prepare a list of activities that we are going to

do throughout the day. Similarly while designing a software, instructions

need to be written in a proper sequence.
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Open Source

“Open source describes the principles and methodologies to promote open access
to the production and design process for various goods, products, resources and
technical conclusions or advice. The term is most commonly applied to the source
code of software that is made available to the general public with either relaxed or
non-existent intellectual property restrictions. This allows users to create user-
generated software content through either incremental individual effort, or
collaboration.”

OSS – Advantages

Better for Coders – Open source software development is quite different from
conventional closed source software development. People start coding from the point
of already existing level of code. They are not required to waste their time and
energy to research on something, which has already been done by someone else.

Better for Users – The user does not have to get into huge budgetary issue for
using applications. The user can get his applications customised without getting
into huge investments.

Faster development – The applications are developed very fast by taking references
from OSS developers working worldwide.

Future of Open Source – So where does it all end? How exactly will open source
shape our lives leading us to a better tomorrow? It is for certain that with this
level of growth and progress, we expect to see open source as the driving force of
the software industry in the next few years.

Greater Freedom – OSS finds developers in users. Following the movement which
has started and following the guidelines they had set for building OSS, it will
continue its excellence in building better and better stuff for everyone.

Software can also be classified as given below:

2.4.3 SHAREWARE

Shareware software is copyrighted software that is distributed on a
‘try before we buy’ basis by paying a nominal shareware fee. Users
who want to continue using the program after the trial period are
encouraged to send a payment for the program to the program
developer. Shareware is generally less expensive because often a single
programmer develops it.

2.4.4 FREEWARE

Freeware programs are programs that are given away free of charge
and often made available on the Internet. The programmer offers
programs as freeware either for personal satisfaction or to assess its
reception among interested users. Program developers often retain all
rights to their freeware and users are not free to copy or distribute or
sell it further.
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Open Standards – Also known as Open Formats, Open Standards are much more
than just a published specification for storing digital content, media or data. It is
a key to freedom.

Algorithm

When any job or task is written or described in a sequence of steps in
plain English language, it is called an algorithm.  It can contain simple
words, which convey meaning, to do a task. For example, algorithm to
add two numbers can be simply described in a few steps given below:

1. Start
2. Accept first number as A
3. Accept second number as B
4. Take a number C = A + B
5. Display C
6. End

As the computer is a machine and does not have a brain of its own we
need to tell from where to begin and where to end. In the above example,
use of ‘Start’ and ‘End’ is to indicate the beginning and end of the task.

Flowchart

Pictorial representation of these steps is known as flowchart. A flowchart
uses a particular set of symbols shown in Table 2.7. A flowchart can
help to identify bottlenecks or any inefficiencies in the program.

Table 2.7 : Various symbols used in flowchart

Start or end of the program

Computational steps or processing function of a program

Input or output operation

Decision making and branching

Connector or joining of two parts of program

Magnetic Tape

Magnetic Disk

Off-page connector

Flow line

Annotation

Display
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Example of Flowchart

Draw a flowchart to find the sum of first 50 natural numbers.
Answer : The required flowchart is given below:

Algorithms and flowcharts are like road maps for accomplishing a given, well-
defined task.

2.5 PROGRAMMING LANGUAGES

2.5.1 MACHINE LANGUAGE (FIRST GENERATION COMPUTER LANGUAGE)

After preparing an algorithm and a flowchart for a particular software
it has to be written in the computer coded language. Unlike humans,
computers can understand language of only 0s and1s (binary digits),
i.e., binary number system (Number system is given in Appendix 2.2).
A program written in 0s and 1s is called machine language program or
binary language program. Machine language was the first generation
(Figure 2.37) computer language.

Figure 2.37 : First generation language

Followed

Machine language only

User
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AssemblerAssembly Language Program Object code in matching language

Figure 2.39 : An assembler

A sample code in machine language is shown below:

ADD 011814 is written as

0001000000000010011101100001100

Machine language is faster in executions since the computer directly starts
executing it but at the same time it is very difficult to write and understand.

2.5.2 ASSEMBLY LANGUAGE (SECOND GENERATION LANGUAGE)

As it was very difficult to generate code in machine language, the assembly
language was developed which consisted of small meaningful terms.
This is considered to be the second generation language (Figure 2.38).

An example of an assembly language program for adding two numbers
X and Y and storing the result in some memory location:

LDA A Load value of A in accumulator

ADA B Add value of B in the value of accumulator

OUTA Display the content of accumulator on output device

A machine cannot execute an assembly languages program directly
as it is not in a binary form. An assembler is needed in order to
translate an assembly language program into the object code executable
by the machine.

This is illustrated in the figure 2.39:

Writing a program in assembly language is more convenient than
in machine language. It is more readable. But assembly language has
some complications associated with it like:

• Assembly language is not portable. It means that assembly language
program written for one processor will not work on a different processor.

• Assembly language program is not as fast as machine language because
it has to be first translated into machine (binary) language code.

Figure 2.38 : Second generation language

Followed

Assembly language

User

I am an
assembler
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Machine language and assembly language are referred to as low
level languages since the coding for a problem is at the individual
instruction level.

2.5.3 HIGH LEVEL LANGUAGE (THIRD GENERATION LANGUAGE)

We have heard about programming languages like C, PASCAL, COBOL,
FORTRAN and BASIC. These are called high level languages (HLL) or
third generation languages (Figure 2.40). The program shown below is
written in BASIC to obtain the sum of two numbers.

10 X=7

20 Y=10

30 PRINT X + Y

40 END (.)

The time and cost of creating machine and assembly languages
was quite high and this was the prime motivation for the development
of high level languages.

A high level source program must be translated first into a form
which the machine can understand; this is done by a software called
Compiler (Figure 2.41).

HLL program Compiler Object Code (machine language)

Figure 2.41 : A compiler

Advantages

• Readability
• Portability
• Easy Debugging
• Easy Software development

Figure 2.40 : Third generation language

Followed

High level languages

User

I am compiler
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2.5.4 FOURTH GENERATION LANGUAGE

Most fourth generation languages (Figure 2.42) are non–procedural
languages. The programmer does not have to give the details of procedure
in the program, but instead, specify what is wanted.

Major fourth generation languages are used to get information from
files and databases. They are query languages, which are used to
answer queries or question with data from a database. For example:

SELECT Name, Address

FROM Personnel

WHERE  Name = “Ekambaram Vasudevan”;

2.5.5 FIFTH GENERATION LANGUAGE

Fifth generation programming languages will permit the user to give
commands in a more conversational way. These will use voice input
devices rather than traditional keyboards or pointing devices.

Fifth generation languages are used mainly in artificial intelligence
research. Example of fifth generation languages: PROLOG, OPS5, and
MERCURY are the best known fifth generation languages.

Figure 2.42 : Fourth generation language

Followed
4 GLs

User
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EXERCISE

SHORT ANSWER TYPE QUSTIONS

1. CPU is the brain of  the computer. Comment.

2. Why is cache memory known as fastest memory?

3. What types of operations are performed by ALU?

4. What are the components of the storage unit of a computer system?

5. Define Input and Output devices.

6. Differentiate Shareware and Freeware.

7. What is Clock speed?

8. What is the relation between bit, byte, kilobyte, megabyte, gigabyte, terabyte
and petabyte?

9. “A device can be used as input as well as output”. Explain with an example.

10. What do you understand by the word Microprocessor?

11. “Human speech may be used as input and output” discuss. What hardware
and software are required for it?

12. What do you mean by language processor? Give few examples of language
processors.

Summary

• A computer system is a combination of hardware and software used to perform a task
more efficiently and accurately.

• Hardware is the set of all tangible and physical components.

• Software comprises of a set of instructions.

• An input device is used to feed instructions or data into the computer.

• An output device is used to show the results processed by the computer.

• Input/output can be in the form of text, graphics or sound.

• A  port is a connecting socket which can be used to transfer data to and from the computer.

• A port can be a parallel port, or a serial port.

• CPU is the brain of the computer which processes all the information.

• A software can be either a system software or application software.

• System software handles the working of the system.

• Application software is useful for a particular application in daily life.

• Shareware is very inexpensive software.

• Freeware is a software which is free of cost.
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13. Expand the following terms

(i) ROM  (x) VDU

(ii) RAM (xi) CRT

(iii) USB (xii) MDA

(iv) SCSI (xiii) CGA

(v) OMR (xiv) VGA

(vi) MICR (xv) SVGA

(vii) OCR (xvi) DPI

(viii) EPOS (xvii) XGA

(ix) MIDI (xviii) RAID

14. What do you understand by secondary storage? Why is there a need for

secondary storage devices?

15. What is firmware? State the use of firmware.

LONG ANSWER TYPE QUESTIONS

1. Draw a block diagram to illustrate the basic organisation of a computer system

and explain the functions of various units.

2. What is the relation between a flowchart and an algorithm?

3. What is the role of a computer in communication?

4. What are various parts of a computer and how do they work?

5. Differentiate between the following:

(a) System software and Application software.

(b) Software and Firmware.

(c) Firmware and Liveware.

(d) Hardware and Software.

(e) Primary memory and secondary memory

6. What is utility software? Where are they used?

7. What is an operating system? Describe its main functions.

8. List out some of the key functions performed by the system software of a

computer system.

9. “The computer cannot perform anything on its own, thus any error in the

output is not a technological error”. Comment.

10. “Although the computer possess various advantages, it also has certain

limitations” - Explain.

11. What are I/O devices? What is the significance of using such devices?

12. Differentiate between parallel port and serial port. Why are they necessary for

the computer system?

13. What do you understand by ‘interactive input devices’? Discuss a situation

where they are appropriate for use.

14. What is the difference between locator and pointing devices? Describe their

applications.



15. What is digitising  tablet? Is it an input or output device? What kind of

applications are associated with this device?

16. Identify the differences between vision-input system and image scanning

system.

17. What are offline data entry devices? How  are they different from online data

entry devices?

18. Why do we require output devices? Describe the various forms of output.

19. A report needs to be generated for managers in an organisation, containing

total sales over the year with a graph indicating the last 5 years’ sale and

prediction for the next year. What kind of output devices will be appropriate for

this purpose and why?

20. Describe the utility of printers.

21. Write short notes on the following:

(a) Scanner

(b) MIDI

(c) Intelligent Terminal

(d) Ports

(e) Non-Impact Printers

22. Distinguish between the following:

(a) Laser Printer and Dot Matrix Printer

(b) Dumb-terminal and Intelligent Terminal

(c) Impact Printer and Non-Impact Printer

(d) Optical Mark Reader and an Optical Character Reader.

MULTIPLE CHOICE QUESTIONS

1. Which of the following language(s) has portability as its main feature?

(i) Assembly language

(ii) High level language

(iii) Machine language

(iv) 4GL

2. Debugging is the term for

(i) compilation

(ii) execution

(iii) removing errors

(iv) not reading comments

3. Hardware is –

(i) Tangible equipment

(ii) In-tangible equipment

(iii) Set of instructions

(iv) Operating system

4. Assembler converts –

(i) Assembly language to Machine language

(ii) Machine language to Assembly language

(iii) Assembly language to High level language

(iv) High language to Assembly language
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Activities

1. Look at the computer in your school and observe the following:
(a) What type of input devices and output devices are used?
(b) To which type of port are they attached.

2. Ask your teacher to show you an inkjet print cartridge and laser toner cartridge. Why do
you think ink-jet print cartridge dries out faster than laser toner cartridge?

3. Can you access the computer using a microphone to use word processing software.

4. Observe what kind of software/utilities you use on a computer.

5. Look at your own computer and note down its memory, speed, type. Also draw and label the
main components of your computer. Observe the software used on your computer system.

APPENDICES

APPENDIX 2.1 : PREVENTIVE MAINTENANCE OF COMPUTER EQUIPMENT

The basic preventive maintenance features are described below:

• Excessive dust buildup inside the computer can cause overheating, which
degrades performance as well as accelerates wear and tear of the interior parts.
If we are not already familiar with opening the computer to do a little dusting,
hire a professional for a through cleaning job. The cost should be minimal,
especially if we request it during the yearly hard-drive swap.

• The keyboard can be cleaned by turning it upside down and gently tapping the
bottom of the keyboard.

• Monitors can be cleaned with a dry soft cotton cloth.
• Printers require routine maintenance as well. Clearing out paper jams, changing

cartridges and cleaning the printer will lengthen the life of the printer. Most
printers have a print head clearing function or we can use a print head cleaning
kit. Make sure that you read the manufacturer’s instructions before performing
any maintenance.

• Consumables like floppy disks, CD, DVD and paper require correct storage to
ensure that they will be usable when required. They should be stored in a
clean and dry area.

• To ensure that the moisture content of the paper is kept at an optimum level,
paper should be stored in a sealed container. Moist paper tends to curl and
jam in the paper path of a printer.

• The case within which the motherboard, power supply, drivers, ect. are housed,
has a number of vents that allow for a controlled airflow from the power supply
and processor fan to keep the components at a satisfactory operating

temperature.

Effect of Negligence to Computer Equipment

• Loss of Money : The loss of computer equipment caused by mechanical

failure of hardware components is common. When losses occur, the cost of
repairs is absorbed by the affected organisation’s budget.

• Waste of time and reputation : Gross negligence results in physical
damage, defacement, or destruction of computer equipment; theft;
unauthorised access or use; unauthorised alteration, substitution, or
deletion of programs, command files, data files, documentation, or other
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material; wiretapping or any form of unauthorised signal interception;
divulgence of confidential information or computer access methods to

unauthorised persons.

• Performance Degradation : Computers often have too many temporary files
cluttering the system, a fragmented file system, viruses/spyware/adware,
and unnecessary programs running on startup. Windows XP has several
software packages to help clean up systems, including Disk Cleanup, Disk
Defragmenter and Check Disk. Each speeds up computers and is easily
used by novices.

If the computer is still operating slower than expected, we should look into
software packages to run deep checks of the entire system, inspecting its registry,
missing shortcuts and Windows files. These programs can increase system
performance by removing thousands of unneeded registry settings from uninstalled
software, cleaning up unnecessary programs from startup, and removing the deluge
of temporary files stored on everyone’s computer.

APPENDIX 2.2 : NUMBERS SYSTEM

Decimal Number System

Most people today use decimal representation to count. In the decimal system
there are 10 digits:

0, 1, 2, 3, 4, 5, 6, 7, 8, 9

These digits can represent any value, for example:

754.

The value is formed by the sum of each digit, multiplied by the base (in this
case it is 10 because there are 10 digits in the decimal system) in power of digit
position (counting from zero):

7 . 10 2 + 5 . 10 1 + 4 . 10 0 = 700 + 50 + 4 = 754

Digit PositionBase

5 . 10 2 + 4 . 10 1 + 7 . 10 0 = 500 + 40 + 7 = 547

Digit PositionBase

0 0 = 1 X 0 = 110 0 = 1

Position of each digit is very important! For example, if we place “7” at the end:

547

it will be another value:

Important note: Any number in power of zero is 1; even zero in power of zero is 1:

Binary Number System

Most modern computer systems operate using binary logic. By convention we
use the values zero and one. These two values, coincidentally, correspond to
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the two digits used by the binary number system. Therefore, computers employ
the binary system.

Similarly, in binary (Base–2), all the columns are powers of 2. Think of the
following table as the four least significant digit place holders for the binary number

system just like the tables above using the decimal number system:

Eight’s column Four’s column Two’s column One’s column
(Most significant (Least significant

 digit) digit)

2 3 2 2 2 1 2 0

10100101b =
= 1 . 2 7 + 0 . 2 6 + 1 . 2 5 + 0 . 2 4 + 0. 2 3 + 1 . 2 2 + 0 . 2 1 +1 . 20

= 128 + 0 + 32 + 0 + 0 + 4 + 0 + 1    =165

Digit PositionBase

The binary number 10100101b equals to decimal value of 165:

For example, let’s look at the binary number:

1011

and convert it to decimal number.

Eight’s Four’s Two’s One’s

1 x  23 Plus 0 x 22 Plus 1 x 21 Plus 1 x 20

Which equals 1 x 8 Plus 0 x 4 Plus 1 x 2 Plus 1 x 1

Which equals 8 Plus 0 Plus 2 Plus 1

The total is : 11 (in decimal), which equals 8 + 0 + 2 + 1.

In other words,

1011
2
= 11

10
.

The subscripted number indicates the number base.

Example 1

What is the decimal equivalent of the binary number 0111 (also written as 0111
2
) ?

Answer

0 x 23 Plus 1 x 22 Plus 1 x 21 Plus 1 x 20

= 0 x 8 Plus 1 x 4 Plus 1 x 2 Plus 1 x 1

= 0 + 4 + 2 + 1

Total = 7 (also written as 7
10

)

Example 2

What is the decimal equivalent of the binary number 1010 (also written as 1010
2
) ?

6565656565

Components of CCT



Answer

1 x 23 Plus 0 x 22 Plus 1 x 21 Plus 0 x 20

= 1 x 8 Plus 0 x 4 Plus 1 x 2 Plus 0 x 1

= 8 + 0 + 2 + 0

Binary Evaluate 24 23 22 21 20 Value Decimal Number

Decimal Value 16 8 4 2 1

0 > 0 0

1 > 1 1

1 1 0 > 4+2+0 6

1 0 1 0 > 8+0+2+0 10

1 0 1 1 0 > 16+0+4+2+0 22

1 1 0 0 1 > 1+8+0+0+1 25

1 1 1 1 1 > 16+8+4+2+1 31

32 16 8 4 2 1

1 0 1 1 0 0

32 16 8 4 2 1

0 0 1 1 1 1

Total = 10    (also written as 10
10

)

Different number systems are summarised in Table 2.8

Decimal To Binary Conversion

To convert a decimal number to binary, first subtract the largest possible power of
two, and keep subtracting the next largest possible power form the remainder,
marking 1s in each column where this is possible and 0s where it is not.

Example 3 (Convert decimal 44 to binary)

4 4
– 3 2

1 2
– 8

4
– 4

0

Example 4 (Convert decimal 15 to binary)

1 5
– 8

7
– 4

3
– 2

16666666666

Computers and Communication Technology
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Table 2.8 : Binary to decimal conversion



Binary Arithmetic

Rules of Binary Addition

• 0 + 0 = 0
• 0 + 1 = 1
• 1 + 0 = 1
• 1 + 1 = 0 and carry 1 to the next more significant bit.

Example 5

Rules of Binary Subtraction

• 0 – 0 = 0
• 0 – 1 = 1 and borrow 1 from the next more significant bit
• 1 – 0 = 1

• 1 – 1 = 0

Example 6

11+11=11 1 Carry

0 1 1 = 3 
(base 10)

+ 1 1 = 3 
(base 10)

1 1 0 = 6 
(base 10)

00100101 – 00010001 = 0 Borrows

00010100 0 0 1 0 0 1 0 1 = 37 
(base 10)

– 0 0 0 1 0 0 0 1 = 17 
(base 10)

0 0 0 1 0 1 0 0 = 20 
(base 10)

Rules of Binary Multiplication

• 0 x 0 = 0
• 0 x 1 = 0
• 1 x 0 = 0
• 1 x 1 = 1 and no carry or borrow bits.

Example 7

00100101 × 00010001 = 0 0 1 0 1 0 0 1 = 41 
(base 10)

11110110 × 0 0 0 0 0 1 1 0 = 6 
(base 10)

0 0 0 0 0 0 0 0 = 17 
(base 10)

0 0 1 0 1 0 0 1

0 0 1 0 1 0 0 1

0 0 1 1 1 1 0 1 1 0 = 246 
(base 10)

6767676767
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Binary Division

It is a repeated process of subtraction (as in decimal division).



There are other number systems also. Table 2.9 gives a comparison between
different Number Systems.

00101010 ÷ 00000110 = 1 1 1 = 7 
(base 10)

00000111 1 1 0 ) 0 0 1 20 1 0 1 0 = 42 
(base 10)

– 1 1 0 = 6 
(base 10)

1 borrows

1 0  20 1

– 1 1 0

1 1 0

– 1 1 0

0

Number system Base value Symbolic character set

Binary 2 0,1

Octal 8 0, 1, 2, 3, 4, 5, 6, 7

Decimal 10 0, 1, 2, 3, 4,5, 6, 7, 8, 9

Hexadecimal 16 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, A, B, C, D, E, F

Table 2.9 : Comparison of various number systems

6868686868
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WORD PROCESSING

TOOL

Introduction

After completing this Chapter, the

student will be able to:

• work with any word processing

program,

• create, save and open a

document using a word

processor,

• format a document inserting

bullets/numbering, tables,

pictures, etc.,

• set  custom tabs and apply styles,

• prepare a document for printing,

• enhance the features of the

document inserting graphics,

tables, pictures, charts, etc., and

using different formatting styles,

• modify document using various

editing and formatting features

within or across documents,

• produce documents for various

purposes and

• apply mail merge facility to send

a document to different

members.

3

We have to submit a project as part of our course
evaluation. We will perhaps take a chart paper
and design the project, write a report and submit
it to our teacher. That’s the way we have done it
all along? Have we ever thought of typing the entire
project report using a computer and submitting it
in a nicely designed printed form? Ever reflected
on getting information from the Internet and
presenting it neatly for the project? Now that’s
the way things are being done! And if we are already
thinking of it, it’s time to discover some document
creation software, i.e., word processing tool to get
the job done. Not only a project, we can get lots of
other things done through it – writing letters and
applications, making newsletters, designing
posters, and the list goes on and on!

Objectives

Computers are dominating our lives today in
more ways than we know. The power of
computers can however be seen in the word
processing tools.

I like the computer because it keeps giving you

options. What if I do this? You try it, and if you
don't like it you undo it. The original can always
be resurrected. It raises the idea of working on
one painting your whole life, saving it and
working on it again and again.

Elliott Green
Research Associate and Tutorial Fellow,  Oxford University
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3.1 WORD PROCESSING

Word processing is the ability to create documents using a word
processor. It can also refer to advanced shorthand techniques,
sometimes used in specialised contexts with a specially modified
typewriter. These were primarily aimed at typists, particularly in offices
where other workers sent handwritten notes to be transcribed into
documents for printing which were returned for reviewing. The word
processing operators achieved considerable time saving largely due to:

• the faster typing speeds achieved as a result of electronic keyboards
• the assistance of the word processing software for functions like

layout and spell check, etc.

Today, there are different word processors available; some are
proprietary like Microsoft Word, WordPerfect Office, StarOffice Writer,
etc., while others are open source like Kwrite, Openoffice.org Writer,
etc. Basic functions in all remain more or less similar and do not require
advanced computer or typing skills for use. However, a complete word
processor is that which lets us work with text and other features, for
example, pictures, tables, artistic texts, to create interesting and
meaningful pages. We can make our own posters for bulletin board, type
letters and attach them as documents to an e-mail, etc. Since MS Word,
an integral component of MS-Office, is one of the programs which provides
all these features and many more and is also being mostly used due to
its ease of usage, we have taken it as a sample Word Processing Tool.

3.2 STARTING THE WORD PROCESSOR

Most of the time, we will be able to start the word processor of our
choice from the Program option under the Windows Start menu. Of
course, we might also create a shortcut on the desktop to access our
word processor.

For example, to start Microsoft Word, click on

• , then on

• , and lastly on

•

as shown in figure 3.1.

3.2.1 ANATOMY OF THE APPLICATION WINDOW

The first and foremost task is to get acquainted with the application
window of the word processing package that we are planning to use.
As already mentioned, most of the packages allow the user to perform
identical tasks; their application windows too appear by and large
comparable. The important components of this are:

• Menu Bar : Provides menu options like File, Edit, View, etc.
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• Standard Toolbar : Contains tools for standard tasks, like saving,
printing, cutting, copying, pasting, etc.

• Formatting Toolbar : Provides tools for formatting like bold, italic,
underline, etc.

• View Buttons : Provides options to switch between Normal, Web
Layout, Print Layout, Outline and Reading views.

• Tab stop: A position we set for placing and aligning text on a page.
• Drawing ToolBar : Provides tools for drawing basic shapes, inserting

pictures, changing colors, etc.
• Status Bar : This provides information about the current document.

Figure 3.1 : Selecting Word to start

Figure 3.2 : Application Window

Standard toolbar
Formatting toolbar
Reviewing toolbar

Tab stop—A position
you set for placing and
aligning text on a page.

View buttons—Click
to switch between
Normal, Web Layout,
Print Layout, Outline
and Reading views.

Status

New Document
task pane

Other Task Panes
m e n u — S e l e c t
other task panes,
including Reveal
F o r m a t t i n g ,
Search, and
more.

Drawing toolbar

Title Bar
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When we start MS-Word, a blank document opens up. Word names
the document as Document1 (Figure 3.2). We can also start a new
document in any of the following ways:

• Click on New button ( ) on the Standard toolbar, or
• Click on New option in the File menu (Figure 3.3).

After we have started a new document, type in some introductory
text into the document. When we start a new document, the insertion

Other programs like WordPad, NotePad could also be used to create word documents,
but these programs lack certain important features as compared to MS-Word.
Therefore MS-Word is a more complete package for word processing.

Figure 3.3 : To open new document

from file menu

Figure 3.4 : To save a document

from file menu

Figure 3.5 : Save As dialog box

Filename

The file will be saved in
this folder. You can click
on the arrow to select
another drive or folder

Double click
to open any of
these folders

point (the blinking vertical line, also called cursor)
appears in the first column of the first line. We
can just type the text, and it will appear where
the insertion point is. But in a document where
we already have the text, we can place the
insertion point anywhere in the text by clicking
the mouse pointing at the desired location.

3.3  HOW TO SAVE A DOCUMENT?

• Click on Save button ( ) on the formatting
toolbar, or

• Click on the Save option in the File menu
(Figure 3.4).

The Save As dialog box appears (Figure 3.5).
It’s a good idea to give the new document a name
and save it as soon as we create it.

The steps we should follow to save our
document are as follows:
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• Automatically, we will  save our file in My Documents folder. If we

need to save in some other location, navigate towards it by clicking

on the arrow on the right, and selecting one of the available options.

Select the location. Figure 3.5 shows the drive/folder/sub-folder

where we want to save the document.

• Type the filename as Document New and Type of document as Word

document.

• Click on the Save button.

We can cancel the process at any time by clicking on the Cancel button.

3.4 HOW TO OPEN AN EXISTING DOCUMENT

• Click on Open under File menu, or click on tool on the Standard

toolbar.
• The Open dialog box is seen on the screen. This is similar to the

Save As dialog box.
• Navigate to the folder where our file is located, select the filename.
• Click on Open.

3.5 FORMATTING TEXT

Formatting refers to the way our text will look like – the design of

the characters, their size, the space between paragraphs, their

alignment, etc.

First, selection of text.

• By using the mouse, position the insertion point (by clicking the

mouse) at the beginning or end of the block to be selected and then

click and drag to the end or beginning of the block.

• By using the shortcuts:

n Double-click on a word to select it.

n Triple-click on a paragraph to select it.

n Ctrl+click on a sentence to select it.

There are basically two types of formatting:

• Character formatting, and

• Paragraph formatting

3.5.1 CHARACTER FORMATTING

Character formatting is the one which we can apply to any individual

character or to a group of characters. It has the following options

(Figure 3.6):

Font : This decides the appearance of  our characters.

Font Style : We can make characters stand out by making them Bold,

Italic or both.
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Size : This increases/decreases
the size of the characters – the
size measured in points
(72 points =1 inch)

Font Color : We can apply
colours to the characters for
printing the final document.

Underline : We can draw
attention to some particular
text by underlining it.

Effects : We can also apply
effects to our text. Two most
common ones are Superscript
and Subscript. The 2 in 32 is a
superscript. To make a
character into superscript, we
need to select only that
character, and click the box
against Superscript. Similarly,
1 in T

1
 is a subscript.

3.5.2 PARAGRAPH FORMATTING

There are some formatting features that get applied to an entire
paragraph or paragraphs, but not to any given character or a group

thereof. Such formatting
features are described as
Paragraph formatting.

It provides the following
options (Figure 3.7):

Alignment : The alignment of
a paragraph may be left, center,
right or justify as given in
Table 3.1.

Indentation : Indents are the
left and right boundaries of
selected paragraphs within a
d o c u m e n t . T h i s m a y b e
necessary when di f ferent
paragraphs have different left
and right boundaries. For
example, we can see the
indentation in poems. The
indentation options available
in most word processors are

Figure 3.6 : Character formatting box

Special
Indentation

like first line

or hanging

Paragraph
Alignment

Paragraph
Indentation

Paragraph
Spacing Line spacing

like single,

double, etc.

Figure 3.7 : Paragraph formatting box
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Left and Right. Apart from these, we can have special indentation in
the form of First Line and Hanging.

Spacing : This option allows us to have some space before and/or
after a paragraph or a group of paragraphs. We can select the
paragraph(s) and select or type in the desired value against the appropriate
option – Before or After. These values are measured in points.

There is also a Line spacing option, which decides on the spacing
between the lines of the paragraph. Normally we will type with the
value Single for it. But if we want to have more space between the
lines, we can select 1.5 lines or Double for it.

3.5.3 TO ADD BULLETS OR NUMBERING

Bullets are small dots, squares, dashes or graphics that are often
seen before the text (word, line, sentence, paragraph or any other
object). To add bullets,

• Select the object

• Click on Bullets and Numbering from Format menu to open the Bullets

and Numbering dialog box (Figure 3.8)

Table 3.1 : Different types of Alignments

Alignment Description

Left Alignment All the lines of the paragraph will be aligned on the left.

Right Alignment All the lines of the paragraph will be aligned on the right.

Center Alignment All the lines of the paragraph will align to the center.

Justify The left as well as the right side of the paragraph will be
aligned except for the last line.

Activity 3.1

Type “We are changing the font”. Try the activity by using the following options:
• font Arial,
• font style Italic,
• size 10 point,
• font colour blue,
• underline style - a simple line,
• underline colour green, and
• effects Small Cap.
• right alignment,
• indentation 1 inch for left as well as right,
• first line indent 0.5 inch,
• spacing as 6 point both before and after the paragraph and
• line spacing 1.5 lines.
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Many of the formatting options
discussed above can be applied through

the Formatting Toolbar (Appendix 3.1 Tools in Formatting Toolbar).

The tools for Bold ( ), Italic ( ), Underline ( ), Shadow,
Numbering, and Bullets act as toggles – that is, the desired formatting
will be applied if it is not already applied to the selected text, else it
will remove that formatting.

3.5.4 USING TABS TO ARRANGE DATA

The tab setting allows us to align the text at a particular point, or to
create a tabular layout. Try this out – open a new document and

• type 2 3 4 5 6, pressing the tab key after every digit. Press the
Enter key.

• type 22 33 44 55 and 66, again pressing tab key after every number
(type 22, press tab, type 33, press tab, and so on).

3.6 A GLANCE INTO VIEWS

Most word processors provide us multiple views: we can select the one that
suits the work at hand. We can display our document in one of the five views:
Normal layout, Web Layout, Print Layout, Reading Layout or Online Layout.

• Normal Layout

Normal layout view shows formatting such as line spacing, font,
point size and italics.

• Web Layout

Web layout view enables us to view our document as it would appear
in a web browser such as the Internet Explorer.

Click here to
select numbers

Click here to
select bullets

Figure 3.8 : Bullets and numbering dialog box

Click on the bullet of your choice,
and click OK.

Instead of a bullet, a number may
also precede a group of paragaphs. To
do so, proceed as follows:

• Choose the numbered tab from Bullets

and Numbering of Format menu to
view the numbering options.

• Select the numbering option of choice,
and click OK.

To remove bullet(s) or number(s)
applied to paragraph(s), select the
paragraph(s), open the Bullets and

Numbering dialog box, and select
None in Bulleted or Numbered tab.
Click on OK.
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• Print Layout

The Print Layout view shows how the document will look when it
is printed.

• Reading Layout

Reading Layout view formats our screen to make reading our
document more comfortable.

• Outline Layout

Outline view displays the document in outline form.
Only headings can be displayed hiding the text
under them. We can just move a heading; the
accompanying text will automatically move with it.

We can opt for any one of the available views by
selecting it from the View menu, or clicking on the

appropriate View Buttons – .

3.7 CREATE A TABLE

Tables provide a neat way to present complex
information in vertical columns and horizontal rows
of cells. Each cell can contain text – a single
paragraph or multiple paragraphs – or graphics. To
insert a table:

• click on Insert in the Table menu and select on
Table from resulting menu. (Figure 3.9)

• This opens up the Insert Table dialog box
(Figure 3.10). Type in some value for the number
of columns and rows… let us type in the values
5 and 4 respectively.

• We can now see this table (Figure 3.11) on the
page – with 5 columns and 4 rows

• Time to type in some text! We can move the
insertion point from one cell to another by
clicking the mouse at the desired cell. We can
also press the Tab key to move to the next cell,
or Shift+Tab keys to move to the previous one. !,
!, ! and ! keys can also be used for this.

Figure 3.10 : Insert Table

dialog box

Figure 3.11 : Blank table created

Figure 3.9: To insert table in the

document
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• When a table is inserted, all columns are of same width and all
rows are of same height. To change their size, move the mouse
pointer to the line separating the rows or columns.  If the mouse is
at column separator, it will change to ; if it is on the line bordering

two rows, it changes to . Now drag the mouse to change the size

of the column or row. If the cell is selected, then only the size of the
selected cell changes instead of the entire column or row.

• Type in the text and adjust the column widths to make a table
as shown in Table 3.2:

There are times when we need to change the number of rows/
columns after we have inserted the table. There are two options each
for rows and columns in the Table menu.

• To insert columns, use the options Columns to the Left or  Columns to the

Right under Insert option of Table menu. Put the insertion point in
any cell at the column adjacent to the location where the new
column is to be inserted, and select the appropriate option.

• For rows, the options are Rows Above and Rows Below. We can use

these like we did for inserting columns.

To delete row(s) or column(s), we can utilise
the Delete option under the Table menu. The
various alternatives under this option are seen in
figure 3.12.

Select cell(s) in appropriate row(s) or column(s),
and click on the choice to delete Rows or Columns

as desired. To delete the entire table, put the
insertion point somewhere in the table and click on
Table under Delete option.

Two or more cells can be merged into a single
cell. Alternatively, a single cell can be split into
several new cells. These options are also available
under the Table menu as seen in the figure above.

To merge cells, select two or more cells and click on Merge Cells. To

split cell(s), select the cell(s) and click on Split Cells... . The Split Cells

 Figure 3.12 : Table menu for delete

options

Roll No Name Class Section House

1 Vijaya XI A Red

2 Lalruata XI B Blue

3 Kabir XI A Yellow

Table 3.2: Sections and Houses of Class XI Students
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dialog box appears, soliciting the number of rows and columns into which
we would like to split the cell(s).

The easiest and quickest way to decorate the table:

Click on Table AutoFormat... under the Table menu. Table Autoformat

dialog box appears.

Let us decorate the table we
had created:

• Place the insertion point
anywhere in the table.

• Open the table menu, and
click on Table Autoformat.

• In the Table AutoFormat

dialog box (Figure 3.13),
select Contemporary. We can
observe the preview portion
of the dialog to see the effect.

Click on Apply. Our simple
table now looks very different
(Table 3.3) from what it
originally was.

3.8 INSERTING
PICTURE IN A
DOCUMENT

Graphics can add interest and
impact to the documents.
Suppose we have completed a
letter telling our friends about
the great party we threw for a
birthday. The words capture
the festive mood of the event,
but that page of text looks
lifeless and dull. We need graphics to enliven our prose.

Figure 3.13 : Table AutoFormat dialog box

Roll No Name Class Section House

1 Vijaya XI A Red

2 Lalruata XI B Blue

3 Kabir XI A Yellow

Table 3.3 : AutoFormatted Table 3.2
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We can insert picture from a picture file or we

can use any of the clip arts provided with MS-Word

or any word processor of our choice.

3.8.1 INSERT A CLIP ART

Let us insert a clip art into our Document New file:

• Open the Document New file.

• On the Insert menu, select Picture, and then

click Clip Art.

• The Clip Art task pane opens up. (Figure 3.14)

• In the Clip Art task pane, type the search term

(for example, “computer”) in the Search for field,

and click on the Search button. If we are not

looking for anything in particular, don’t type in

any text, just click.

• Select the insertion point in the document where

we want to insert clip art (Figure 3.15 (a)), and

then click the clip we want on the task pane

(Figure 3.15 (b)).

Figure 3.14 : Clip Art task pane

Figure 3.15 (a) : Selecting the insertion point , (b) Selecting the clip art

• The clip art will get placed where the insertion point was
(Figure 3.15 (c)).

Figure 3.15 (c) : Inserting clip art in the document
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3.8.2 TO INSERT A GRAPHIC FROM A FILE

• On the Insert menu, select Picture, and then click from File.

• The Insert Picture dialog box opens up. Browse the graphic file.

• Click the file, and then click Insert.

• The picture gets inserted where the insertion point was located.

3.8.3 TO APPLY WRAPPING STYLE

We have inserted a clip art or picture, but we do not want blank space

to the right and left of the picture. No problem, we can further refine

the layout of the graphic and text. Using the five wrapping styles, we

can create documents with just the look we want.

To apply wrapping styles to a graphic,

• Click on the graphic to select it.

• On the Format menu, click Picture.

• In the Format Picture dialog box, click the Layout tab.

• Click the preferred wrapping style, and then click OK.

Different Wrapping styles are given in Appendix 3.3.

3.9 HOW TO COPY, MOVE AND DELETE TEXT

Any word processor will allow us to copy or move text/graphics from

one part of the document to another or from one document to another.

If the same text is appearing in more than one place, the copy option

can save us from quite a lot of trouble. If we want to reorganise the

document by changing the position of certain text, we need not delete

the text from existing location and re-type at the new location – just

move it from its current location to the desired location.

To copy or move, proceed as follows:

• Select the item to copy or move. This can be a character, a few

words, some paragraphs or a graphic.

• If we want to copy, click on Copy from Edit menu. Alternatively, we

can click on  tool on the Standard toolbar.

• If we want to move, click on Cut from Edit menu. Alternatively, we

can click on  tool on the Standard toolbar.

• Place the insertion point at the destination location (this may be

within the same document, or in another document), where we
want the text or graphic to be copied or moved.

• Click on Paste from Edit menu. Alternatively, we can click on 

tool on the Standard toolbar.

To delete some text or graphic, select the same and simply press

the Delete key.
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3.10  CHECKING SPELLING AND GRAMMAR

Checking spelling and grammar in a document
after we finish typing and editing the text is
very useful. We can check for possible mistakes
and then confirm each correction. In Microsoft
Word, we can start the spell checker by clicking
on Spelling and Grammar option under Tools

menu (Figure 3.16).

When the spell checker finds a spelling
mistake, a dialog box or task pane

(Figure 3.17) is displayed and the first misspelt word found by the
spelling checker is selected.

Figure 3.16 : Tools menu

Figure 3.17: Task pane for Spelling and Grammar

We can resolve each error that the program finds in different ways:

• We can use one of the words suggested by the word processor and
click Change.

• We may want to change the word ourselves. Click the word on the
document (not in the Spelling and Grammar dialog box) and edit it.
After fixing the error, click on Resume.

• The indicated word may actually be the correct one, but not available
in the Dictionary; for example, the name of the town Shillong. To
include such word into the word processor’s dictionary, click Add

to dictionary. If, we would like to ignore it, click Ignore once. If we
want to ignore all instances of such cases in the document then
click Ignore All.
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After we resolve each misspelt word, the word processor flags the
next misspelt word so that we can decide what we want to do.

After the program finishes flagging the spelling mistakes, it begins
showing us the grammatical mistakes. We can proceed in a similar
fashion to correct those also.

Alternatively, we can check spelling automatically while we type.
In that case, we can be more confident that we won’t need to correct
a lot of spelling mistakes when we are ready to deliver our
document. Word flags misspelt words by underlining them with a
wavy red line (Figure 3.18) so that we can easily spot them. We
can right-click the misspelt word to see suggested corrections on
the resulting shortcut menu.

Figure 3.18 : Entering text with Spellchecker on

Similarly, the grammar mistakes are flagged by a wavy green
underline – we can correct these just as we corrected the spellings.

However, don’t blindly accept the corrections suggested by the word processor. The
word processor is not always accurate in detecting spelling and grammar errors!

3.11 SETTING PAGE LAYOUT

When a document is to be printed, the word processor has to be told as
to how the document should appear on the page, i.e., its paper size,
margins, layout of the paper, etc.

To alter the page setup, click on Page Setup under the File menu. In the
resulting Page Setup dialog box (Figure 3.19), set the margins to the required
values. Let us set the margins as Top – 1 inch, Bottom – 1 inch, Left –

1.25 inch and Right – 1.25 inch.
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Figure 3.19 : Page set up dialog box

orientation, and selected the paper size.

3.12  MAIL TO MANY IN SIMPLE STEPS – THE MAIL
 MERGE

We use mail merge when we want to create a set of documents that

are essentially the same except that each contains some unique

elements. For example, in a letter to invite friends to a birthday party,

the date of invitation and the text thereof will be same everywhere, but

the address and greeting line will be different in each letter.

Using mail merge, we can create:

• A set of labels for envelopes : The return address is the same on all

the labels or envelopes, but the destination address is unique on

each one.

• A set of form letters, e-mail message or faxes : The basic content is

the same in all the letters, messages or faxes, but each contains

information that is specific to the individual recipient, such as

name, address or some other piece of personal data.

Creating each letter, message, fax, label, envelope, etc. individually

would take hours. That’s where mail merge comes in. Using mail merge,

Apart from the four margins, we

may set the following:

• Gutter is the space left on one side

for stitching and binding – give

an appropriate value, if required.

• The orientation decides whether

the page will be printed

lengthwise (portrait) or across its

breadth (landscape). In other

words, Portrait is taller than it is

wide; Landscape is wider than it

is tall. The orientation buttons

themselves are quite self-

explanatory.

In the Paper tab, select the paper

size on which we are going to print

the document. There are standard

paper sizes like letter, A4, legal etc.

Either we can select one from these

or we can enter the width and

height of the paper we are using.

Click OK once we have typed in

the values for margins, chosen the
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Summary

• A word processor is a software for typing, formatting and creating documents.

• There are two types of formatting that we can apply – character formatting and paragraph

formatting.

• For character formatting, we must first select all the characters where we want to apply

the formatting. For paragraph formatting, it is enough to have any part of the paragraph

selected – for a single paragraph, it is sufficient to place the insertion point somewhere

in that paragraph.

• Character formatting includes – font, font style, size, font colour, underline style, underline

colour, and effects – for example subscript, superscript, emboss, etc.

• Paragraph formatting comprises of – alignment; indents – left, right, first line and hanging;

space before and after paragraphs; and line spacing.

• To highlight the points, we can use bullets or numbering for the paragraphs.

• If we plan to put tabular data, we can either use tabs – left, right, center and decimal; or

use table to type in the text within the cells.

• To enhance the appeal of the document, we can insert pictures – either from clip art, or

from files. We might have to select appropriate wrapping options to have the text around

the picture.

• We can move or duplicate text in a document or across documents using options like

Cut, Copy and Paste.

• If we are likely to make mistakes (and all of us are!), we can utilise the word processor

to check the spellings and grammar.

• Before we print the document, we must decide on margins, page size, gutter etc. through

Page Setup.

• If we need to have many copies of documents which are same except for some parts, like

invitation letters, we can use the mail merge facility to make the task simpler.

• We can allow others to review the documents by editing as well as by adding comments.

These changes can be tracked. We can later decide as to whether to keep those changes

or to revert back to the original text.

all we have to do is create one document that contains the information
that is the same in each version. Then we just add some placeholders
for the information that is unique to each version. The word processor
will take care of the rest.

We can prepare mail-merged documents by using this facility as
described in Appendix 3.2.
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EXERCISES

SHORT ANSWER TYPE QUESTIONS

1. What is a cursor?

2. How many types of text alignments are there?

3. What are the methods of selecting a line in MS-Word?

4. How many types of page orientations are there in page setup?

5. What are the views used in word processors?

6. How can words be added in word processors, dictionary?

7. List the advantages of word processors.

LONG ANSWER TYPE QUESTIONS

1. Give the steps to insert a clip art picture to your document.

2. What is formatting? Discuss the different types of formatting that you can

have using a word processor.

3. Discuss the different types of indentation.

4. How is line spacing different from space before or after paragraphs?

5. What are the various facets of Paragraph Formatting? Explain each one clearly.

6. Explain the process of applying bullets to some paragraphs in a document.

7. What is tab? How do they assist in the process of formatting?

8. What is style? Discuss the steps involved in defining styles. What is the use of

style for next paragraph?

9. How do you change the features of an existing style?

10. How do you insert table in your document? Discuss the steps involved in splitting

and merging cells.

11. Discuss the various text wrapping options available when you insert a picture

in your document.

12. Explain the utility of mail merge.

13. Define mail merging in word processor.

MULTIPLE CHOICE QUESTIONS

Identify the most appropriate option for the following :

1. To increase the space on the left for just one paragraph in a page, you can

adjust

(i) Left indent

(ii) Right indent

(iii) Alignment

(iv) Tabs
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Activities

1 The following interview letter is to be sent to all the candidates who had applied for
admission to XYZ College, informing them the respective date and time of interviews.
The name, address, date and time of interview for each candidate is given. Use Mail
Merge to perform this task. Save your work in the folder created in question number 1.

XYZ COLLEGE : PQRPUR

Dear......................... Date : ............................

Apropos your application for admission to the Degree course on ................... at this
college, you are requested to attend the interview on ................... at ................... The interview
will be held at the Principal’s office. You are to bring :

(i) The higher secondary marksheet.
(ii) Birth certificate
(iii) Character certificate from the last institution attended.
Please note the following :

• Attending the interview does not qualify you for admission.
• In case of any delay on your part, your candidature will stand cancelled.

Principal.

2. When you want to repeat the same formatting at different places in your

document, you can take the help of

(i) Character formatting

(ii) Paragraph formatting

(iii) Style

(iv) Tabs

3. Which of the following is not character formatting?

(i) Text Colour

(ii) Alignment

(iii) Font

(iv) Subscript

4. Which of the following is not a paragraph formatting?

(i) Alignment

(ii) Indentation

(iii) Line Spacing

(iv) Underline style

5. Which of the following cannot be included in a style?

(i) Paragraph formatting

(ii) Character formatting

(iii) Table

(iv) Numbering



The data for the Merging are as follows:

2. Type the text given below, taking note of all the formatting.

Don’t skim over this

Tibetan monks consumed a bowl of this wonder food a day, and lived to the ripe old age of
109. Ayurvedic practitioners have prescribed it for 5,000 years and health-food buffs swear
by its magical properties.

Yet today the reports are conflicting. Because milk, the main ingredient in the preparation
of yoghurt, is considered by many nutritionists to be highly mucous-forming and difficult to
digest, yoghurt has received a step-motherly treatment from the medical community. Yet ounce
for ounce, it packs more calcium, protein, riboflavin, phosphorous and vitamin B12 than milk.

3. Type the text given below, taking note of all the formatting.

Covering All Bases

Dev Dasgupta, 35, is a middle-level manager in a private bank. He’s taken a householder’s
policy to insure his house (valued at Rs 20 lakh), its contents (valued at Rs 3 lakh) and his
wife’s jewellery (Rs 50,000). He also has a comprehensive cover for his pride and joy, a
zippy, new Maruti Zen (cost: Rs 3.6 lakh). Additionally, he’s bought a personal accident
cover for Rs 5 lakh, and a health cover of Rs 2 lakh each for himself and his wife. Here’s
what he pays to secure everything he values. Well, almost everything...

Name Address City Date Time Course

S. Khongwir Malki Shillong 10/6/08 9:30 Comp. Sc.

P. Sharma Malviya Nagar New Delhi 10/6/08 11:30 B.B.A.

S. Sahoo Baily Road Patna 11/6/08 10:45 Mass Comm.

P. Deka Dispur Guwahati 12/6/08 9:30 Biotechnology

A. Sema Church road Dimapur 12/6/08 12:30 Pisiculture

Type of milk used Protein (g) Fat (g) Carbohydrates C a l o r i e s
to prepare yoghurt (g) (g) (g) (g)

Buffalo 89 14 6.3 182

Cow 7 9 9.6 160

Skim Milk 8.4 0.2 6.3 69

Insurance For Premium

For amount (Rs.) Payable (Rs.)

Fire and allied perils 20 lakh 1,300

Contents 3 lakh 195

Burglary, theft, housebreaking 3 lakh 720
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Jeweller 50,000 500

Personal Accident 5 lakh 750

Health 4658

New Maruti Zen 3.6 lakh 12,007

Total Premium 20,130

4. Get some pictures of your school. Now design a calendar for the next year, with one
picture for every month of the year.

APPENDICES

APPENDIX 3.1 : TOOLS IN FORMATTING TOOLBAR
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Style. We can apply a style to
the selected paragraph using
this option.

Font. We can change font of
selected text through this
option.

Bold. We can make selected text
Bold through this option.

Underline. We can underline
selected text through this
option. But we cannot select the
type of underline – for that we
have to open Font dialog box.

Center. We can use this to center
align selected paragraph(s).

Justify. We can use this to
change the alignment of
selected paragraph(s) to justify.

Numbering. We can make
s e l e c t e d p a r a g r a p h ( s )
numbered. But we cannot
change the type of numbering
by this option.

Decrease Indent. This option
allows us to move selected
paragraph(s) to the left, if not
already at extreme left.

Styles and Formatting. Opens
the Styles and Formatting task
pane;  we can use this task
pane to  define and apply styles
or formatting.

Size. We can change size of
selected text through this.

Italic. We can make selected text
Italic through this option.

Align Left. We can use this to
left align selected paragraph(s).

Align Right. We can use this to
right align the selected
paragraph(s).

Line Spacing. We can use this to
make the line spacing of
paragraph(s) to single, double, etc.

Bullets. We can apply bullets to
selected paragraph(s). But we
cannot change the type of
bullets by this option.

Increase Indent. This option
allows us to move selected
paragraph(s) to the right.



APPENDIX 3.2 : MAIL MERGE

Mail to Many in Simple Steps

Border. We can use this to
apply different borders to
paragraph(s) or table(s).

Font Color. This option allows
us to change the color of
selected text.

Highlight. We can use this tool
to highlight selected text.

In Word, we initiate the process of mail merging by starting
the Mail Merge Wizard from the Tools menu.

• The Mail Merge Task Pane becomes visible in the task
pane, asking us to select the type of document we want
– letters, e-mail messages, envelopes, labels, etc. Since
we want to invite your friends through a letter, select
Letters, and click on Next at the bottom of the pane (not
seen in the figure).

• Microsoft Word now prompts for Selecting starting

document. The options provided are Use the current

document, Start from a template, and Start from existing

document. Select the first option. We can later try out
the others on our own!

• We now have to provide the details or the receipients –
like name, address, etc. which will be different for every
letter. The options provided in the task pane are Use

an existing list, Select from Outlook contacts and Type a

new list. We have not yet made any list of friends we
would invite, so select the last option to create a new
one. Click on Create in the task pane.

• The New Address List dialog box opens up for us to
type in the details that will vary from one letter to
another. This dialog box has various buttons that
allow us to make New Entry, Delete Entry, Find Entry,
view existing entries by moving to First, Previous, Next

and Last entry.
• However, it will be very rare that all the fields (like Title,

First Name, etc.) in the New Address List dialog box will
match your requirement. There will be some we don’t
need, while there may be others which are not
included. To modify the list of fields, click on Customise.

• The Customise Address List dialog box opens up. In
this dialog box, we can add new fields, delete or rename
existing fields, and also change the order in which
the fields are arranged by using the Move Up or Move

Down buttons.
• Since we want to send the letters to your friends, delete

the unwanted fields – Title, Company Name, Address

Line 2, ZIP Code (we don’t have ZIP code in India,
instead there is PIN Code), Country (no one is going to
be invited from abroad) and Work Phone by selecting
them one at a time and clicking on Delete button.

9292929292
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• We might also want to invite few of your teachers, but
at a different time. So include Time as a field by clicking
on Add and typing in the field name.

• On the screen is the New Address list dialog box with
the modified field list. Type in the details of your friends;
clicking on New Entry button after completing each
receipient’s details.

• Once we have completed entering the details of your
invitee, click on Close button. We will be prompted to
save the address list. Save it with an appropriate name
– say FriendsList.  The list is saved as a Microsoft Access

database.
• We can now see the Mail Merge Recipients dialog box

containing the details that we have just entered. If we
don’t want to send the invitation to one or more names
in the list, just uncheck the boxes in front by clicking
on them. Click on OK, once done.

• Click on Next on the task pane to proceed with mail
merge. (There are opions like Select a different list and
Edit receipient list). Try them.

• In the document that is open, type in the part of the
letter which is common to all, like the text of your letter.
Don’t put in the name, address or time, since they will
not be the same in every letter.

• The task pane provides assistance to include fields – the data
which we had typed in earlier. We can put the insertion point in
the beginning and click on Address Block to insert the formatted
address. We can also click on More items to see all your fields,
so that we can include the fields of your choice. The selected
field will be inserted where the insertion point is placed.

• Put the insertion point at the beginning of the text. Click on
More items… on the task pane, and enter the name and the various address
fields. Then place the insertion point where we would like to put the time, and
insert the Time field. If need be, we can format these fields.

• At this point, we will not see the data for the fields that we had typed in;
instead we shall only see the field placeholders.

• Click on Next on the task pane to see what the actual letter would look like. In
this view of the task pane, we have options to preview letter by clicking on 

Word Processing Tool
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or  buttons. We can also exclude certain receipients from your list by clicking

on  button. Click on Next to complete the merge process.

• In this task pane view, we can merge your document to
the printer by clicking on Print – meaning that the letters
will be printed one after another, containing the names,
addresses, etc. that we had put in your address list. We
can also merge to a new document by clicking on Edit

individual letters. This will open a new document containing
all your merged letters – if needed, we can then edit them
one by one before printing.
In the above discussion, we learnt the Mail Merge utility

using the task pane. However, when we proceed with mail
merge, the Mail Merge Toolbar also appears with the required

options. Try different tools available on the toolbar.

APPENDIX 3.3 : TEXT WRAPPING STYLES
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The In line with text style insets the graphic in
the text at the location of the insertion point.
The graphic moves as we add or delete text.
The text does not wrap around the graphic;
white space extends to the margins on either
side of the graphic.

Wrapping Style Result



The Square style wraps the text around all
sides of a square bounding the graphic.

The Tight style wraps the text around the
graphic in an irregular shape bounding the
actual image. The graphic moves as we add
or delete text.

The Behind text style has no border around
the graphic. The graphic floats on its own layer
behind the text.

Like the previous case, the In front of text style
has no border around the graphic. But in this
case, the graphic floats on its own layer in
front of the text..

Word Processing Tool
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ELECTRONIC

SPREADSHEET

Introduction

After completing this Chapter, the

student will be able to:

• create, save and open a sheet in

a spreadsheet,

• enter data – text, numbers and

formulas in a sheet,

• navigate within a sheet and also

between different sheets of a

workbook,

• insert and delete cells, rows and

columns in a sheet,

• select, copy, paste and delete cell

data within a worksheet,

• use various formulas and inbuilt

functions provided in the

spreadsheet,

• create error free sheets using

special tools like spell check and

auto correct,

• setup the page and margins of

the worksheets so as to print it in

a paper of desired  choice,

• format the data in the worksheet

entirely or selectively,

• define and apply styles and

• enhance worksheets using

charts.

4

In our daily life, we may have come across a list of
items in tabular form several times. For example,
the shopping bills, the school annual report card,
or the cricket match scorecard. These tables with
rows and columns are called spreadsheets. If we
have to tabulate and analyse the data for the
Indian team’s performance in a cricket series and
submit a project as part of our  course evaluation,
we will perhaps take a chart paper and design the
project, write a report and submit it. That’s the
way we have done it all along. The project may
completely cover all aspects of the series but we
are not happy with it. This is because the project
report is static – we cannot make dynamic analysis
using this paper report. How do we then get
attention of our audience? Welcome to the world
of electronic spreadsheets, where we can do all
these, and much more. Let us see how.

Objectives “It’s a humongous time saver! I did [depreciation

calculations] with spreadsheets before, but

because of tax laws changing so much, you have

to keep track of ACE (adjusted current earnings),

AMT (alternative minimum tax) and four or five

other methods of reporting. And updating would

take four or five hours. Now, with one button,

the information just rolls over.”

Terry Rogers

Consultant, Datacentrik Solutions, Vancouver.



4.1 A SPREADSHEET

A spreadsheet is defined as a large sheet which contains data and
information arranged in rows and columns. There are different spreadsheet
programs available; some are proprietary, like Microsoft Excel, Lotus 123,

etc., others are free/open source like, Gnome Office Spreadsheet Gnumeric,

KOffice KSpread, OpenOffic.org Calc. Spreadsheets, also known as
worksheets, allow us to perform detailed analysis on numerical data.
Data is entered in a cell, which represents the intersection of a row and a
column. The most powerful feature of a spreadsheet is that it automatically
recalculates the result of mathematical formulas if the source data changes.
A spreadsheet can help us quickly record and manipulate a large amount
of numerical information and share it with others in a wide variety of
forms. Since MS-Excel, an integral
component of MS-Office, is one of the
programs which has all these features
and many more we have taken it as a
spreadsheet program.

4.2 STARTING A
SPREADSHEET
PROGRAM

To start follow the steps given below:

1. Click on  button on the

Taskbar.
2. Click on  option in

the pop-up window.

3. Click on 

A blank spreadsheet as shown in figure 4.1 is displayed.

4.3 BASIC SPREASDSHEET ELEMENTS

4.3.1 WORKBOOK AND WORKSHEET

Each speadsheet file is known as a workbook and is stored with a default
extension of .xls. Each workbook can contain many sheets, so various
kinds of related information can be organised in a single file. Each
workbook can contain up to 255 worksheets, but by default it displays
only three. Worksheet is the area where the data is stored and work is
performed. Extra worksheets can be added as and when required.

4.3.2 ROWS, COLUMNS AND CELLS

The rows in a worksheet are numbered from top to bottom along the
left column of the worksheet. The columns are labeled from left to
right with letters. The total number of rows in Excel are 65536 and the

Standard Toolbar Formatting

Active Cell

Active

Figure 4.1 : A blank spreadsheet
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total number of columns are 256. Columns are named from A to IV.
The rows are numbered from 1 to 65536.

A cell is the intersection of a row and a column. A cell is identified
by an address that consists of the column name followed by the row
number. For example, the first cell is referred to as A1, which indicates
that it lies at the intersection of the column A and row 1. This is the
active cell. The active cell is ready for accepting any action or input. A
small group of contiguous cells is defined as a range. The range is
referred to by writing the starting address of the cell in the range:
Ending address of the cell in a range or vice versa. For example A1:A10
(can also be referred as A10 : A1).

4.4 NAVIGATING IN A WORKSHEET

The cursor keys, mouse and the scroll bar can be used to navigate
through the worksheet. However, navigating through the 65,536 rows
and 256 columns using these techniques is very inefficient. To move to
any cell directly without scrolling through the entire worksheet, use
any of the following shortcut methods:

Method 1 : Using key combinations

Movement Key Stroke

One cell up Up arrow key (�����)

One cell down Down arrow key or ENTER (�����)

One cell left Left arrow key (�����)

One cell right Right arrow key or TAB (�����)

Top of the worksheet CTRL + HOME
(cell A1)

End of the worksheet CTRL + END
(last cell containing data)

End of the row CTRL + right arrow key or END +
right arrow key

End of the column CTRL + down arrow key or END +
down arrow key

Method 2 : Using the name box

1. Type the cell address in the Name Box
2. Press ENTER to reach the desired cell.

For example, to move to cell D6, enter D6 in the Name Box and press
ENTER. The cursor is positioned on the cell in the D column and 6th row.

Method 3 : Using the go to dialog box

1. Press F5 or CTRL + G or choose Go To option from the Edit menu to
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Icon Movement

t| To display the first worksheet

u| To display the last worksheet

t To display adjacent worksheets on the left

u To display adjacent worksheets on the right

invoke the Go To dialog box.
2. Enter the cell coordinates in the Reference textbox.
3. Click OK to move to the desired cell.

4.4.1 NAVIGATING BETWEEN WORKSHEETS

To move between worksheets,
simply click on the sheet number
in the lower left corner of the
screen (Figure 4.2). In case the
number of worksheets is more than
the number which can be displayed
use the tab scrolling buttons,
located next to the sheet numbers
and then click on the sheet
number to select it.

The tab scrolling buttons and
their use are given below:

4.5 SAVING A WORKBOOK

To save a Workbook:

1. Choose the Save As option from the File menu or Click on the Save
button on the Standard Toolbar or Close the workbook by clicking
on the Close button. The Save As dialog box is displayed as shown
in the figure.

2. Select the directory in which the file is to be saved.
3. Type the name of the file in the File Name text box.
4. Click Save.

4.6 OPENING A WORKBOOK

To open a workbook:

1. Choose Open option from the File menu or Click on the Open button
on the Standard Toolbar.

2. Select directory in which the file has been saved.
3. Type the name of the file in the File Name field or select the name

by clicking on it.
4. Click Open.

Click on the Sheet
number to open the sheet

Tab scrolling
buttons

Figure 4.2 : Spreadsheet showing different worksheets
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Place the cursor in cell A3
and look at the Formula bar.

Figure 4.4 : Working with Math Function

4.7 USING FORMULAS AND FUNCTIONS

Formulas are entries containing an equation that calculates the value
to be displayed. Please remember, when working with formulas, do not
type in the numbers but type in the equation. This equation will be
automatically updated upon the change or entry of any data that is
referenced in the equation.

4.7.1 ENTERING FORMULAS

Cells in a worksheet can also contain formulas that are helpful in
performing calculations. Formulas are mathematical equations. They
are useful for establishing the relationship between two or more cells.

They contain the coordinates of the
cells that are used in the formula,
operators and functions. When a
formula is entered, the cell
displays the result of the formula.
Formulas must begin with an =
sign, otherwise it is treated as a
text entry (Figure 4.3).

Value displayed in the cell

Figure 4.3 : Using formula in a Spreadsheet

Whenever any cell value is
changed it automatically
recalculates the values of any
formula and displays it in the
relevant cell.

mathematical functions built into
them. The most basic operations
used widely are addition,
subtraction, multiplication and
division. Follow the given steps to
perform addition.

1. Move the cursor to cell A1.
Type 1.

2. Press Enter to move to cell A2.
Type 1 in cell A2.

3. Press Enter to move to cell A3.
4. Type =A1+A2 in cell A3.

Note that the contents of cell
A1 and A2 have been added and
the result is shown in cell A3
(Figure 4.4).

Using Arithmetic Operators

When a number is entered into a cell, it is possible to perform
mathematical calculations using them. Spreadsheets have many



101101101101101

Electronic Spreadsheet

The same steps can be followed to perform other mathematical
operations by simply changing the formula typed into cell A3.

Using Auto Sum

The addition of numbers is one of the most frequently used actions.
Thus, a toolbar button, AutoSum, has been provided to accomplish
this task. The AutoSum button on the Standard toolbar automatically
adds the values above the destination cell or to the left of the destination
cell. The steps to illustrate this are as follows:

1. Click on the destination cell i.e. the cell in which the result is to be
displayed.

2. Click on the AutoSum button, which is located on the Standard
toolbar. The cells containing the numbers to be added automatically
should now be highlighted.

3. Press Enter to see the result in the destination cell.

4.7.2 FUNCTIONS

This has a set of prewritten formulas called functions. Functions are
special programs that accept data and return a value after processing
the data. Functions differ from regular formulas because they accept
values and not the operators, such as +, -, *, or /. For example, the
SUM function can be used to add numbers in place of the ‘+’ operator.
When using a function, remember the following :

• Use an equal to sign (=) to begin a formula.
• Specify the function name.
• Enclose arguments (data accepted by a function) within parentheses.
• Use a comma to separate arguments.

Some commonly used Functions are listed in Table representing
some commonly used Functions (Appendix 4.1)

4.7.3 COPYING AND PASTING FORMULAS AND FUNCTIONS

Sometimes when working with formulas, the need arises to repeat the
same formula for many different cells. The formulas can be copied
using various methods.

Method 1 : Using the Edit menu

Steps are given below:

1. Click on the cell that contains the formula.
2. Choose the Copy option from the Edit menu.
3. Click on the cell where the formula is to be copied.
4. Choose the Paste option from the Edit menu. Note the change in

the cell reference.
5. Press Esc to exit the Copy mode.
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Method 2 : Using the Formatting Toolbar / Keyboard Shortcuts

Steps are given below :

1. Click on the cell that contains the formula.

2. Click on the Copy icon  located on the Formatting toolbar or
press Ctrl + C keys.

3. Click on the cell where the formula is to be copied.

4. Click on the Paste icon  located on the Formatting toolbar or

press Ctrl + V keys.

5. Press Esc to exit the Copy mode.

If a formula needs to be copied to multiple cells, use the AutoFill
feature discussed later in the lesson.

4.7.4 CELL REFERENCING

Observe that when you copy and paste formulas, they are pasted relative
to the position they are copied from. This is because of the way the
formula treats the cell references. The cell coordinates in the formula
are known as cell references. Two commonly used cell references are –
Absolute and Relative.

Absolute Referencing

Absolute referencing implies that the coordinates of a cell are not
changed when a formula is copied from one cell to another. To make a
cell address an absolute cell address place a dollar sign in front of
both the row and column identifiers. For example, $A$1 implies that
both row and column have been fixed or made absolute. In simple
words this means that while copying this formula to another cell,
neither the column name nor the row number will change.

Relative Referencing

With relative cell referencing, when we copy a formula from one area
of the worksheet to another, it records the position of the cell relative
to the cell that originally contained the formula. This is the default
mode of referencing in a spreadsheet.

The F4 key is used to toggle between the absolute and relative
modes of referencing cells.

4.8 WORKING WITH WORKSHEET RANGES

Each cell is referred to by a cell address. A group of cells are referenced
using a reference operator. There are two types of reference operators,
range and union.
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• A range reference refers to all
the cells between and including
the reference (Figure 4.5). A
range reference consists of two
cell addresses separated by a
colon. The range reference
B1:B4 includes cells B1, B2, B3
and B4. The range reference
A1:B3 includes A1, A2, A3, B1,
B2 and B3.

• A union reference includes two
or more references. A union
reference consists of two or
more cell addresses separated by a comma. For example, the
reference A1, B5, C7 refers to cells A1, B5, and C7. Similarly, the
reference A1:A3,B4:B6 refers to cells A1, A2, A3, B4, B5 and B6.

4.8.1 USING RANGE NAMES IN FORMULAS

When working with large volumes of data in a worksheet, it is frequently
desirable to refer to a range of cells repeatedly. For example, if a column
in the worksheet contains the price of products, it will be required
again and again for calculating the total price of all products or
calculating the average price and so on. In such a case, it is convenient
and efficient to name this range meaningfully and use the name of the
range instead of the cell coordinates. Naming a range of cells has the
following advantages:

• Names are easier to remember than cell coordinates.
• Names make navigation in a worksheet easier.
• Named ranges can be used throughout a workbook easily. This is

very helpful while linking
worksheets in a workbook.

4.8.2 CREATING RANGE

 NAMES

Steps to create a named range are:

1. Select the cell or range of cells
to be named.

2. Choose the Name option from
the Insert menu.

3. Choose the Define option from
the Name sub-menu. The Define
Name dialog box is displayed as
in figure 4.6.

4. Type in the name of the range in
the Names in a workbook text box.

Figure 4.5 : Worksheet Range

Type the name
of the Range

The Range
reference

Figure 4.6 : To create Range Name from Name Option

of the Insert Menu
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Figure 4.8 : Inserting a column

Blank

5. Click on the Add button to create the name. The name is
immediately added to the existing names in the box.

6. Click on the OK button to close the dialog box.

4.8.3 USING RANGE NAMES

Simply type the name in the formula in place of the cell coordinates.
For example, to find the maximum of a range of marks named Maths,
the formula will be  =MAX(Maths).

4.9 WORKING WITH ROWS AND COLUMNS

Figure 4.7 : Inserting a row

To add extra information to a
worksheet, it may sometimes be
desirable to insert new rows and
columns. To insert a new row/
column, execute the following steps:

4.9.1 INSERTING A ROW

1. Click on the Row Number (or any
cell in that row) above which
the new row is to be added.

2. Choose the Rows option from
the Insert menu. A row is
inserted above the selected row
(Figure 4.7).

3. Click any where in the
spreadsheet to remove the
selection.

4.9.2 INSERTING A COLUMN

1. Click on the Column name (or
any cell in that column).

2. Choose the Columns option from
the Insert menu. A column is
inserted to the left of the
selected column (Figure 4.8).

3. Click anywhere in the
spreadsheet to remove the
selection.

4.9.3 DELETING ROWS AND

COLUMNS

When the contents of an entire row

or column are to be deleted, perform the following steps:

1. Click on the Row Number/Column Name to be deleted.
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2. Choose the Delete option from the Edit menu or right click and
select Delete option from the pop-up menus.

3. Click anywhere in the spreadsheet to remove the selection.

4.9.4 INSERTING AND DELETING CELLS

We can insert or delete individual cells also, rather than the entire
row or column.

Inserting a Cell

1. Click on the cell where new cell(s) is to be inserted.
2. Choose the Cells option from the Insert menu.

The Insert dialog box is displayed (Figure 4.9).
3. Choose the appropriate option. The result of

each option is explained as under:

(a)Shift cells right – adds a blank cell to the
left of the selected cell.

(b)Shift cells down – adds a blank cell above
the selected cell.

(c) Entire row – adds a new row above the
selected cell.

(d)Entire column – adds a new column to the
left of the selected cell.

4. Click on OK button.

Deleting a Cell

1. Click on the cell which is to be deleted.
2. Choose the Delete option from the Edit menu.

The Delete dialog box is displayed as shown
in figure 4.10.

3. Choose the appropriate option. The result of
each option is explained as under:

(a) Shift cells left – the cells to the right of
the deleted cell are moved left.

(b) Shift cells up – the cells below the deleted
cell are moved up.

(c) Entire row – deletes the entire row and
moves the row below upwards.

(d) Entire column – deletes the entire column
and moves the row to the right leftwards.

4. Click on OK button.

Figure 4.9 : Insert dialog box

Fiugre 4.10 : Delete dialog box

Note: If there is any data at the extreme right or at the end of the worksheet, it
does not allow us to insert cells or rows. This is because, it does not delete
existing contents from the worksheet while inserting cells. For example, if there
is data in row number 16,384, then inserting a row will result in an error.
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Figure 4.11 : Clear data using Edit Menu

4.9.5 CLEARING DATA

To delete an entry in a cell or a group of cells, place the cursor in the
cell or highlight the group of cells and press the Delete key. Note that

this method only clears the cell contents and
not the cell formats or comments.

Alternatively, use the Edit menu that allows
an option of what to delete.

Steps for clearing data using Edit menu are
as under:

1. Click on the cell or select the cell range whose
contents are to be deleted.

2. Choose the Clear option from the Edit menu.
3. Choose the relevant option from the Clear

sub-menu.

The Clear sub-menu offers four choices
(Figure 4.11) explained as below:

• All – to delete all formats, contents and
comments.

• Formats – to delete formats only.
• Contents – to delete contents only.
• Comments – to delete comments only.

4.10  SELECTING CELLS

To perform a function on any particular cell or a group of cells, the cell
or cells need to be first selected. Selecting a single cell is as simple as
clicking on it.

4.10.1 SELECT A ROW

To select an entire row, click on the row number to be selected on the
left hand side of the spreadsheet.

4.10.2 SELECT A COLUMN

To select an entire column, click on the column label at the top of the
spreadsheet.

4.10.3 SELECT ALL CELLS IN A WORKSHEET

Click on the empty grey box in the left corner between A and 1. This
area is called the Select All button.

4.10.4 TO SELECT A CONTIGUOUS GROUP OF CELLS

To select adjacent cells, use any of the following methods.
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Figure 4.12 : Selecting Contiguous Group of Cells using

Name Box

Method 1 : Using the Name Box

1. Click on the Name Box.
2. Type the cell reference of the

starting cell and the ending cell
separated by a colon in the
Name Box. For example, to
select cells A3 to A10, type
A3:A10 in the Name Box.

3. Press Enter to select the cells.

For example, as shown in the
figure 4.12, typing A1:D1 in the
Name Box selects the cells in the
specified range i.e. A1,B1,C1,D1.

Method 2 : By Dragging

1. Place the cursor in the starting cell.
2.  Holding down the left mouse

button, drag the mouse over the area which is to be selected.

4.10.5 TO SELECT NON–CONTINUOUS GROUP OF CELLS

1. Place the cursor in cell A1.
2. Press the left mouse button.
3. While holding down the CTRL key and left mouse button, move

mouse from starting cell to ending cell. Holding down the Ctrl key
enables one to select non–contiguous areas of the worksheet.

4. Perform the desired operation or Press Esc and click anywhere on
the worksheet to remove the highlighting.

4.11  EDITING CELL CONTENTS

After entering data into a cell, changes can be made to it using any of
the following methods:

Method 1 : Using the F2 Key

1. Move the cursor to the desired
cell whose contents have to be
edited.

2. Press F2. Make the necessary
changes.

3. Press Enter.

Method 2 : Using the Formula Bar

1. Move the cursor to the desired cell
whose contents have to be edited.

2. Click in the formula area of the
Formula Bar. (Figure 4.13)

Figure 4.13 : Editing Cell Content

Formula Bar
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Icon Effect

Left  aligns the selected text

Centers the selected text

Right aligns the selected text

3. Make the necessary changes.
4. Press Enter.

Method 3 : Double-click in the Cell

1. Move the cursor to the desired cell whose contents have to be edited.
2. Double-click in the cell.
3. Make the necessary changes.
4. Press Enter.

4.12  FORMATTING WORKSHEETS

4.12.1  ALIGNING CELL CONTENT

By default, text entries are left aligned and formulas and numbers are
also left aligned. These alignments can be changed. Apart from the
Left, Right and Center alignment options, the entries can be aligned
vertically also. There are two methods for changing the horizontal cell
alignment as explained below.

Method 1 : Using the Menu

1. Click on the cell to be aligned.
2. Choose the Cell option from the Format menu. The Format cells

dialog box appears.
3. Choose the alignment tab.
4. Click to open the drop-down box associated with the horizontal

field. After the drop-down box is opened, select the desired alignment
as Right, Left or Center.

5. Click OK to close the dialog box.

Method 2 : Using the Format Toolbar

1. Click on the cell to be aligned.
2. Click on the appropriate alignment button in the Format toolbar to

change the alignment.

To change the vertical alignment select the desired alignment as
Center or Bottom from the Vertical drop-down box in the Format Cells
dialog box displayed above.

Note : To make the line of data fit evenly within the height of a cell,
choose the justify option.
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4.12.2  CHANGING COLUMN WIDTH

There are two methods to change the column width.

Method 1 : Using the Menu Bar

1. Place the cursor anywhere in the column whose width is to be
changed.

2. Choose the Column option from the Format menu. A dialog box
opens.

3. Type in the required Column width in the dialog box and
click on OK.

Method 2 : By Dragging

1. Place the cursor on the line between the B and C column headings.
The cursor with two arrows appears.

2. Move the mouse to the right while holding down the left mouse
button. The width indicator appears on the screen.

3. Release the left mouse button when the width indicator shows the
desired width.

4.12.3  CHANGING ROW HEIGHT

There are two methods to change the row height.

Method 1 : Using the Menubar

1. Place the cursor anywhere in the row whose height is to be changed.
2. Choose the Row option from the Format menu. A dialog box opens.
3. Type in the required Row Height in the dialog box and click on OK.

Method 2 : By Dragging

1. Place the cursor on the line between the 1 and 2 row headings. The
cursor should look like the one displayed above, with two arrows.

2. Move the mouse downwards or upwards while holding down the left
mouse button. The height indicator appears on the screen.

3. Release the left mouse button when the height indicator shows the
desired height.

4.12.4  CHANGING FONT ATTRIBUTES

The Font style, size and colour can be easily changed in a
spreadsheet to dress it up a little. To set the Font properties perform
the following steps.

1. Click on the cell whose font properties are to be changed.
2. Choose the Cell option from the Format menu. The Format cells

dialog box appears.
3. Choose the Font tab.
4. Change the Font type, style, size and colour using the appropriate options.
5. Click on OK.
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Alternatively use the formatting tools available on the Formatting
tool bar for changing the type, size and colour of the text.

4.12.5  MAKING FORMAT CHANGES

Auto Formatting Worksheets

The Auto Format is a tool for creating pleasing worksheets with various
formats quickly and easily. To Auto format a worksheet, follow the
given steps:

1. Choose the Auto Format option from the Format menu.
2. Select the format to apply.
3. Click on OK.

Figure 4.14 : Style option dialog box

Modifying Styles

The worksheet allows users to
create, store and use individual
formatting styles. A style can be
defined as a collection of formats
such as font size, patterns, and
alignment that can be defined and
saved as a group. To add or modify
styles perform the following steps :

1. Choose Style option from the
Format menu.

2. In the Style name box, type a
name for a new style (Figure 4.14).

3. To change formats for an existing style, click the style you want to change.
4. Click Modify.
5. On any of the tabs in the dialog box, select the formats you want,

and then click OK.
6. Clear the check box for any type of formats that are not to be included

in the style.
7. To define and apply the style to the selected cells, click OK.
8. To define the style without applying it, click Add, and then click Close.

Additional Formatting Options

Special Cell Borders

Another formatting feature, which can improve the readability of a
spreadsheet, is to add borders around cells. This is especially useful if
spreadsheet needs to be printed, because, by default, the light grey
cell gridlines don’t appear when a spreadsheet document is printed.

To set borders, the steps are:

1. First select the cells on which you want to put borders.
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2. Then click the Borders button on the toolbar at the
top of the screen .

3. Select a border style from the options that are
displayed in figure 4.15. In the example below, the All
Borders options is selected – this places a single line
around all sides of all of the selected cells.

It is also possible to give different borders on different
sides of a cell or have coloured borders around cells. Use
the Draw borders option for this purpose. For this, follow
the given steps:

1. Click on the down arrow next to the borders

button on the formatting Toolbar.

2. Select the Draw Borders option
from the drop-down menu. The
Borders toolbar is displayed as
shown in figure 4.16.

3. Choose the colour of the border
and the type of the border and
draw borders or grids.

Special Cell Shades

Cells can be filled with various
colours or shading effects. For
achieving this, use the Patterns tab
of the Format cells menu. The steps
to be followed are given below:

1. Select the cells to which cell
shading is to be applied.

2. Choose the Cells option from
the Format menu.

3. Click on the Patterns tab.
4. Choose the desired colour and/

or pattern from the available list.
5. Click on OK.

Protecting Cells

It allows us to set Protection options to prevent editing (or even viewing)
of all or parts of a workbook. This can be very useful while sharing a
spreadsheet with others or even to prevent accidental altering of labels
and formulas once they are all completed.

It is necessary to set an option to unlock cells that may still require
change after a worksheet is protected. By default every cell has its
Locked property set to true. For unlocking cells :

1. Select the block of cells to be unlocked.

Figure 4.15 : Choose Border

Options

Figure 4.16 :  Draw Border Options

Click to choose
border type

Click to choose
border colour

Click to toggle
between drawing
borders and grids

Figure 4.17 :  Format cell window for protecting cells



112112112112112

Computers and Communication Technology

112112112112112 Figure 4.20 : Applying different colours to different sheets using Format Tab Color

2. Choose the Cells option from the Format menu.
The Format Cells window appears as shown in
figure 4.18.

3. Click on the Protection tab.
4. Click in the box next to Locked to remove the check

mark.
5. Click OK. The Locked property for these cells is

now disabled.

Conditional Formatting

This feature allows the user to apply formats to cells
that satisfy a predefined criterion. To apply
conditional formatting, perform the following steps:

1. Choose Conditional Formatting option from the
Format menu.

2. In the Conditional Formatting dialog box
(Figure 4.19) specify criteria using the various options.

Figure 4.18: Protect sheet

dialog box

Figure 4.19 : Conditional formatting dialog box

3. Click Format.
4. Select the font styles, borders,

shading and other options to be
applied.

5. Click OK to apply the formats
to cells that meet the specified
criterion.

Tab Colours

To separate out worksheets from
one another, it is possible to give
different colours to the name of the
worksheets at the bottom left

corner. The steps to be followed for achieving this are:
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1. Click on the Sheet name.
2. Right click and in the pop up box choose the Tab Color option.
3. Select the desired colour from the Format Tab Color Dialog Box as

shown in figure 4.20.
4. Click on OK to see the effect.

4.12.6 USING CHARTS

Charts are an excellent tool to present data in a worksheet in a visually
appealing format which aids in analysing and comparing data. The
Chart Wizard button  guides through the steps for creating an
embedded chart. The steps are as follows:

1. Highlight all the cells that need to be included in the chart
including headers.

2. Choose the Chart option from the Insert menu.
3. Choose the suitable Chart type from any of the available types. We

will select Column. There are various types available like Pie Chart,
Bar Chart, Line Chart, etc.

4. In the Chart Sub-type box, choose the Clustered Column icon to
select the chart sub-type.

5. Click Next.
6. The next step displays the address of the cell range selected for

preparing the chart. If the need arises, this range can be changed
by clicking on the collapse dialog box.

7. Click Next.
8. To place the Subject data on the x-axis, select the Rows radio button.
9. Click Next.

10. Type Class XI Performance in the Chart Title textbox.
11. Type Subjects in the Category (X) Axis field. Subjects will appear

as the x-axis title.
12. Type Marks in the Value (Y) Axis field. Marks will appear as the y-axis title.
13. Choose the Data Table tab.
14. Select Show Data Table if required.
15. Click Next.
16. Choose the As Object in Sheet1 option to make the chart an embedded

object and part of the current worksheet. In case we need it on a new
sheet, then we may choose the option As New Sheet.

17.Click Finish.

Activity

Let us explore it by ourselves creating a worksheet and using different Chart Options.

4.12.7 USING SPECIAL TOOLS

Spell Checking

The Spell Check feature of spreadsheet is same as that for Word
Processing which we used in the previous chapter.
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Figure 4.22 : Find and Replace Dialog Box

Click Here

1. Select the range of cells to be checked.

2. Click on Spelling  button on the Standard Toolbar.

3. On locating an error, make changes accordingly.

AutoCorrect Worksheets

The AutoCorrect feature can
correct common typing errors
during working. For example, it can
change “adn” to “and” and change
“their is” to “there is.” The
commonly misspelt words can be
added as an AutoCorrect entry
(Figure 4.21). The common
misspelling is then automatically
corrected.

4.12.8 FINDING AND

 REPLACING DATA

This feature is useful in finding
and replacing multiple occurrences
of a value in the worksheet quickly
and efficiently. The steps involved
are as given below:

Specify the
commonly
misspelled words,
Click on Add and
then OK

Figure 4.21: AutoCorrect Dialog Box

1. Click on the cell whose value
is to be found and replaced.

2. Choose the Replace option from
the Edit menu. The Find &
Replace menu box opens
(Figure 4.22).

3. Enter the text to be found in
the Find What textbox.

4. Enter the text to be replaced
with in the Replace With textbox.

5. Click on the Replace All button
and then Click on OK when
prompted.

6. Click on Close to come out of
the dialog box.

4.12.9 USING AUTOFILL

Excel contains a feature called AutoFill, which copies a logical series
of values, labels or formulas. The AutoFill handle, which is like the “+”
mathematical operator, can be located at the bottom right corner of
the active cell.

To fill series perform the following steps:
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Dragging the fill handle across five cells

Figure 4.23 : Using AutoFill option

Note : Advanced options on creating such auto-fill series are
available with the menu command Edit > Fill > Series.

1. Click on the first cell and type in “01-May”.
2. Click on the cell again and then position the mouse in the bottom

right of the cell so that the cursor turns to a small black plus sign,
as shown below.

3. With the cursor, click, hold and drag the mouse down.
4. It automatically copies the date and increments by one day for

each cell going down, giving the series 1-May, 2-May, ... , 10-May.
It keeps showing exactly which day is being filled. Release the mouse
when the desired date is reached (Figure 4.23).

4.12.10  ADDING COMMENTS

Cell comments are additional
explanatory notes which can be
attached to a cell in a spreadsheet.

Cell comments are indicated by
the small red triangle in the upper
right corner of the cell. To view
the comment, rest the pointer over the cell. A text box will appear, as
shown in the figure 4.24.

To add a comment to a cell follow the given steps:

1. Click on the cell to which the comment is to be added.
2. Choose Comment from the Insert menu.
3. In the box, type the comment text.
4. Once the comment is typed, click outside the comment box. The

comment disappears but a small red triangle appears at the top
right corner of the cell.

To edit an existing cell comment, follow the given steps:

1. Click on the cell with the comment we want to edit.
2. On the Insert menu, click Edit Comment.
3. Edit the comment and click outside the comment box.

Figure 4.24 : Adding Comments
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4.13  PRINTING A WORKSHEET/WORKBOOK

The simplest way to print a workbook is to click the Print icon located
on the Standard toolbar. Dotted lines will appear on the screen after
clicking on the print icon. These dotted lines indicate the right, left,
top, and bottom edges of the printed pages. Before the printing can be
done, it offers a variety of options to customise the printing according
to specific needs.

4.13.1 PRINT PREVIEW

There are many print options. All
Office packages offer a facility of
previewing a worksheet before it
is actually printed in order to
customise the print according to
one’s specific requirements. Print
options can be selected using the
Page Setup dialog box or in the
Print Preview. In Print Preview, it
is possible to see the results of
selections onscreen.

Figure 4.25 : Preparing a worksheet for printing

4.13.2 PRINT A SPREADSHEET

To print a spreadsheet:

1. Choose Print Preview option
from the File menu or click on
the Print icon in the Standard
toolbar.

2. Click Setup.
3. Choose the Page tab (Figure 4.25).
4. Choose Portrait or Landscape.
5. In the Adjust To field, type 100%

to set the size to 100%.
6. Choose the Margin tab.
7. Check the Horizontally box in

the Center On Page frame to
cen t e r the spreadshee t
horizontally.

8. Click OK.
9. Click Print. The Print dialog box

opens.
10. Click OK to print the file.
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Summary

• A spreadsheet, also known as a worksheet, is a row and column arrangement of data
and the formulas to manipulate the data.

• A spreadsheet can be used for a variety of applications like business forecasts, inventory
control and accounting.

• Every Excel file is a workbook that can contain more than one worksheet.

• Cell is defined as the space where a specified row and a column intersect.

• Worksheets can contain labels, numbers or formulas.

• Worksheet allows selecting both contiguous and non-contiguous cells.

• A range is a group of cells referenced with a name. The range reference consists of the
first and last cell addresses separated by a colon.

• The AutoSum button on the Standard toolbar adds numbers automatically and also
suggests the range of numbers to be added.

• Formulas and functions are automatically updated with a change in the source cell or
position of the formula.

• In Relative referencing, the reference is adjusted relative to the new location of the formula.

• In Absolute referencing, the cell reference does not change but remains fixed while pasting
formulas.

• Functions are pre-written formulas which must begin with an “=” sign.

• Cell ranges can be named and used in place of cell references.

• The AutoFill handle is a very useful tool to fill in logical series.

• Cell comments are additional explanatory notes which can be attached to a cell in a
spreadsheet.

• Charts are an excellent tool to present data graphically and also help in analysing and
comparing data.

• The most powerful feature of a spreadsheet package is the “What-if analysis”. Using this
feature, we can change values and immediately see the effect as the entire worksheet is
automatically updated, based on the change in the values.

EXERCISE

SHORT ANSWER TYPE QUESTIONS

1. Define spreadsheet. Name any two spreadsheet software.

2. How many rows and columns are there in MS Excel?

3. How can you write a formula in Excel? Write a valid formula.

4. What is the shortcut to print current time in a cell?
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5. Create a table to summarise the alignments of different types of datatype.

6. What is the use of auto correct option?

7. What is the use of print preview feature?

8. What is the use of auto sum feature?

9. How many function categories and functions are there in Excel? What do you
understand by automatic recalculation feature of a spreadsheet?

10. Differentiate between relative and absolute cell referencing with the help of
suitable examples.

11. Explain the uses of any two inbuilt mathematical functions in Excel.

12. Differentiate between the COUNT( ) and COUNTA( ) functions of Excel.

13. What is the function of the auto fill handle in Excel?

LONG ANSWER TYPE QUESTIONS

1. What do you mean by conditional formatting? Explain.

2. Explain any five types of charts in Excel.

MULTIPLE CHOICE QUESTIONS

1. A range refers to a  of cells.
(i) Row

(ii) Column
(iii) Group of contiguous cells
(iv) Group of non-contiguous cells

2. In  referencing, the cell reference does not change while copying
formulas.
(i) Relative referencing

(ii) Absolute referencing
(iii) Mixed referencing
(iv) None of the above

3. Which of the following function keys is used as a toggle key for changing
referencing modes?
(i) F2

(ii) F8
(iii) F4
(iv) F6

4. Which one of the following is the default folder for saving the files?
(i) c:\

(ii) d:\
(iii) my documents
(iv) new folder

5. A valid formula in Excel begins with:
(i) +

(ii) –
(iii) #
(iv) =
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6. How many sheets are there in a workbook by default:
(i) 1

(ii) 2
(iii) 3
(iv) 4

7. Which function key is used to edit cell contents:
(i) F1

(ii) F2
(iii) F3
(iv) F4

8. Height of a row in Excel is:
(i) 12

(ii) 12.25
(iii) 12.50
(iv) 12.75.

Activities

ACTIVITY 4.1

Prepare an analytical result report of Second Monday Test Round Exam of your class in the
format given below.

A B C D E F G H

1 1ST QUARTERLY CYCLE TEST

2

3 Name English Maths Science S. Science Computer Lang Total
II Marks

4 Ankit 78 65 77 88 76 54

5 Achala 77 98 90 66 99 76

6 Himanshu 67 78 87 56 84 92

7 Paarth 81 91 98 77 100 78

8 Total
Appeared

10 Highest M.

11 Lowest M.

Instructions

• Calculate the total marks obtained by each student in column I.
• Calculate the highest and lowest marks obtained in each subject in row 9 and 10

respectively.
• Also calculate the aggregate/percentage marks obtained by each student in column J
• Give the number of students appearing for each subject in row11.
• Find the subject-wise average marks  and display them in the row 8.
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ACTIVITY 4.2

Prepare a score sheet of an inter-house cricket match in your school:

A B C D E

India vs. Pakistan

Batsman Balls Faced Fours Sixes Singles Total

Gurman  Singh 61 7 3 23

Harinder Singh 12 2 4 2

Sachin Gupta 132 21 10 64

Gaurav Sachdeva 17 4 5 7

Ishwaq Ahmed 23 3 3 6

Instructions

• Calculate the total runs obtained by each student in column E.
( Total = No. of sixes x 6 + No. of fours x 4 + No. of Singles)

• Calculate the Strike Rate of each batsman in column F.
• Draw the pie chart to compare the strike rate of each batsman.

ACTIVITY 4.3

Prepare a personal expenditure report of last financial year in the format as below.

A B C D E F G

1 Pocket -Money Expenditure Report 2008-09

2

3 Month Mobile Travel Hobby Dinner Dates Savings Total

4 April 1200 900 500 1000

5 May 1440 788 700 1500

6 June 1320 1110 700 1200

7

8

9

Instructions

• Assume that you are given a monthly pocket-money of Rs. 6000.
• Calculate the savings made by you every month.
• Calculate the total expenditure in each month.
• Calculate the highest and lowest expenditure made.
• Calculate the total savings after the three months
• Draw the bar graph to compare the expenditure of various months.
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Electronic Spreadsheet

Our School Canteen

A B C D E

1 Weekly Purchase/Sale Report of Items

2                              Weekly Investment        Weekly Sale

3 Item Name Qty. Made Cost Price (Rs.) Qty. Sold Selling Price (Rs.)

4 Samosa 250 2 245 3

5 Sandwitch 150 4 139 5

6 Fried Rice 300 7 300 10

7 Tea 225 2 225 3

ACTIVITY 4.4

Prepare a report on purchase and sale of any 10 items of a shop over a week depicting the
profit/loss in the format specified below.

Instructions

• Calculate the total amount invested on each of the items. Total Amount Invested=Qty.
Purchased * Cost price.

• Calculate the total selling price of each of the items. Total Selling Price=Qty. Sold *
Selling Price.

• Calculate the Profit/Loss of each of the items. Profit/Loss =Total Selling Price-Total
Amount Invested.

• Calculate the overall Profit/Loss made by Our School Canteen.



APPENDIX

APPENDIX 4.1 : ANNEXURE – TABLE REPRESENTING SOME COMMONLY

USED FUNCTIONS

Function Description

SUM() The SUM function is used to calculate
the sum of the numbers passed as
arguments.

Average() The AVERAGE function is used to
calculate the average of the numbers
passed as arguments.

MAX() The MAX function returns the largest
value among the values passed as
arguments.

MIN() The MIN function returns the
smallest value among the values
passed as arguments.

COUNT() The COUNT function is used to count
the number of cells that contain
numbers within the list of
arguments.

COUNTA() The COUNTA function is used to
count the number of cells that
contain data within the list of
arguments.

COUNTIF() The COUNTIF function is used to
count the number of cells within a
range that meet the given criteria.

Syntax

=SUM(number1, number2, …….)

=AVERAGE(number1,number2……..)

= MAX(number1, number2, …….)

= MIN(number1, number2, …….)

= COUNT(value1,value2……..)

= COUNTA(value1,value2……..)

= COUNTIF(range, criteria)
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ELECTRONIC

PRESENTATION TOOL

Introduction

After completing this Chapter, the

student will be able to:

• design  different types of slides,

• recognise type of views of

presentation,

• insert graphics, audio and video

in a presentation,

• copy and move text and slides

within and between presentation

files,

• apply designs in slides, adding

animation effects to the text,

• add slide transition effects, and

hyper linking,

• create action buttons,

• run a slide show and

• pack a presentation file to run it

on a computer not having the

presentation software.

5

For our school exhibition, we want to prepare an

exhibit on any current issue – global warming, drug

abuse or child labour. We could prepare our exhibit

in the conventional way, i.e. by using static tools,

like charts and posters and maybe some visual

images. Imagine the impact if, instead of the

charts, we have music, moving objects and

graphics displaying the message.

The objective of the exhibition is to make our

message understood and remembered by others.

An average human being has a very short attention

span. Audio-visual aids can make presentations

more interesting, dynamic and effective. Therefore,

we can make it more interesting and attention

seeking by making the characters move/dance,

use pictures/charts/graphics, play music or show

video. Thus we manage to create a much better

impression. How can we do this?

Objectives
"Projected slides should be as visual as possible

and support your points quickly, efficiently and

powerfully."

Garr Reynolds

(Associate Professor of Management at Kansai Gaidai

University)
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5.1 AN ELECTRONIC PRESENTATION

An electronic presentation program is used to display information.
This information is normally displayed in the form of a slide show –
the information is shown on a slide which is viewed on a computer's
monitor, or beamed on a screen using a LCD projector.  A presentation
can have several slides, which can be displayed one after the other.
The information presented can be an assortment of text, graphics,
audio and video.

Why do we call the screen of information a slide? The word slide is a
reference to the slide projector, which is somewhat obsolete today,
thanks to electronic presentation software. In the days of slide
projectors, each slide had to be shot by a camera, specially developed
in a studio, and then placed on a slide projector for projection on a
screen. Today, however, we can just design our slide on a computer
using a presentation software and project it.

There are different types of presentations like professional (work-
related), educational and for general communication. Presentation
programs can either supplement or replace the use of older visual aid
technology, such as pamphlets, handouts, chalkboards, flip charts,
posters, slides and overhead transparencies.

A commonly used presentation program is Microsoft PowerPoint,
although there are alternatives such as OpenOffice.org, Impress, Corel
Presentations and Apple's Keynote. A presentation program includes
three major components: an editor that allows text to be inserted and
formatted; a method for inserting graphic images, audio and video;
and a slide-show system to display the final content.

In this chapter, we are using the presentation package – Microsoft
PowerPoint – as our learning tool. However, we should remember that
other such programs are also available. If we learn to use one of them,
we will be able to use the others without any difficulty.

5.2 STARTING THE PRESENTATION PROGRAM

Whatever the presentation program we are using, we can start it from
the Program option under the Windows Start menu. For example, to
start Microsoft PowerPoint, click on

• , then on

• , and lastly on

• 

5.2.1 ANATOMY OF THE APPLICATION WINDOW

Any presentation software that we use will allow us to design and show slides.
The application window (i.e., Microsoft PowerPoint window, Openoffice.org
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Impress window, etc.) will provide us with tools that will assist us in
our job (Figure 5.1). The important components of this window are:

• Menu Bar : Provides menu options to help in designing and viewing
the presentation.

• Standard Toolbar : Contains tools for standard tasks, like saving,
printing, cutting, copying, pasting, etc.

• Formatting Toolbar : Provides tools for formatting like bold, italic,
underline, etc.

• Task Pane : Allows options depending on the selected task. The
figure 5.1 shows the options for the task New Presentation. We can
select other tasks too.

• Slide Pane : This is the place where we design the slide by typing,
formatting, etc.

• Slide Sorter Pane : Allows us to decide on the order in which the
slides will be shown during the slide show.

• Notes Pane : Allows us to type in notes that we may need while
preparing for the presentation later, but will not be shown during
the slide show.

• View Buttons : Provides options to decide whether we want to view
slide show, normal slide view, or slide sorter view.

• Drawing ToolBar : Provides tools for drawing basic shapes, inserting
pictures, changing colours, etc.

• Status Bar : This provides information about the current
presentation, like the number of slides, the design applied, etc.

Figure 5.1 : Application window of a Presentation program

Menu Bar
Standard Toolbar

Formatting Toolbar

Task Pane

Slide Pane

Notes Pane

Drawing Toolbar

Slide Sorter
Pane

View Buttons

Status Bar
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After learning documentation and spreadsheet packages, we are
already quite familiar with menu bar, standard toolbar, formatting
toolbar, drawing toolbar, and the status bar.

5.3 STARTING A NEW PRESENTATION

To create a new presentation, click on Blank Presentation on the New

Presentation task pane. We will now see a slide on the slide pane similar
to the one shown in Figure 5.1. This is called the title slide.

The first step to start with any presentation software is to type in
some text in the slides.

It is not necessary that we have to type in something in every
placeholder in the slide. For example, if we do not have any subtitle,
just leave the corresponding placeholder as it is. The text 'Click to add

subtitle' will not be seen on the screen when we run the slide show.

Let us now prepare our first presentation:

• Open the Presentation Program, click on the placeholder (Figure
5.2 ) which says – Click to add title, and type text.

• Click to add subtitle, and type the name.

Figure 5.2 : Title slide

Sizing

Placholders for text
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5.3.1 ADDING A NEW SLIDE

Click on New Slide option on Insert menu or (CTRL + M) and select a
desired layout from the Slide Layout options in the Task Pane.
(Appendix 5.1–5.3)

5.3.2 VIEWS IN PRESENTATION

A presentation can be viewed in several ways as per the location and

demand. Some presentation options are listed below:

Normal View : This view has three panes and shows the outline, the

notes area and the slide. We can type the notes in this place holder

which we might require at the time of showing our presentation. Text

in the notes page does not appear in the slide show.

Outline View : In this view we can see only the text of the slides in the

presentation.

Slide Sorter View : In this view, slides appear of thumbnail size and

they can be moved or sorted according to the requirement. Slides can be

moved by first clicking them and dragging them to their desired location.

Slide Show : This view is used to show the final presentation with all

the effects and colour schemes.

5.3.3 INSERT OTHER OBJECTS

The following is a list of various objects that can be inserted on a slide.

Table : Allows us to insert a table. We can insert the number of rows

and columns required for the table, and then type in the content.

Chart : Allows us to insert a chart. We can type in the data values in

order to develop the chart.

Clip Art : Allows us to insert a clip art, a variety of which normally

comes along with the presentation software.

Picture : Allows us to insert picture – the ones that we might have

clicked using a digital camera, or have scanned using a scanner, or

have got from somewhere else. We have to provide the name of the

picture file we wish to insert.

Diagram or Organisational Chart : Allows us to insert diagrams which

we can select from the diagram gallery. One of the common options is

the organisational chart (a chart showing hierarchy in an organisation,

or a family tree, etc.).

Media Clip : Allows us to insert a media clip like some audio or video

clips. However, to insert a media clip in this manner, Microsoft

PowerPoint requires that the media clip be a part of Microsoft Clip

Organiser.



128128128128128

Computers and Communication Technology

Place the mouse over the desired non-text content and click to

include the same on the slide.

We have already read about inserting Clip Art in the presentation
by selecting a slide layout that allows us to insert non-text content.
There is another way of inserting clip art into the slide. Let us learn
this process:

• Open the presentation.
• Click on Clip Art under Picture option of Insert menu. We will now

see the Insert Clip Art option in the task pane.
• We can insert some text to search clip arts belonging to a particular

group. To try out, let us type in Inspiration and click on . If we

are not sure, just click on  without typing in any text.

• We will see all the available clip arts grouped under our search text
in the task pane.

• Select the desired clip art by clicking on it.
• We will now get the clip art on the slide. We can change its size by

dragging the sizing handles. By click and drag we can place the clip
art at the desired location in the slide.

5.3.4 CREATE A CHART IN PRESENTATION

Sometimes it is useful to project a chart to the audience rather
than listing out raw data. We have learnt how to design charts using

Figure 5.3 shows a slide layout which can be used to insert non-

text content:

Figure 5.3 : Slide layout to insert other objects

Insert Chart

Insert Clip Art

Insert Media Clip

Insert Diagram

Insert Picture

Insert Table
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spreadsheets. Now we will learn how we can get a chart in
presentation software:

• Open the slide where we want to place the chart.
• Generally a Presentation software cannot draw charts. We need to

get the help of some other software. Click on Object under Insert

menu (Figure 5.4 (a)).

If we plan to draw the chart in spreadsheet, select Microsoft Excel

Chart (Figure 5.4 (b)) under Object type and click on OK.

A dummy chart (Figure 5.5) appears on our slide which can be modified with
our data.

• At the bottom of the chart we will notice . Click on Sheet1 and feed

in the data for the chart as we had
done in the spreadsheet.

• We can change what the chart looks
like by using the options under the
Chart menu. (As in spreadsheet)

5.3.5 NAVIGATING ACROSS SLIDES

Now that we have more than one slide
in our presentation, we will need to
move from one to the other while
designing them. We have three
different options for this:

• Press the Page Up (or PgUp) key to
go to the previous slide, press Page

Down (or PgDn) key to move to the
next slide.

Figure 5.4 : Insert Object dialog box

(a) Insert with Object (b) Insert object dialog box with spredsheet chart selected

Figure 5.5 : Dummy Chart
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• Click on the appropriate slide on the Slide Sorter pane.

• Use the scroll bar that appears between the Slide Pane and the

Task Pane.

5.4 SAVING AND OPENING A PRESENTATION

Once made, we would surely like to save the presentation (i.e., store it
permanently) for future reference and use. The process of saving a
presentation and later opening it (or to create a new presentation) is
similar to what we have learnt in Chapter 3 (Word Processing Tool).

We had previously typed in some text in the a slides of the
presentation. Now we save it with a filename, My Presentation.

5.5 FORMATTING TEXT

Now let us learn how to make the slide more presentable by formatting

the text on the slides:

We can format the text either through the Format option under the

Menu Bar, or we can use the Formatting Toolbar to invoke most (but not

all) formatting options (as in word processing). The main formatting

options are –

• Font

• Bullets and Numbering

• Alignment.

Before we format any text, we must select the part of the text we

want to format. For Font formatting, we need to select all the characters

that we want to format; while for the others, we need to select any part

of the paragraph.

5.6 COPY, MOVE AND DELETE TEXT AND SLIDES

For copying, moving or deleting text from and to the same or different

slide in the same or different presentation we can follow the same

procedure as in the case of word processing. When we copy a slide, we

actually duplicate the slide. When we move a slide, we end up changing

the order of the slide in the presentation. These can be done as follows:

• To copy, i.e. duplicate a slide, select the slide (on the Slide Pane or

in the Slide Sorter Pane) and click on Insert →  Duplicate Slide.

• To move a slide or a group of slides, select the slide(s) in the Slide

Sorter Pane and drag them to the desired location.

Note : If we add or edit anything after we have saved the presentation, we will

have to save it once again. Otherwise, the changes made after the last Save

operation will not be saved.
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• To delete a slide or a group of slides, select the slide(s) in the Slide

Sorter Pane and press the Delete key.

5.7 HOW TO VIEW SLIDES?

Most presentation software will provide us with three views:

• Normal view – where we design the presentation.
• Slide Sorter view – this is a view of the slides in the

presentation in thumbnail form. When we have finished
creating and editing the presentation, slide sorter view
gives us an overall picture of it – making it easy to reorder,
add, or delete slides.

• Slide Show view – this takes up the full computer screen. This
is the view that we will use at the time of presentation.

We can move from one view to another by using the options
under the View menu or by clicking on the appropriate View

Buttons. The options under the View menu are given in figure 5.6.

5.8 SLIDE SHOW : PRESENT SLIDES TO THE AUDIENCE

Now that we have somewhat prepared the presentation, its time to
view the show. We are already familiar with the Slide Show option
under View menu and the corresponding View button. We can use either
of them to start the slide show. We can also start the slide show by
selecting the View Show option under the Slide Show menu.

We can also save the
presentation file as PowerPoint

Show. In that case, we will not
have to start the presentation
p r o g r a m t o v i e w t h e
presentation. Just double click
on the file, and we will have
the show on the screen. To save
a file as PowerPoint Show,
select this alternative under
Save as type option in Save As
dialog box (Figure 5.7). To open
the Save As dialog box, click
on File → Save As.

However, to run the slide
show as described above,
we will need to have the

Note : To select multiple contiguous slides, press the Shift key as you click on the
slides one after the other. You can also select the first one, and then click on the
last one while keeping the Shift key pressed. To select non-contiguous slides,
press the Ctrl key instead of the Shift key.

Figure 5.6 : View

Options for Presentation

Figure 5.7 : Dialog Box to save file as PowerPoint Show

Select the type as
PowerPoint Show
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5.8.2 CUSTOM ANIMATION/ANIMATION SCHEMES

We can animate text, graphics, diagrams, charts, and other objects on
the slides by following these steps:

• Select the object.
• Click on Slide show Menu and choose option Custom animation.
• Click on the effects tab to apply the appropriate effect.
• We will see numbers like 1, 2, 3 appearing against the paragraph/

objects – this is the order in which they will appear during the
slide show.

• Repeat the process to apply animation for another instance, say
this time for exit (instead of Entrance).

• Once again, we will need to run the slide show to see the effect.
Click on   at the bottom of Custom Animation task pane.

• We might have to click the mouse to move from one animation to
another.

5.8.3 SLIDE TRANSITIONS…

While animation decides how each item in the slide emerges on the
screen, slide transition takes care of how the slides (and not the
items on the slide) appear one after the other during the show. We
can apply a particular slide transition to all the slides or to some
selected slide(s).

Figure 5.8 : Slide

Designs with the options

for Templates

presentation program in the system. What happens if we take
this presentation file to a machine which doesn't have a
presentation program loaded? Can we run the program?

5.8.1 SLIDE DESIGNS

Now let us learn how to apply Designs to the slides to make
them more attractive.

A slide design determines the background colour and picture
as well as the colour and type of text on it. Follow steps given
below to apply slide design to the templates :

• Click on the Slide Design option under the format menu. This
will show the Slide Design task bar as shown in figure 5.8.

• Click on any design of the choice in the task pane. This
applies the selected design to all slides of the presentation.

• If we wish to apply the design to selected slide(s) of the
presentation, select the slide(s) from Slide Sorter pane. Now,
click on the arrow which appears when we move the mouse
to the desired design in the Slide.

• Design task pane, and click on Apply to Selected Slides

from the resulting menu.
• Run the slide show once more to see the effect.
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To apply slide transitions to the presentation,

• Open the presentation.
• Click on Slide Show and select Slide Transition to see the

options in the task pane (Figure 5.9).
• If we want to apply it to some selected slide(s), select the

slide(s) from Slide Sorter pane. To try out, just select the
second slide of the presentation.

• Select the desired transition effect like Blinds Horizontal,
Box In, Cover Down, etc. from the task pane.

• If we wish, we can change the speed of transition (options
are slow, medium, fast).

Select medium. This option is available under Modify
transition in task pane.

• In addition we can add sound that will be heard during slide
transition. This option is also available under Modify
transition in task pane.

• We can set the slide to advance on a mouse click, or
automatically after a pre-decided delay. Select automatically
and set the value to 00:11.

• Click on  at the bottom of the task pane to see the effect.
• If we wish to apply the selected transition to all slides in the

presentation, click on Apply to All Slides button else click on Apply.

5.8.4 INSERTING SOUND/MOVIES…

Most presentation software allows us to enhance the
presentation by inserting sound and movies. In
Microsoft PowerPoint, we can add them through
following steps:

• Click Insert menu
• Select Movies and Sounds. We can add them using

Clip Organiser or directly from file (Figure 5.10).

If we select the Clip Organiser option, we will see a
selection in task pane very similar to the one we had
seen in case of inserting clip art. Choose the desired
movie or sound clip, and we will have it on the slide.

The other option is to get the movie or sound from
file. If we select these options, we will see Insert Movie
or Insert Sound dialog box, one very similar to the
Save As dialog box. Select the movie or sound file
that we wish to insert.

5.8.5 NAVIGATION BETWEEN DIFFERENT SLIDES USING HYPERLINKS

A hyperlink is a connection from one slide to another or a connection
to a web page, or a file.

Figure 5.9 : Slide

Transition Dialog Box

Figure 5.10 : Insert Menu with the

options of Movies and Sounds
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A hyperlinked object may be a text, a graphic or an action button (a
readymade button) placed on a slide, which when clicked, opens the
connection (another slide, web page, file) the hyperlink was pointing to.

When we point to a hyperlink, the pointer takes the shape of a

pointed finger (L), indicating that it is something we can click on.

To create a hyperlink, first select the text or object that we want or
represent the hyperlink with (for example, in figure 5.11 it is the word

here). Click on Hyperlink from Insert menu. The Insert Hyperlink dialog
box (Figure 5.12) opens up  and we can browse for the file that we
want to link as shown below:

Figure 5.11 : Slide showing an object with hyperlink

Figure 5.12 : Insert hyperlink dialog box
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If we want to create a link to another slide of the same show, then

• Select 'Place in This Document' on the left pane of Insert Hyperlink
dialog box.

• We will see that all the slides of the presentation are listed in the
dialog box.

• From this list, we select the slide we want to go to and click on OK.

If we want to create a link to another slide in a different
presentation, then

• Click on Existing File or Web Page.
• Navigate to the correct folder and select the presentation to which

we want to create the link.
• Click OK.

Similarly, we can make a hyperlink to a web page by giving its URL
in the Address bar. For example to link to www.gmail.com, type
http://www.gmail.com in address bar (Figure 5.13).

Figure 5.13 : Insert hyperlink to a web page

Address bar

5.8.6 ADDING ACTION BUTTONS

To insert an Action Button on the slide,

• Select the slide we want to place the button on.
• On the Slide Show menu, click on Action

Buttons option and select the button we
want from the resulting cascading menu
(Figure 5.14).

• Click on the desired location on the slide, and
we will see the selected Action Button getting
placed there, which can be later resized to suit

Figure 5.14 : Slide show menu with

action buttons
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the requirement. Additionally, the Action

Settings dialog box (Figure 5.15) opens up.
• Select the Hyperlink to option and select the

desired link from the drop down list box.
• Click on OK to complete the process.

If we plan to insert the same Action Button
on all slides of the presentation, click on
Master on the View menu. Select Slide Master.
Now place the button on this Slide Master as
in the previous steps.

5.8.7 AUTOSHAPES

AutoShapes can be used to emphasise certain
points in the presentation. These are available
on the Drawing toolbar. They include several
categories of shapes: lines, connectors, basic
shapes, flowchart elements, stars and banners

Figure 5.15 : Action settings dialog box

and callouts. These can be resized, rotated, flipped, coloured and
combined to make more complex shapes. We can also add text to these
shapes which then becomes part of the shape. Follow the steps given
below to draw an autoshape:

• Click on AutoShapes option on the Drawing toolbar
• Select the desired shape (Figure 5.16),
• Click and drag on the slide to draw the shape of desired size.

Figure 5.16 : Drawing Bar with Auto Shapes  options

The handles (Figure 5.17) around a selected shape have the following
purposes:

• The Sizing handles are the white handles around the shape which
are used to change the size of the shape.

• The Adjustment handle is a yellow-diamond shaped handle. This
handle, if present, indicates that the shape is adjustable.
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• The Rotating handle is the green handle
which can be used to adjust the angle of
rotation of the shape.

A shape could have graphic attributes

such as fill, line, and shadow or text
attributes such as style, font, colour, and
shadow. To put text into the autoshape, select
the autoshape and just type in the desired
text; and we will see the text appearing
within the autoshape. If some text is already
there, the new text typed will be appended
to the exisiting text.

Tools for changing the basic attributes

of a shape - fill color , line color line

style  (which decides on the thickness of the border), dash style 
(which decides whether the border line will be solid, dashed, dotted,

etc.), shadow style , 3-D style  and font color  are located on

the Drawing toolbar. For changing the attributes, we need to select
the autoshape that we have placed, click on the appropriate tool on
the Drawing toolbar, and select the desired option. If we want to
change the text attributes other than font color, select the autoshape
and click on Font option under the Format menu to set the desired
text attributes.

5.9 HOW TO RUN A PRESENTATION FROM A
COMPUTER  NOT HAVING THE PRESENTATION
SOFTWARE INSTALLED?

When we want to  Run a Presentation program from a computer not
having the presentation software installed  then Pack and Go is the
way to do this which is described in Appendix 5.4.

Figure 5.17 : Various handles for

Auto Shapes

Summary

• An electronic presentation program is a computer software that is used to display
information.

• A presentation can have several slides, which can be displayed one after another.

• The places on the slide where we can click and type text for the presentation are called
placeholders.

• The font, size, alignment, etc. will be same as that of the placeholder text, unless we
change them.

• We can select the layout of a slide by selecting appropriate choice from Slide Layout task pane.

Rotating
Handle

Adjustment
Handle

Sizing Handle
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EXERCISES

SHORT ANSWER TYPE QUESTIONS

1. What is meant by slide design?

2. What is meant by animation schemes?

3. How do you change the bullets appearing in your presentation?

4. What are the three major functions of a presentation program?

5. What are placeholders?

6. What do you mean by Pack and Go?

7. What do you mean by slide transition?

LONG ANSWER TYPE QUESTIONS

1. How can a transition help in your presentation?

2. What are the different ‘views’ in the presentation package that you are

familiar with?

• A slide can contain non-text content too, like – chart, clip art, media clips, etc.

• We can apply formatting to the text in the slide – we can change the fonts and their associated
features; we can apply bullets or numbers; and we can decide on the paragraph alignments.

• We can copy or move the content of a slide, or even the slide itself.

• There are three views – normal view to design presentation, slide sorter view to arrange
the order in which slides will appear, and finally the Slide Show view is used while delivering
the talk.

• If we don't like the way our slides look, we can use Slide Design to improve them. We can
apply a slide design to selected slides, or to all slides in the presentation.

• The way various items appear on the slide during a slide show is decided by the Animation

that is applied. We can select preset animation schemes, or decide on our own using
custom animation option.

• Apart from the items in the slide, we can control the way the slide itself appears during
the slide show. This is done using slide transitions facility.

• Instead of listing out raw data, we can insert a chart in the presentation to make the data
more meaningful to the audience.

• We can create hyperlinks on slides to connect it to other slides in the same or different
presentation, or even to a file or a website.

• To facilitate navigation from one slide to another, we can include action buttons in our
slides.

• AutoShapes can be used to get the audience's attention to certain points in the
presentation.

• A presentation file can be made to run on a computer system not having the presentation
software (Pack and Go).
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4. Discuss the process of inserting clip art into a slide.

5. List out the process of creating a hyperlink to connect to a slide in another

presentation.

6. What is an AutoShape? Discuss the formatting that can be applied to an

AutoShape.

7. How is a file saved as type Presentation different from the one saved as type

PowerPoint Show?

10. How can we insert clip art in a slide? Explain.

11. How can we hyperlink a slide? Explain.

MULTIPLE CHOICE QUESTIONS

1. The presentation is seen on the computer or a projection screen in the form of

(i) Slides

(ii) Pages

iii) Papers

(iv) Handouts

2. Animation decides the way

(i) the slides appear

(ii) the items in the slide appear

(iii) the text looks

(iv) the slides look

3. The first slide of presentation

(i) always has the layout – Title slide

(ii) normally has the  layout – Title slide, but can be changed using Slide Layout

task pane.

(iii) normally has the  layout – Title slide, but can be changed using Slide Design

task pane.

(iv) normally has the layout – Title slide, but can be changed using Slide

transition  task pane.

4. While working with AutoShapes, you can change the style of the text using

(i) Font Color

(ii) Line Style

(iii) Select Font from Format menu

(iv) None of the above



Activities

1. Design a presentation to make your friends interested in the book that you have read
recently. Ensure that you use animation and slide transitions. Use AutoShapes to design
an appropriate callout in the first slide.

2. Design a presentation on your favourite singer. Ensure that you include some of his/
her music in your presentation. Place a hyperlink to link to some websites mentioning
his/her achievements.

3. Prepare a presentation of your hobbies like playing cricket, listening to songs, gardening,
photography etc.

4. Create a family magazine containing description of your family members, their role in
the family and their photographs.

5. Prepare a presentation of your school with the following contents:
a. On the first slide, put the name and a photograph of your school.
b. On the second page, display the features of your school.
c. On the third page, put information about the library with a photograph.
d. On the fourth page, Science lab
e. And so on.

6. Suppose you are a student of class XI D and have been asked to prepare a slide show of
new inventions of computer hardware. Collect latest pictures from the Internet and put
them on different slides and also display their features with them.
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APPENDICES

APPENDIX 5.1 : TEXT LAYOUT OPTIONS

Title Slide. Allows us to type
a title and a subtitle for
your presentation. Only the
starting slide of your
presentation will normally
be of this type.

Title and Text. Allows us to
insert a title for the current
slide (not the whole
presentation) and the text
that we want under that
title. This is one of the most
common types of slides.

Title Only. Allows us to type
in only a title. We can use
this in place of Title Slide.

Title and 2-Column Text.
Similar to Title and Text,
except that this allows us
to enter text in two
columns.

Text Layouts
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T itle, Text and Content.
Allows us to add a title on
the top, text on the left
column, 0and a non–text
content on the right
column.

Title, Text and 2–Content.
Allows us to add a title on the
top, some text on the left
column, and two non–text
contents on the right column.

Title and Text over Content.
Allows us to type in a title,
add some text and lastly
insert some non-text content
at the bottom of the slide.

T itle and 2–Content over
Text. Allows us to type in a
title, insert two non-text
content in two separate
columns, and some text in
a single column below the
non–text contents.

T itle, Content and Text.
Similar to the previous one,
but now the non-text
content will be placed on
the left column, while the
text will take up the right.

Title, 2–Content and Text.
Allows us to add a title on the
top, two non-text contents on
the left column, and some
text on the right column.

Title and Content over Text.
Allows us to type in a title,
insert some non-text content
and lastly add some text at
the bottom of the slide.

Text and Content Layouts

APPENDIX 5.3 : TEXT AND CONTENT LAYOUT OPTIONS

APPENDIX 5.2 : CONTENT LAYOUT OPTIONS

Blank. Does not provide any
placeholder. We will have to
build it up from scratch if
we want to use this.

T itle and Content. Very
similar to Content, but
allows us to also add a title
for the slide.

Title, Content and 2-Content.
Allows us to add a title and
3 non-text contents in two
columns. The left column
will have only one non-text
content, while the right
column will have two.

Title and 4-Content. Allows
us to type in a title for the
slide and insert 4 non-text
contents – 2 in left column
and 2 in right column.

Content. Allows us to add
picture, audio, video,
charts, etc. but not text.

Title and 2–Contents. Allows
us to add a title and two
non-text contents – like
picture, chart, video, etc.

Title, 2-Content and Content.
Similar to the previous one,
except that the left column
will have two non-text
contents while the right
column will have only one.

Content Layouts
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Introduction

After completing this Chapter, the

student will be able to:

• identify various terms associated

with convergence of CCT,

• correlate communication system

and its components,

• classify components of

communication system,

• explain the process of data

transfer,

• compare different data

communication technologies,

• justify the need of convergence of

technologies to meet the next

generation unified applications,

• visualise application of unified

messaging system and

• appreciate the importance of

standardisation of various

components in any system.

6

In the earlier chapters, we saw how computer
systems have become an important tool for our day–
to–day functions. Online applications as ATMs,
automatic complaint registration, railway
reservation, etc. have improved our productivity and
made our job faster and easier. In the next chapter
on ‘the Internet’, we will see that most of the current
applications are Internet based and depend heavily
upon the communication systems. In this chapter
we shall see that the communication systems have
undergone gradual changes from the telephone
system to video–conferencing. Communication
systems are converging to provide next generation
applications (Figure 6.1).

Even before computers were invented, there were
various modes of communication like postal services,
telegraphs and telephones. In the twentieth century,
considerable efforts were made to develop reliable
and affordable telecommunication systems.

Objectives “Seven hundred million people living in the rural

areas need a unique rural development model

called PURA (Providing Urban Amenities in

Rural Areas) which envisages provision of three

connectivities namely physical connectivity,

electronic connectivity and knowledge

connectivity leading to economic connectivity.”

Dr A.P.J. Abdul Kalam



Telecommunication systems
were developed to effectively use
multiple services such as
t e l e v i s i o n , r a d i o n e w s
broadcasting, etc. along with the
telephone. Telecommunication
systems were also used for long
d is tance communicat ion
between computers.

A revolution in the
computer technology started in
the middle of the twentieth
century. Today the computer
is not just a data processing
device, if has become a
multipurpose utility tool. The
computer is being used,
among many other things, for
documentation, entertainment and communication.

Communication system is a very general term which means a
combination of computers, communication devices, associated networks
and required software.

Let’s consider a simple example of sending a picture to a friend
using e-mail.

Traditionally the picture could be sent through the postal service.
The sender would put the picture in an envelope and post it at the
nearest post office. The postal service would then deliver the envelope
to the receiver. The receiver could get the picture in two days or in a
month or never, and it could even get lost.

Using modern communication system the picture can be sent
instantly in the following way.

To send the picture, the sender would use a scanner (Figure 6.2 ) to
get its copy on the computer. Then the computer has to be connected
to the Internet. The sender would use an Internet application such
as e-mail to attach the picture and send it to the receiver’s e-mail address.

The receiver could be located in any part of the world, s/he can
receive the copy of the photograph within minutes. S/he would connect
to the Internet and login to her/his e-mail account, download the
picture into her/his computer system. If needed, a printer can be
used to get a copy of the picture.

Similarly any information such as a document, an image or music
can be instantly transferred to any part of the world using modern
communication systems.

Figure 6.1 : Convergence of various communication systems
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6.1 COMPONENTS OF COMMUNICATION SYSTEMS

In a communication system there are various components which are
interconnected through communication devices, networks and
communication software. All communication systems have the following
five essential components which interact with each other to provide
seamless connectivity (Figure 6.3).

Figure 6.3 : Components of communication systems

Figure 6.2 : Sending a scanned picture

Apparently this operation may look simple, but in the background
there are many interconnected devices and networks that are involved.
At various stages, our data (picture) is converted into various forms
until it reaches the final destination.

Any information which can be digitised, whether it is voice, data or
video, can be communicated through our present day electronic
communication system.
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6.1.1 MESSAGE

The content that has to be such communicated as document, picture,
song, etc. It can be in any form such as text, number, image, audio or video.

6.1.2 SENDER

The sender can be any device such as a computer, mobile, telephone,
video camera, etc. which is used to send the information.

6.1.3 RECEIVER

The receiver can be any device such as a computer, mobile, telephone,
video camera, etc. A device that receives the information.

6.1.4 TRANSMISSION MEDIUM

It is the connectivity between the sender and receiver, through any medium
such as twisted pair cable, fibre optic cable, coaxial cables or radio waves.

6.1.5 PROTOCOL

Protocols are a set of rules that control the communication between

the receiver and the sender. The communication software interfaces

two connecting devices and controls the flow of data. For successful

communication, both the devices must follow a common
communication protocol.

6.2 APPLICATIONS

These are the software or programs designed to fulfill the specific

requirement of the user. Eg., Mozilla Browser, Outlook Express, etc.

Internet Service Provider (ISP) : Company that provides Internet
services

6.3 EVOLUTION OF COMMUNICATION SYSTEMS

The modern communication systems started developing only after the

nineteenth century with the development of the electromagnetic

telegraph system.

In the telephone system (Figure 6.4), a microphone is used to convert

voice signals into electrical signals and transmit the same through a

pair of copper wires over a long distance. At the remote end a speaker/

earphone is used to convert electric signals back to voice. All the local

exchanges are interconnected through Public Switched checked

Telephone Network (PSTN) backbone. Over the years, the

telecommunication system has also undergone tremendous up

gradation. Today, they provide multi-functionality like FAX, SMS,

television, Internet, data communication, etc.
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Figure 6.4 : Telephone system

Modern PSTN uses high speed backbones with various types of
transmission media such as fibre optics and wireless.  The major break
through in telecommunication system came after the development of
following technologies.

1. Pulse Code Modulation: Technology for digitisation of voice/analogue
signal into digital signals (Figure 6.5).

Figure 6.5 : Digitisation of information

2. Multiplexing of multiple low speed signals into a high speed signal.
3. Invention of various transmission media such as wireless, fibre optic cables, etc.

Wireless Network : Communication
medium where devices are not
connected through any cables, but
through radio waves. Mostly used for
connecting areas where the users are
always mobile or it is not possible to
lay cables.

Wireless network
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Earlier computers were directly connected to devices such as
terminals, printers, monitors, etc. The distance between two devices
was also limited within a room or a building. The data transfer was
also restricted to sending small text messages and commands.

Figure 6.6 : Direct communication between two computers

Long distance data communication was done through low speed

point to point connections (Figure 6.7) such as leased lines and dial-up.

Figure 6. 7 : Long distance point to point connection through Modem

Satellite network: Communication
system where signals are
transmitted directly to many
points spread across a large region
through satellite. It is being widely
used for intercontinental/long
distance communication for
telecommunication and television
broadcasting.

Television and radio connection

through satellite
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Figure 6.8 : Simultaneous voice and data communication through ISDN network

6.4 CONVERGENCE OF COMMUNICATION
TECHNOLOGIES

Earlier, there were separate networks for voice, video and data
communication. These networks did not meet the requirement of next
generation integrated multimedia applications such as video
conferencing, Net-meeting, etc. which require simultaneous
transmission of voice, data and video. Efforts are made to develop
integrated solution to support multimedia applications through a single
communication system. As more and more tasks are becoming computer
dependent, convergence of the technologies has become a necessity.

Leased lines and dialup connections use telecommunication

infrastructure as their backbone. At both ends, an electronic device

called a modem is used to terminate the connection. Modems modulate

digital signals from computers into voice graded analogue signals, and

then transmit these analogue signals through telephone lines. At the

remote end, the analogue signals are demodulated into digital signals.

In dialup and leased line connections, the telephone lines could either

be used for data communication or for voice communication, but not

simultaneously.

With telecom technologies such as ISDN and Broadband, the

telephone connection can now be used simultaneously for voice

communication as well as data connection (Figure 6.8).
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Objectives of convergence of communication technologies are –

(i) to provide cost effective communication system.
(ii) to make deployment easier and convenient.

(iii) to make optimum use of existing infrastructure to support
multimedia applications.

(iv) to develop high availability and high speed network to support online
interactive application such as telemedicine, video-conferencing.

(v) to provide inexpensive unified services.

The emergence of global competition is also driving the ISPs to
provide unified services like email, talk, chat, web search, etc. from
a single platform, using the existing infrastructure.The tele-
communication service providers started giving additional services
like Internet access, broadcast services like video-on-demand, IPTV,
etc. Customers are also opting for such ISPs who can provide single
point solution for all required services.

Data networks are now extensively used for telecommunication
services such as Voice over Internet Protocol (VoIP) and broadcasting
services like IPTV. Even the cable TV operators are providing Internet
connection along with cable connection. Today mobile phones are
equipped with Internet and FM radio services.

The equipment manufacturers are developing plug and play devices
that can be connected with multiple networks and can be controlled
from remote locations.

6.4.1 DEVELOPING UNIFORM DATA REPRESENTATION AND

DIGITISATION TECHNOLOGIES

Digitisation of data is the first step in the process of convergence.
All types of data whether text, number, image, voice or video, can
be represented in the binary form. Digitisation is the process to convert
any type of data into binary digits that can be processed by any
computing device.

The motivation behind this digitisation is the fact that the computer
works on the principle of manipulation of numbers. If any data is in
binary form, it can easily be manipulated by the computer. Therefore,
efforts are on to develop technologies to digitise various types of data for
better storage and transmission. Once digitised, irrespective of the type
of data, the same communication system can be used for transmitting.

6.4.2 CONVERGENCE OF STANDARDS AND PROTOCOLS

During communication, the message is processed at various stages by
several intermediate hardware and software components. It is cost
effective and easy to integrate if all the components follow uniform
protocols and standards. There are some standards and protocols
which have become very popular and have emerged as standards.
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These standards are followed by industries and manufacturers. Some
such protocols are –

1. Internet Protocol (IP) is the most popular protocol to interconnect
different networks.

2. Ethernet is most popular standard for Local Area Network.
3. HTTP is most popular protocol to connect web applications.
4. MPEG is compression technology for transmission of video.

The function of Internet Protocol is similar to our postal delivery
system but is electronically processed and is very fast.

In the traditional postal system, the message, written in the form
of a letter containing receiver’s and sender’s addresses, is dropped in
the nearest letter box. Letters collected from all the letter boxes are
segregated as per the state/city in the post office. All letters to the
same city are bundled and sent through air/train depending upon the
distance and availability. At the remote city, the letters are unbundled
and sent to the respective local post offices. Finally the letter is delivered
to its destination through the local postman.

Similarly in the Internet (Figure 6.9), all messages are sent in
the form of packets called IP packets. Each packet is marked with
source address and destination address. Like every person is
identified with a name and address, each computer connected to
the Internet is also identified with a unique address/name termed

Figure 6.9 : Internet
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as IP address/domain name respectively. The computer sends the
IP packet directly to the connected IP network. In the Internet the
packets are forwarded from one network to other as per the
destination address till it reaches the receiver.

Internet Protocol has become very popular as it can withstand and

overcome the frequent breakdown of communication links. It was

designed to automatically find an alternative path and continue the

communication without any break.

Ethernet (Figure 6.10) is another communication protocol which

has become very popular for connecting communication devices through

various types of transmission media such as copper, wireless and optical

fibre. It can support various data transfer rate as 10 Mbps/100 Mbps/

1 Gbps/10 Gbps and is very simple to implement. Today all computer

peripherals such as printer, scanner, etc. are equipped with Ethernet

interface instead of serial/parallel interfaces.

Figure 6.10 : Convergence of computer and other devices with Ethernet and IP

6.4.3 CONVERGENCE OF NETWORK

Broadband is one simple example of convergence of voice, video and

data. Broadband is the latest communication technology using which

a user can have simultaneous voice calls, Internet access and cable

television over the same telephone line (Figure 6.11). Effort is being

made to provide more high bandwidth services through various types

of transmission media.
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Figure 6.11 : Convergence of voice, video and data in broadband network

6.4.4 CONVERGENCE IN VOICE COMMUNICATION

In this age of convergence, voice communication can be done from multiple
networks with multiple connecting devices and from multiple locations
(Figure 6.12). The mobile phone connected to wireless network can
communicate with landline telephone connected to PSTN network as

Figure 6.12 : Voice in converged network
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well as with multimedia computer connected with the Internet. Instant
messages can be sent from a computer to a mobile phone. Devices from
one network can communicate with devices from other network through
gateways. Gateways are communication devices used to interface
different networks. Manufacturers are developing multipurpose plug
and play devices which can be connected anywhere at any time.

6.4.5 CONVERGENCE OF VIDEO COMMUNICATION

Video–conferencing and video–streaming (Figure 6.13 ) are some of the
multimedia applications gaining popularity. Video-conferencing was
primarily done through point-to-point connection like ISDN, leased line,
etc. and required specialised equipment.

Figure 6.13 : Video streaming through IPTV

Today, thanks to convergence, video-conferencing is done through IP
networks and does not require costly video conferencing systems; all that
is required is a multimedia system with a camera and associated software.

High quality and reliable video-communication is possible with the
development of features like Quality of Service (QoS) and video
compression techniques such as MPEG.
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The technology to prioritise IP packet
containing voice and video traffic over
other data packets is called Quality
of Service.

Moving Pictures Expert Group
(MPEG) algorithms compresses video
data to reduce number of bytes that
can be easily transmitted and then
decompressed.

Since video traffic requires high bandwidth, it becomes difficult to
get acceptable quality when transmitted through low speed PSTN or
satellite links. These video signals are therefore compressed and
formatted before transmission. Video compression techniques such as
MPEG4 can compress video data upto 100 times which can then be
transmitted through low speed networks.

Earlier news and movies were telecast through broadcast media
using satellite, wireless and cable. The signal quality was noisy and
non interactive. Now with technologies like IPTV and video-on-
demand, high quality video can be received. IPTV is a broadcast
service provided by telecom operators through their PSTN networks.
The user can view the video telecast through their traditional TV
sets as well as computer systems.

Video-on-demand is another video streaming service where the user
has the option to select what s/he wants to watch from among those
stored in the media server.

6.4.6 CONVERGENCE OF WIRELESS NETWORK

Wireless is one of the fastest growing networks. The demand is growing
as more and more users require access to Internet from multiple
locations. It is becoming as essential as mobile phones.

Access points are similar to
the Ethernet device where
all computers with wireless
card can connect for data
transmission.

Figure 6.14 : Convergence of wireless
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Wireless LAN, WiFi and WiMax are few such technologies which provide

high speed data communication over wireless networks. Computer
systems are designed with built-in wireless interface cards which can

connect to any type of wireless networks. In wireless network, computers

are connected to the nearest available access point.

The access points are connected to other networks through wired

Ethernet connection or broadband connection.

With third generation mobile technology such as GPRS, one can
use mobile devices to access multi-service applications like voice

communication, Internet and video conferencing.

6.4.7 CONVERGENCE OF APPLICATIONS

Web browsers like Internet Explorer, Firefox, etc. are the accepted client

applications for Internet access. Most equipment manufacturers are

providing web interfaces for management and control of their systems

instead of product specific client application.

Most of the applications are developed with web interface so that

the application can be accessed from a standard client application

supplied as part of the operating system.

Another example of convergence of application is unified messaging

system. There are many popular web service providers, for instance

Yahoo, MSN and Google, who started with either e-mail or search
engines, but are now providing a banquet of messaging services like

email, chat, instant messenger, conferencing, file sharing and VoIP.

There are several applications that can replace multiple

communication devices such as telephone, fax, answering machine,

books, etc, with one multimedia computer. The number of such services

and applications are increasing day-by-day. Broadband and Direct-to-
Home (DTH) are some communication technologies which allow

interactive TV services such as movie-on-demand, Internet access,

video conferencing and e-mail, all through a single connection.

In a nutshell, any data that can be digitised can also be

communicated through a converged communication system. The distinct

division between telecommunication and data communication has faded
into one converged communication system. Efforts are on to make more

and more services IP enabled and networked.

In the next chapter, we shall discuss various Internet applications

used for communication.

6.5 IMPORTANCE OF STANDARDISATION

Standardisation plays an important role in every sphere of our day-to-

day life. Standardisation is the process of agreeing on technical specifics
of any process or product.
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The goals of standardisation are to have compatibility, interoperability,
safety, repeatability and quality. In a competitive market, it is very
important for industries to maintain the standards to flourish in their
trade. There are predefined standards set for the IT industry too. This is
to guarantee the interoperability and compatibility between products from
different vendors. There are various standardisation organisations
worldwide which are primarily engaged in the documentation, research,
development, and testing in the field of computer hardware, software and
communications to formulate standards. Once a standard is accepted,
the vendors can design and develop the product as per the standards.

Some important standardisation organisations in the field of
Information Technology are as follows –

• ANSI (American National Standards Institute)
• ITU (International Telecommunication Union)
• IETF (The Internet Engineering Task Force)
• IEEE (Institute of Electrical and Electronic Engineers)
• EIA/TIA (Electronic Industry Association/Telecommunication

Association)
• ISO (International Standards Organisation)
• VESA (Video Electronics Standards Association).

The Internet Engineering Task Force (IETF) is a large open
international community of network designers, operators, vendors, and
researchers concerned with the evolution of the Internet architecture
and the smooth operation of the Internet. While IEEE is generally
concerned with hardware, ANSI has been primarily concerned with
software. ANSI has defined standards for a number of programming
languages including C, C++, COBOL and FORTRAN. All these
organisations collectively provide the framework of the standards which
bind IT across the world. They let us work easily across regions, without
being bogged down with compatibility issues. For example, IEEE
developed a set of network standards to facilitate interoperability among
various make and models of network devices.

ITU defines international standards, particularly for communication
protocols.  It has defined a number of standards, including V.22,
V.32, V.34 and V.42 that specify protocols for transmitting data over
telephone lines.

EIA/TIA specifies generic telecommunication cabling system which
supports multiproduct, multivendor environment. For example, EIA/
TIA 568A and 568B standard is for the pin configuration of LAN cable.

Apart from these standardisation organisations, there are region
specific associations of manufacturers who also contribute to the
development of standards to meet the needs of that particular region.

In India there are few standardisation organisations like BIS (Bureau
of Indian Standards), which actively participate in the development of
standards in various fields.
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Summary

• Telecommunication is the use of electronic system to send and receive voice, data and

video messages.

• Broadly there are five components of communication system, namely information/

message, device, application, protocol and network.

• Voice communication requires telephone instruments like telephone, mobile or VoIP

phones for PSTN, wireless or data network.

• Data communication allows transfer of information and remote management of devices.

• Data communication is undertaken by directly connected computers, printers, etc. in a

Local Area Network.

• Long distance data communication is done through point to point connections using

PSTN or wireless networks.

• Broadcasting of audio and telecasting of video service such as radio and television is

done through wireless links.

• Ethernet is the most popular LAN technology for data communication which provides

communication speed up to 10Gbps.

• Internet Protocol (IP) connects the computer across similar or diverse networks.

• In IP, data packets are transmitted in packets containing unique IP addresses for the

source and the destination.

• IP automatically routes the packet to its destination through any available path.

• Convergence of technologies is required to meet the next generation unified applications

where all the three forms of data are required to be transmitted simultaneously.

• IP is internationally accepted protocol through which all different forms of data can be

communicated.

• The approach to convergence is to make all components of communication systems IP

enabled.

• While trying to achieve convergence, effort is on to use existing infrastructure with partial

upgradation.

• Broadband and IPTV are two next generation technologies which use PSTN to provide

unified services for voice, data and video.

• VoIP is a data communication technology which allows IP phones and computers to

connect to telephones through PSTN and mobile networks.

• Unified messaging system is provided by web service providers which can be used  to

access multiple services like e-mail, chat, call and entertainment from a single computer

system with Internet connection.

• Standardisation is very important for interoperability of various components in any

system,

• There are organisations which develop standards, rules and specification for a product

that the manufacturers have to meet.
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EXERCISE

SHORT ANSWER TYPE QUESTIONS

1. What is coding?

2. Why is digitisation required?

3. What are the emerging technologies that support voice, data and video?

4. What are the services provided by a broadband connection?

5. Why are unified messaging services becoming popular?

6. Explain features of circuit switching technology.

7. What are the features of packet switch technology?

8. Explore the sites which provide unified messaging services.

9. Explore the easiest way of connecting computers in a LAB.

10. Explore the easiest and fastest way of connecting computers  on a campus.

LONG ANSWER TYPE QUESTIONS

1. Identify the five components of data communication when a file is printed.

2. Identify the type of interfaces that are available in the computer and printers
in your school lab.

3. Find out the various services provided by your local service provider. And
compare the charges against each service among the local ISPs.

4. Find out the various ways a home computer can be connected to the Internet.

5. Configure a broadband connection for data and voice communication.

6. Explore some traditional means of communication.

7. What are the benefits of standardisation?

8. Find the specification of your computer system.

9. Identify the components of data communication.

10. Identify the components of mass communication.

11. How is voice communication different from data communication?

12. Explain the benefits of digitisation of Audio and Video Signals.

13. How does long distance data communication work?

14. Why is it easies to setup Ethernet network than X.25?

15. What are the advantages of Internet Protocol?

16. What is convergence of communication technology?

17. What are the benefits of convergence of communication?

18. Explain the constraints in the convergence of communication.

19. What are the various approaches to meet the requirements of next generation
application?
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MULTIPLE CHOICE QUESTIONS

1. The 1st modern telecommunication device was
(i) Telephone

(ii) Telegraph
(iii) Computer
(iv) Television

2. Set of rules that controls communication between two devices is called
(i) Network

(ii) Application
(iii) Protocol
(iv) Media

3. Example of packet switching technology
(i) Ethernet

(ii) X.25
(iii) Broadband
(iv) RS 232

4. Example of Frame switching technology
(i) Ethernet

(ii) X.25
(iii) Broadband
(iv) RS 232

5. Circuit switching network is
(i) Point to point

(ii) Multipoint
(iii) Connectionless
(iv) Virtual connection

6. ISDN is telecommunication technology where
(i) Simultaneous voice and Data

(ii) Only Voice
(iii) Only data
(iv) Only Video

7. Internet Protocol ( IP) is
(i) circuit switching

(ii) packet switching
(iii) frame switching
(iv) point to point

8. Broadband is a convergence technology for
(i) Voice, data and video

(ii) Only data
(iii) Only voice
(iv) Only video

9. VoIP technology enables to connect
(i) Only PSTN telephones

(ii) Only Mobile telephones
(iii) Only VoIP telephone
(iv) All IP enabled telephone systems connected to the Internet.

10. GPRS is used in mobile phones for
(i) Data communication

(ii) Voice communication
(iii) Send SMS
(iv) None of the above
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Activities

1. Identify the five components of data communication when a file is printed.

2. Identify the type of interfaces that are available in the computer and printers in your
school lab.

3. Find out the various services provided by your local service provider. And compare the
charges against each service among the local ISPs.

4.  Find out the various ways in which a home computer can be connected to the Internet.

5. Configure a broadband connection for data and voice communication.

6. Find the model of the mobile phone available in your locality which supports voice as well
as Internet.

7. Explore the sites which provide unified messaging services.

8. Explore the most easiest way of connecting computer in a LAB.

9. Explore the easiest and fastest way of connecting computers on a campus.



THE INTERNET

Introduction

After completing this Chapter, the

student will be able to:

• explain the basics of the Internet

and its origin,

• describe functioning of the

Internet,

• give examples of Internet services,

• write terminologies of the Internet,

• list various usage of the Internet,

• illustrate how to surf different

websites,

• demonstrate how to download

files,

• open an e-mail account,

• send and receive emails through

an email account and

• store and retrieve addresses from

the address book.

7

Guess how is it possible to see the latest news,
cricket, talk to our friend, check availability of
railway reservation, timings or status of a particular
flight, send or receive mails/messages as and when
we wish to. Yes, it is possible through the Internet,
where all this happens like magic on few clicks of
the mouse. Millions of people across the globe are
able to communicate and interact with each other
through the Internet. All we need for this is an
Internet connection on any computing device like
Desktop, Palmtop, Laptop, Mobile Phone, etc.
Applications of the Internet have covered almost
every field – be it education, research, entertainment,
communication, science, commerce, shopping,
advertising and many more.

The Internet is possible because of the ability to
interact and share information between the

Objectives
The Internet is based on a layered, end-to-end

model that allows people at each level of the

network to innovate free of any central control.

By placing intelligence at the edges rather than

control in the middle of the network, the Internet

has created a platform for innovation.

Vinton Cerf

Widely known as a "Father of the Internet," co-designer of

TCP/IP protocols and basic architecture of the Internet
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7.1 HISTORY OF THE INTERNET

The Internet was not developed within a period of a few days or a few

months. Rather, it is the result of a long and aggressive research which
took many years.

In 1969, the American Department of Defense (DOD) started a network
of devices called ARPANET (Advanced Research Projects Administration
Network) with one computer in California and three in Utah. In
September 1969, the University of California at Los Angeles (UCLA),
the Stanford Research Institute (SRI), the University of California, Santa
Barbara (USCB) and the University of Utah were connected by a network
that was called the ARPANET. As the use of the network gradually
increased, other universities, research organisations, and private and
commercial organisations also started using this technology.

The Internet, often referred to as the ‘Net’, consists of a complex
network of computers connected by high-speed communication
technologies like satellites, microwave devices, etc. It allows easy
and quick access to a huge amount of information/resources
stored at many different locations around the world. The actual
term “Internet” was finally coined in 1995 by the FNC (Federal

Networking Council, USA).

computers connected through a network. The Internet is often called
the Network of Networks (Figure 7.1) which enables us to interact and
communicate with each other.

Figure 7.1 : Network of networks
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7.2 HOW THE INTERNET FUNCTIONS?

A corporate network may have its computers connected through a local
area network, governed by certain rules. Further, this network may be
connected with other networks. But, if different networks are governed
by different rules, will they be able to communicate with one another?
Imagine a group of people having one Tamilian, one Bengali, one
Himachali, one Mizo and one from Maharashtra trying to communicate
with each other in their own native languages, failing to understand
what the other person is trying to say. Therefore, to communicate with
each other, some common standard must be followed.

Functioning of the Internet is not controlled by any one particular
organisation. It is managed by a group of voluntary organisations. These
voluntary organisations have formed the Internet Society. They decide
on the rules, known as protocols, for communication over the Internet.
The different networks may have their own rules that they follow
internally, but when they communicate with each other, they must
follow some common rules. It’s like we speaking our mother tongue at
home, but while communicating in a mixed group, we use a common
language, mainly, Hindi or English.

7.3 HOW TO WORK WITH THE INTERNET?

In order to work with the Internet we need to know certain related terms
like www, web browsers, web pages, websites, etc. We should know how
to get connected to the Internet. Once connected – how to use it.

Most of the terms on the Internet are prefixed with the term web.
The electronic pages seen on the Internet are known as web pages. A
web page can be defined as the document that we see on the Internet.
Many web pages linked with each other combine to form a website. A
web page can be written in the language known as HTML (Hyper
Text Markup Language). HTML is a very simple language having a
number of options to represent text. Many other scripting languages
have now been developed which can be embedded into HTML, giving
it the power to interact with the users. (These are discussed in detail
in the next Unit). These dynamic web pages can take inputs from
users and give information accordingly – taking in the location of the
user before displaying the weather forecast. For example, a protocol
called Hyper Text Transfer Protocol (HTTP) is used to transmit and
receive the web pages.

7.3.1 WEB BROWSERS

The web is a collection of a huge amount of information. Every single
web page consists of some information and also a number of links,
which connects us to other related web pages.  To visit the linked
web pages, just click over the linked text and the next web page
opens up.
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Just like a word processing application is needed to open a word
processor document, an application is needed to view an HTML
document. To view a web page we need special software called web
browser. Mosaic was the first web browser developed by National Centre
for Supercomputing Application (NCSA). This browser didn’t have any
special features like present day web browsers. It was not possible to
view pictures or use any present day font formatting features in the
web pages. Initially, the browsers were designed to show plain text,
without any formatting.

With the increasing use, the need to incorporate additional features
like text formatting, viewing images, playing sound, etc. was felt.  Most
modern day browsers incorporate all these features. Some other  commonly
used browsers are Netscape Navigator, Mozilla FireFox, Opera, Safari,
MSIE (Microsoft Internet Explorer), etc. Almost all of these support a

common set of rules of the language. Some browsers are shown in figure 7.2.

7.3.2 WWW (WORLD WIDE WEB)

One Internet application that is currently drawing a lot of attention is
the World Wide Web (WWW), also known as W3. WWW is a hypermedia
based software technology allowing consolidation of hypertext, graphics,
audio, video and multimedia to provide information on almost each
and every topic/subject/area.

WWW was started in 1989 at CERN (European Center for Nuclear
Research). The motivation was the need to interact with each other by
the group of researchers at far off places. This demand for interaction
and communication led to the rapid growth in this area of
communication.

Any website located on the Internet has an address associated with
it indicating the location of the website. Every page has an address
associated with it. This address is known as the URL.

Figure 7.2 : Web Browsers

Mozilla Firefox is an open
source web browser
which is available free of
cost and can be easily
downloaded from the
Internet. Open source
software does not
require any license fee.
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7.3.3 URL (UNIFORM RESOURCE LOCATOR)

URL stands for Uniform Resource Locator. Every web page that is
displayed on the Internet has a specific address associated with it.
This address is known as the URL. It tells us the location of the web
page being displayed and other related information.

As the postal address is required to reach a letter to a person
staying anywhere on earth, a unique location (address) of a web
element which may be a website or a web page is required in the
World Wide Web to view it in the browser. This unique address of the
web elements is referred to as a URL. The URL consists of four basic
parts, namely, server type, hostname, folder name and the filename.
Each one of these has a specific function. The “server type” indicates
the type of Internet server (Protocol) being accessed. The server type
is always followed by “://” and the host name. The host name is the
Internet address of a remote computer on which the files reside. The
folder name indicates the name of the directory in which the files are
located. The filename specifies the name of the specific document to
be displayed in the browser. The filename itself consists of two pieces
of information, the name of the file to be displayed and the file
extension, which specifies the file type (.htm for HTML file, .txt for a
text file, .bmp for a bitmap image, etc.)

The structure of a URL can be represented as follows:

Server type://Hostname/directory/sub-directory/.../filename

A URL is illustrated in figure 7.3.

Figure 7.3 : Illustration of a URL

Table 7.1 : Some protocols with their usage

Name Used for

http Hyper Text Transfer Protocol is used to transfer the hypertext

Many other protocols exist apart from http. Table 7.1 lists some

common protocols.
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There are other protocols also like SLIP (Serial Line Internet
Protocol), SMTP (Simple Mail Transfer Protocol) ARP (Address Resolution
Protocol) PPP (Point to Point Protocol), etc.

7.3.4 CONNECTING TO THE INTERNET

In order to activate Internet services on any computer, it requires an
Internet connection from an Internet Service Provider. There are several

Internet Service Providers (ISPs) in India
like VSNL, BSNL, Airtel, Reliance, etc.
They charge some nominal fee for
installation and connection. Depending
on the requirement we can get an
Internet connection in any of the
following ways:

1. Dial-up connection : We can get
connected to the Internet by dialing the
ISP’s number. This is useful if the
network is either confined to small
group of computers or for a single PC
(Figure 7.4).

2. Leased lines : A dedicated line
is laid specifically for the connection.
This provides a fairly high speed, but is

expensive. This is suitable for an organisation requiring
uninterrupted, high speed Internet connection.

3. Broadband : This also provides a good speed. While leased line
requires a separate telephone line, broadband can be delivered using
an existing telephone line. This is ideal for home and small
businesses requiring high speed Internet.

Figure 7.4 : Set up for Internet connection

ftp File Transfer Protocol is used to transfer binary and text files over the

Internet

file Local file

news News group /News article

telnet For remote login over a TCP/IP connection

TCP/IP Transmission Control Protocol Internet Protocol. TCP/IP consists of

a set of two protocols i.e. Transfer Control Protocol and Internet

Protocol. Transfer Control Protocol controls the flow of data and is a

reliable service protocol. Every computer in a network has a unique

IP address associated with it. IP identifies and reach the target

computer on the network.

UDP User Datagram Packet is used to transfer data between two computers.

It is an unreliable protocol, offering no guarantee for data delivery.
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4. WiFi Broadband : These days even wireless connections are
available. For this we need to have a Wi Fi card attached to the
computer and a wireless modem.

5. When we connect to the Internet we must know its speed parameters.
The speed of the Internet is measured in the number of bits
transferred per unit time. Generally, the speed of the Internet is
measured in kbps (kilo bits per second), but these days some
organisations are providing high speed connections in Mbps (Mega
bits per second).

In order to have a connection we need a device called the modem.
This device converts the digital signal from the computer into an
analogue signal that can travel through the telephone line. On the
other end, this analogue signal is again converted back to digital form
by the modem at the destination end. Some computer systems have
internal modems (built-in within the motherboard) while in some
systems there might be a need to have an external modem to have an
Internet connection.

Another device called a router can be attached to the computer to
access the Internet. The router is a device used for connecting two
different networks.

7.3.5 DOMAIN NAMES

All the websites on the Internet have unique names associated with
them. To launch a website, we must have a unique domain name. In
order to avoid any conflict within the names of the websites the concept
of domain names was developed.

There are certain websites which have .ac which indicates academic
organisations, .in suffixed to their name indicating that they belong to
India, for example: www.ignou.ac.in, www.ncert.nic.in, and many more.
websites having .au as a suffix indicate Australia, .jp indicates Japan
and so on. However, there is no such suffix for USA.

A domain can be generic or according to the names of the country.
Some common domain names are:

1. in – stands for India (country name)
2. gov – indicates government agencies
3. net – network organisations
4. org – non-profit organisations
5. edu – educational organisations
6. com – commercial organisations
7. mil –  military or defence

Bandwidth : In context of the Internet, the number of bits transferred by a channel
per unit time is the bandwidth.
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7.4 USES OF THE INTERNET

The Internet is extensively used for a wide variety of purposes. Some of
these are mentioned below:

7.4.1 SEARCH FOR INFORMATION

A number of programs called search engines are available to search for the
information on any topic. Some famous search engines are provided by:
www.google.com, wikipedia.com, webopedia.com, MSN.com, Yahoo.com, etc.

Search Engines

A search engine is a complex program that searches documents containing a specified

set of keywords. A search engine basically works in three phases:

1. The search engine sends a program (called the spider) that searches the web

pages in the Internet for the keyword.

2. After the spider fetches the result, another software called the indexer reads these

results. The indexer then creates an index based on the words contained in each

of the documents returned by the spider.

3. After indexing, the search engine presents only the documents matching the search

criteria to the user.

The relevance of the result returned by the search engine depends on how you

frame the query. To search any information, connect to any of the searchengine websites

like: www.msn.com, www.google.com, www.webopedia.com, www.yahoo.com and

follow the points mentioned below:

1. Enter the keywords of the topic for which the search is required in the input box.

For example, if a search is required on population then enter the keyword as

“Population” or “population”

2. Search for the phrase is done by entering the phrase within the double quotes. For

example, if the search is required on  declining sex ratio then the keywords can be

entered as:

“declining sex ratio.”

3. Notice that the phrase to be searched has been given in double quotes. If double

quotes are not entered then search will be made for individual keywords. Any

document containing any one of the keywords will be returned.

4. The search can be made simultaneously for more than one word by placing a

space or ‘OR’ within the keywords.

5. If a search is to be made for a set of words in a desired sequence then these set of

keywords can be given in double quotes.

7.4.2 E-MAIL (ELECTRONIC MAIL) SERVICES

The Internet is commonly used for sending and receiving e-mails. We
can send a message electronically to any person  on the globe, provided
that person has an e-mail-id. This service is fast and economical.
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7.4.3 CHATTING

Chatting involves textual exchange of message in real time. Chat
servers provide facility to create virtual chat rooms and only the
members associated with these rooms are allowed to share messages.
Chat works best if the time is scheduled by both the parties who are
willing to chat – as both the parties must be connected to the Internet
while chatting. Some common chat engines are : Yahoo Messenger,
Google Talk, Rediff Bol, etc.

7.4.4 INSTANT MESSENGER SERVICES

These tools can be used to send messages instantly. It also allows us
to talk to anyone anywhere in the world. This is a cheaper and quicker
method compared to other services. Unlike chatting, it is not necessary
to have an account with the same provider. Additionally, both the users
need not be connected while sending messages. We can easily download
the messenger software from Internet e.g. MSN Messenger, Yahoo
Messenger, etc.

7.4.5 NEWSGROUP

Newsgroup is an e-service hosted by many newsgroup organisations.
One can become a member of a newsgroup and read and share current
affairs and messages. Newsgroups cover a broad domain of interests
including education, science and technology, medicine, arts, sports,
etc. USENET is one such example.

7.4.6 TELECONFERENCING

People can have a conference or meeting sitting at different locations
with a microphone attached to their computers.

7.4.7 VIDEO-CONFERENCING

In teleconferencing we are able to talk to each other sitting at different
places but in video-conferencing we can also see what is happening at
the other side. We have observed that the anchor, panelists and experts
sitting at different locations across the globe communicate and share
their views in many news channels. For this, we need a web-camera
and a microphone connected to the computer system, high bandwidth
connection, and video-conferencing software.

7.4.8 E-COMMERCE

E-commerce or Electronic-Commerce means online transactions of
business. In this, the vendor and customer conduct a transaction sitting
at different geographical locations, connected through the Internet.
The customer need not strain himself by visiting a number of shops
outside in scorching heat or heavy rains. He can do shopping by sitting
at home, visiting the desired e-commerce site and placing an order
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online. E.g. http://shopping.indiatimes.com, http://ebay.com, http:/
/shopping.rediff.com, etc.

7.4.9 M-COMMERCE

It is an acronym for mobile commerce. It is an upcoming technology
after e-commerce. It involves buying and selling of goods and services
electronically through wireless handheld devices at any place. We can
do transactions through our mobile phones also.

7.5 HOW TO MANAGE AN E-MAIL ACCOUNT

7.5.1 E-MAIL ADDRESS

An e-mail addess (account) consists of two main parts, the username
and the domain-server name with the symbol @ in between.

<username>@<domain-name>

Username can be any name but domain-name is fixed for a
particular website on which we have our e-mail account. For example,
dceta.ncert@nic.in, xyz@nic.in or abc@yahoo.com, etc.

7.5.2  CONFIGURING E-MAIL ACCOUNT

We can easily make our e-mail account by visiting websites which
provide this service. Many websites like www.indiatimes.com,
www.rediffmail.com, www.hotmail.com provide free as well as paid
e-mail services. For creating an e-mail account on the Google website
we have to follow the steps given below:

1. Log on to the website by typing www.google.com and then select
Mail option or simply type www.gmail.com (Figure 7.5)

Figure 7.5 :  Logging on to google for creating e-mail account

To  Sign Up as a
new user
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2. Click on the option ‘Sign Up’ or ‘New User’.

A web page containing a form opens up in the browser (Figure 7.6).
Fill in the form with details and click the option ‘Register Me’ or ‘Confirm’.

Figure 7.6 : Create an account dialog box for gmail

If the details filled are NOT according to the questions asked then
the host website shows an error message. An error will also result if
the e-mail address you are attempting to make is already used by
someone else. Each e-mail address is a unique address.

1. After the e-mail address has been created, the host website will
congratulate and show a welcome screen and then will move on to
our account (Figure 7.7).

Figure 7.7 : Inbox showing a mail from the host website
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7.5.3 HOW TO LOG TO AN E-MAIL ACCOUNT

To send or receive mails, we have to login to our e-mail account as
follows:

• Open the website and type in the e-mail id and the password in the
textboxs for user and password respectively (Figure 7.8).

• Click on ‘sign in’. We are now logged in provided we have typed in
the correct e-mail-id and password.
Once logged in, we may expect a web page which looks similar to

the one shown in Figure 7.9.

Figure 7.8 : Login into an e-mail account

Figure 7.9 : Inbox displaying the mails received

To enter the login
name and password

To check in mails
received



The Internet

175175175175175
Figure 7.10 : Sending mail

7.5.4 RECEIVE MAILS

To see the mails received, click on Inbox. A number against the Inbox
indicates the number of unread mails. Once the Inbox is open, we
shall see all the mails listed there.  To read a mail, we need to just
click on the mail that we wish to read.

After going through the mails we can either let them remain in our
account for future reference or we can also delete the same. There are
options for deleting or transferring them to trash. Trash is a folder
where we keep the mails to be deleted.

7.5.5 SENDING E-MAILS

To send an e-mail, both the sender and receiver must have an e-mail
account. To send an e-mail, follow the steps listed below:

1. Click on the ‘Compose’ option.
2. Enter the e-mail address of the receiver against any of the three

options - To , CC and BCC.
• To: Address(es) mentioned in this box are visible to every receiver.
• CC: stands for Carbon Copy. The mail will be sent to the To

address as well as CC address. The addresses typed in To as
well as in CC are visible to all other receivers.

• BCC: Stands for Blind Carbon Copy. Each user whose addresses
are typed in BCC is unaware of the fact that the same message
has also been sent to others.

Instead of typing in the address, we can also insert the same from
the address book (Section 7.5.7) :

1. Click Insert Address or Address Book.
2. Select the addresses by Checking (ticking) them.
3. Click OK or Insert option to insert the address in the recipient mailbox.

3. Write in the message in the text box as indicated in the figure
4. After typing in the message click on send option as indicated in

the figure 7.10.

To quit

Receiver’s
Address

Send button

Button to write/
compose a mail

Enter Subject

For Attachments
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In order to close the e-mail session, we can click on options like
logout or sign out.

7.5.6 SENDING FILES AS ATTACHMENTS

An e-mail can contain other files attached to it. Files can be attached
using the following steps:

1. Click the Compose button.
2. Click Attach a file button (Figure 7.11).
3. Click Attach another file to attach more than one file (up to a certain

limit set by the website).
4. Type in the other details like receiver’s address and the textual

message and click the Send button (Figure 7.10).

Once an e-mail account has been created, we can check the mail
from any place anywhere in the world, provided we are connected to
the Internet.

Figure 7.11 : Selecting and attaching files to be e-mailed

7.5.7 ADDRESS BOOK

Just like we store the address of our friends and relatives in an address
diary, the host website provides us the facility to store e-mail addresses
of our contacts.

Add Contact

1. Click on the Contacts option.
2. Click on Create-Contact button to add any new contact.
3. Fill in the details and click on Ok, Add or Save button (different

sites may provide different options).

Figure 7.12 shows all the contacts of the user.

Attached files
Click here to
attach files

Dialog window to
select the files to

be attached
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Remove Contact

To remove a contact from the address book,

1. Click on the Contacts option.
2. Select the addresses to be deleted by clicking on them.
3. Click Remove or Delete Button to remove the selected contact(s).

7.6 DOWNLOADING FILES

While working on the Internet, any web page can be seen in the browser
window only after it has been copied to the main memory of the
computer. This process of copying web pages from the Internet to the
computer is called downloading. Apart from the web pages which are
downloaded whenever we type in the address or click on its link, we
can also download files from the Internet.

7.6.1 HOW TO DOWNLOAD FILES?

One popular use of the Internet is downloading software files and their
updates. There are a number of ways in which a file can be downloaded:

• There may be a download button which can be clicked. Click and
follow the instructions that appear on the screen for downloading
the particular software.

• A web page can be saved by selecting ‘Save’ or ‘Save As’ option.
• Right click a link and then choose the option ‘Save Target As’

(Figure 7.13).
• Hold the Shift Key and click the link. This opens up another download

window from where we can save the file.

Figure 7.12 : Address book

Remove
Contact

Create/add a
contact

Contact
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The above image shows the popup
menu which appears when one right
clicks a hyperlink. The ‘Save Target As’
is the selection needed for saving.

Some files may be in compressed
form having extensions like .zip, .tar, rar,
etc. Such files need to be decompressed
after downloading using software meant
for this purpose. An example of such
software is WinZip.

Apart from downloading files, we can
also save some pictures or texts.

1. To save pictures:
(a) Right click on the picture.
(b) Choose the option ‘Save picture’ from the popup menu.
(c) Save the picture at the desired location when the dialog box gets

opened up.

Note : Picture or file can be saved with the same name as provided
by the website or using a different name.

2. To save the text:
(a) Entire text from a web page can be copied to a word processor

file by choosing Select All option from Edit menu. Choose Copy

option from Edit. Open a blank document file in the word processor
and select the Paste option from the Edit Menu.

(b) To copy only a part of the text from a web page, select the text or
matter to be copied. Once selected open a blank document and
paste as above.

2. We can directly set the picture seen on the Internet as the background
image of our computer. Right click on the picture and select the
option ‘Set As Background’.

7.7 E-SERVICES

There is a wide range of services provided by the Internet like search
engines, chatting and e-mail which we have discussed before, others
are e-banking, e-learning, etc. which are discussed below.

7.7.1 E-BANKING

Almost all the nationalised banks have started providing their services
online. This means you can have a bank transaction through Internet.
E-banking is a facility that allows you to conduct your banking
transactions online with a laptop or computer with an Internet
connection. Every user is allotted a unique user id and password by
the bank for this purpose.

Figure 7.13 : Downloading a file
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The account holder can view account balances and transaction
statements, transfer money between accounts in the bank, pay utility
bills at any time of the day and from any place, can take printouts of
financial-statements, and many more.

7.7.2 E-LEARNING

E-learning deals with educating people online with the help of the
Internet. Development in this field has led to the formation of virtual
classes and online sessions. A teacher can teach many students at the
same time sitting at different geographical locations. Such classes
may be open to all, or may require prior student registration.

“... the effective teaching and learning process created by combining e-digital content

with local community and tutor support along with global community engagement.”

 http://cbdd.wsu.edu/edev/Kenet_ToT/Unit1/WhatseLearning.htm

E-Learning can be delivered in different ways:

1. At the time of learning teacher and students both are to be online.

Video Lecture : The teacher or instructor can take a class while
students can see and listen to him/her. For such a classroom a web
camera is required at every terminal.

Textual Lecture : The teacher can take a class by passing his lectures
as text and students providing textual response. Students can post
their queries online and can get the response instantly.

2. At the time of class both teacher and student need not be online at
the same time.
(a) The teacher can send the lecture using tools like explain these

and blogs online to the students.
(b) The students can read their lessons online. If they have any

queries then they can mail their queries to the teacher’s account.

Summary

• The Internet is a net consisting of complex network of computers connected by high

speed communication technologies.

• The Internet has penetrated and benefited every field – be it education, sports, news,

business, etc.

• A web page can be designed using HTML.

• The Internet has converted the world into a global village.

• The Internet has led to faster globalisation. A web page is an electronic document that

we can see on the Internet.
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EXERCISES

SHORT ANSWER TYPE QUESTIONS

1. Write steps for adding a contact to an email account.

2. What is the Internet?

3. What is the full form of ARPANET?

4. What is the acronym for electronic mail?

5. Define e-commerce.

6. What do you mean by the term m-commerce?

7. What do you mean by the term protocol?

8. What is e-banking?

9. Describe the term e-services.

10. What is a modem?

11. What is a router?

12. Differentiate between e-commerce and m-commerce.

LONG ANSWER TYPE QUESTIONS

1. Who governs the Internet? Discuss in detail.

2. Explain any three applications of e-commerce.

3. Explain any three applications of m-commerce.

4. How would you add an address in an address book?

• Web browser is software required to view web pages.

• Mosaic was the first web browser.

• www is stand for World Wide Web.

• Electronic mail can be sent and received through any e-mail account.

• Downloading is saving of files from the Internet to our computer.

• Attachments are the extra files that we can send with our email.

• E-commerce stands for electronic-commerce which means buying and selling over the

Internet.

• M-commerce is an emerging field which stands for mobile commerce.

• Teleconferencing is having online conference with the facility of exchanging thoughts

using an audio.

• Videoconferencing means having online conference with the facility of seeing and

listening to other participants.
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5. Explain the use of the Internet in our daily lives.

6. Write down the steps required to create an e-mail account.

MULTIPLE CHOICE QUESTIONS

1. Modem speed is measured in

(i) Gbps

(ii) Tbps

(iii) Kbps

(iv) Pbps

2. URL stands for

(i) Uniform Research Limited

(ii) Uniform Resource Locator

(iii) UniLine Resource Labs

(iv) Uniform Research Locator

3. Field involved in adding mobility to the area of commerce

(i) Mobile Business

(ii) M-Commerce

(iii) Hand to hand commerce

(iv) Mobile Communication

4. Learning online through Internet is also known as :

(i) E-teaching

(ii) Virtual classes

(iii) E-learning

(iv) Videoconferencing

5. E-commerce, e-learning, e-banking, m-commerce are some of the

(i) e-services

(ii) Internet services

(iii) User services

(iv) Business services

Activities

Activity 7.1

• Create an e-mail account on any one of the websites (for example www.gmail.com,
www.yahoo.com, www.indiatimes.com,  www.rediffmail.com, etc.)

• Add the email addresses of your friends in the address folder.

Activity 7.2

Send an e-card to your friend on his/her birthday (you can search for e-cards on websites
like : www.123mountaingreetings.com, etc)

Activity 7.3

You have to write a mail to your friend as a reply for the mail received from him. Try
replying to your friend using the option ‘Reply’ present on your email account. This
option can be seen on the top of the mail-box. How does this method differ from the
normal method of reciprocating?



Activity 7.4

You have received an e-mail that is very interesting or informative. You want to send
this mail to other friends as an email. Try to send this mail to other friends using the
option ‘Forward’ present on the top of the email account.

Activity 7.5

‘E-Teaching’ is an upcoming learning tool. Surf for e-learning sites on the Internet and
create a report.

Activity 7.6

Trace your location on the globe using programs like Google Earth,

APPENDICES

APPENDIX 7.1 : TO CREATE AN E–MAIL ACCOUNT

1. Click on the option ‘Sign Up’ or ‘New User’.

Figure 7.14 :  Logging on to Google for Creating email account

2. A web page containing a form opens up in your browser. Fill in the form with
details and click the option ‘Register Me’ or ‘Confirm’.

To  Sign Up
as a new user
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If the details filled are not according to the questions asked then the host
website shows an error message.  An error will also result if the email address
you are attempting to make is already used by someone else. All email addresses
must be unique.

Figure 7.15 :  Create an account dialogue box

Figure 7.16 : Confirmation of the account created in the inbox

3. After the email address has been created, the host website will either

congratulate you/show a welcome screen and will move on to your account.

The Internet
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APPENDIX 7.2 : SIMPLE MAIL TRANSFER PROTOCOL

Simple Mail Transfer Protocol is a TCP/IP protocol used in sending
and receiving e-mails. However, since it is limited in its ability to
queue messages at the receiving end, it is usually used with one of two
other protocols, POP3 (Post Office Protocol 3) or IMAP (Internet Message
Access Protocol) that let the user save messages in a server mailbox
and download them periodically from the server. In other words, users
typically use a program that uses SMTP for sending e-mail and either
POP3 or IMAP for receiving e-mails. On Unix-based systems, Sendmail
is the most widely-used SMTP server for e-mail. A commercial package,
Sendmail, includes a POP3 server. Microsoft Exchange includes an
SMTP server and can also be set up to include POP3 support.

SMTP is usually implemented to operate over Internet port 25. An
alternative to SMTP that is widely used in Europe is X.400. Many mail
servers now support Extended Simple Mail Transfer Protocol (ESMTP),
which allows multimedia files to be delivered as e-mails.

APPENDIX 7.3 : POINT-TO-POINT PROTOCOL

The Point-to-Point Protocol, or PPP, is a data link protocol commonly
used to establish a direct connection between two nodes over serial
cable, phone line, trunk line, cellular telephone, specialized radio links,
or fiber optic links.

PPP also established a standard for the assignment and management
of IP addresses asynchronous (start/stop) and bit-oriented synchronous
encapsulation, network protocol multiplexing, link configuration, link
quality testing, error detection, and option negotiation for such
capabilities as network layer address negotiation and data-compression
negotiation. PPP supports these functions by providing an extensible
Link Control Protocol (LCP) and a family of Network Control Protocols
(NCPs) to negotiate optional configuration parameters and facilities. In
addition to IP, PPP supports other protocols, including Novell’s
Internetwork Packet Exchange (IPX) and DECnet.
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SOFT SKILLS FOR

EFFECTIVE

COMMUNICATION

Introduction

After completing this Chapter, the

student will be able to:

• identify various soft skills,

• understand the structure and

processes of effective

communication,

• relate soft skills with effective

communication,

• write clearly and concisely,

• communicate effectively, build

rapport and relate well with all

kinds of people,

• facilitate and support the

professional growth of others,

• focus efforts energetically on

meeting a goal, mission or

objective,

• utilise logical, systematic and

orderly procedures to meet

objectives,

• work effectively and productively

with others and

• prepare an action plan to improve

effectiveness of his/her

communication.

8

Having knowledge, i.e itself is not enough, we need
to communicate it to others effectively. In fact
effective communication is one of the keys to
success.  By successfully getting our message
across, we convey our thoughts and ideas
effectively. The message is the information that
we want to communicate. It is essential to be
technically sound, but we should also have the
ability to express and communicate our ideas
clearly and effectively to others in the simplest
possible manner. Effective communication and soft
skills not only improve our relationships with
others, but they also improve our efficiency.

We have learnt in earlier chapters what
communication is and how messages can be
communicated through various technical skills
(also called hard skills), like electronic word
processing/presentation, the Internet, etc., and a
few more will be discussed in the next unit on
Web Publishing Technologies. In this chapter we
discuss what soft skills are and how these could

Objectives “Think like a wise man but communicate in the

language of the people.”

William Butler Yeats

Nobel Prize winner for literature in 1923 and founder of the

Irish National Theatre Company at the Abbey Theatre, Dublin.
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8.1 WHAT ARE SOFT SKILLS?

Soft or social skills (also called non-technical skills) are those personal
values and interpersonal skills that determine a person’s ability to
work well with others in a project team. Soft skills are needed to deal
with the external world and to work in a collaborative manner with
one’s colleagues. These skills include effective communication,
leadership, and teamwork skills; demonstrating problem solving
abilities, initiative, and motivation skills; displaying honesty and strong
work ethics.

Soft skills play a vital role for academic and professional success;
they help us excel in the workplace and their importance cannot be
denied in the emerging information or knowledge society. Soft skills
are needed to deal with the external world and to work in a collaborative
manner with one’s colleagues.

8.1.1 TYPES OF SOFT SKILLS

There are various components that comprise soft skills. Some are inborn
such as confidence, friendliness and whether or not someone has a
sociable nature, while others are skills that can be taught or improved
upon, such as developing effective communication, organisation, and
social graces.

A large number of soft skills are known today. However, a different set
of soft skills is required for a specific type/nature of work. For our
purpose these may include the following:

• communication skills
• listening skills
• presentation skills
• interpersonal skills
• team skills
• leadership skills
• etiquette
• cross-cultural skills
• language skills, etc.

Some of these are discussed in subsequent paragraphs.

Communication Skills

The ability to communicate ideas to others effectively is an absolute
essential requirement for our career building. Speaking clearly and
coherently will allow effective verbal communication with others. How
we speak is more influential to the person who we are communicating
with than what we actually say, so we should be careful  about our

be used for effective communication in the context of computer/IT
mediated communication.
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body language and tone of our voice when we are talking.
Communication is a two–way process. Listening is therefore an
essential skill too. Listening is more than just hearing what is being
said. Effective listening encourages others to listen to us and respond
to what we say. If communication skills are an area that we feel we
could improve on, we should set about identifying ways in which we
could develop them. Communication subsumes delegation, listening
and presentation.

The ability to present comprehensive written ideas will enable us
to put forward professional documentation of our thoughts and is a
highly regarded skill. If we write so that misinterpretation is minimised
we will find that people are far more receptive to our suggestions.

Effective communication skills are something every one needs to
possess. Verbal communication skill includes a one-to-one interaction,
presentation/public speaking ability, and good telephonic skills. Written
communication would include program writing, report writing, letter
writing and e-mail etiquette, etc.

8.1.2 HOW TO DEVELOP SOFT SKILLS?

Developing soft skills needs practice. These are acquired and
experienced on the spot. Soft skills cannot be acquired by merely
reading textbooks. The soft skills we gain equip us to excel in our
academic/professional life and in our personal life. It is a continuous
learning process.

Development of soft skills has two parts. One part involves developing
attitudes and attributes, and the other part involves fine-tuning
communication skills to express attitudes, ideas, and thoughts. Perfect
integration of ideas and attitudes with appropriate communication skills
in oral, written, and non-verbal areas is necessary for successful work.
Attitudes and skills are integral to soft skills. Each one influences and
complements the other.

8.1.3 HARD SKILLS VS SOFT SKILLS

Hard skills are technical procedures/tools related to our field. Examples
include work place productivity tools (Unit II), computer protocols, etc.
These skills are typically easy to observe, quantify and measure. By
contrast, “soft skills” are typically hard to observe, quantify and
measure. Soft skills complement hard skills, which are the technical
requirements. Soft skills are as important, if not more important, than
traditional hard skills at our work place.

8.2 COMMUNICATION

We know that communication is to get our message across to others
clearly and unambiguously and it is most important for our progress.
For this, we must understand what our message is, who the audience
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Information is giving out while communication is getting through.

Communicate with confidence, clarity and impact.

is and how it will be perceived. We must also weigh-in the
circumstances surrounding our communications, such as the
situational and cultural context.

8.2.1 EFFECTIVE COMMUNICATION

Effective communication and interpersonal skills are crucial to the
success of an academician as they help him in dealing with people at
the emotional level. Effective communication and soft skills not only
improve relationships, but also improve efficiency. Communicating
effectively is characterised by such things as active listening, using
self for messages, conflict management, positive body language, and
asking the right questions.

8.2.2 COMMUNICATION PROCESS

The process of communication involves effort from both the sender and
receiver of the message. Else the process can be fraught with error,
with messages often misinterpreted by the recipient. When the error is
not detected, it can cause tremendous confusion, wasted effort and
missed opportunity.

Problems with communication can pop-up at every stage of the
process. To be an effective communicator and to get our point across
without confusion, our goal should be to lessen the frequency of these
problems at each stage. This can be done through clear, concise,
accurate, and well-planned communications.

The communication process consists of basic components like
sender, encoding, channel, decoding, receiver, and feedback and
the context.

Sender

As the source of the message, we need to be clear about why we are
communicating, and what we want to communicate. We also need to
be confident that the information we are communicating is useful and
accurate.

Encoding

This is the process of transferring the information we want to
communicate into a form that can be sent and correctly decoded at the
other end. One must be careful about cultural issues, mistaken
assumptions, missing information, etc.
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Channel

Messages are conveyed through channels which may be verbal,
including face-to-face meetings, telephone and videoconferencing and
written, including letters, e-mails, memos and reports. Different
channels have different strengths and weaknesses. For example, it is
not effective to give a long list of directions verbally.

Decoding

Just as successful encoding is a skill, so is successful decoding
(for example, taking the time to read a message carefully, or listen
actively). Confusion can arise from errors in encoding as well as
decoding. This is particularly the case if the decoder does not have
enough knowledge to understand the message.

Receiver

Our message is delivered to individual members of our audience. No
doubt, we need to be aware of the actions or reactions we hope our
message will get from them. We need to bear in mind, though, that
each of these individuals enters into the communication process with
his or her own ideas and feelings that will undoubtedly influence their
understanding of our message, and thereby, their response. To be a
successful communicator, we should consider this before delivering
our message, and act appropriately.

Feedback

Feedback is obtained by monitoring response of the receiver to the
message. Our audience will provide us with the feedback, may be in
the form of verbal and non–verbal reactions to our communicated
message (Figure 8.1). Pay close attention to these feedbacks. These
feedbacks are the only things that allow us to be confident that our
audience has understood our message. If we find that there has been a
misunderstanding, at least we have the opportunity to send the message
a second time.

Figure 8.1 : An illustration to explain how important feedback is – some illustrations of non-verbal

cues reflecting whether the information is well received or not (facial epressions/hand signs/

body gestures)

How are you...

I am fine...

thank you...

Heyyyyyyy what are

you dooooooing...

What are youuuuuu

saaaaaying...

I am not able to Hear

youuuuu...
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8.2.3 COMMUNICATION MODELS

Various communication models have been proposed for the
communication process. The simplest of these, the sender-receiver
models are discussed  here.

Basic Communication Model

This model (Figure 8.2) is useful when the movement of information
across space and through time is a central challenge. Since the model
looks at communication from a message point-of-view, its usefulness
is limited when the information exchange is so complex that it cannot
be isolated into message units.

Figure 8.2 :  Basic Communication Model

Interaction Communication Model

In a two-way communication/dialogue the source and receiver change
positions and messages bounce back and forth (Figure 8.3).

Figure 8.3 : Interaction communication model

The above model can be simplified as shown in figure 8.4.

Figure 8.4 : Interaction communication model (Simplification)
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These are successful only when both the sender and receiver understand the
same information.

8.2.4 CONTEXT

In a communication, there is some minimum shared context. We might

be in the same physical location. Even over the phone we have, at the

minimum, the commonality of time. When we generate a document

paper, usually there is some context embedded in the medium: the

text is in the proceedings of a conference, written on a birthday card,

handed to our teacher with a batch of too westernised term papers, or

something similar.

8.3 COMMUNICATION THROUGH E-MAIL

With e-mail, we cannot assume anything about a sender’s location,

time, frame of mind, profession, interests or future value to us. This

means, among other things, that we have to be very, very careful about

giving our receivers some context. This section will give specific
strategies for doing so.

8.3.1 USEFUL SUBJECT LINES

A subject line that pertains clearly to the body of the e-mail will help

people mentally shift to the proper context before they read our message.

The subject line should be brief (as many mailers will truncate long

subject lines), does not need to be a complete sentence, and should

give a clue to the message contents. For example:

Subject : Need 3 Cars on Tuesday

Ramesh – I need three cars for Thursday’s demonstration in

Delhi.  They need to be petrol engine cars, and they need to

be packed for shipping by Tuesday night.

Here the subject line summarises effectively the most important

details of the message. If the message is in response to another e-mail,

our e-mail software will probably preface the subject line with Re: or

RE: If our e-mail composition software does not do this, it would be

proper to put in RE: by hand.

Subject : Re : Need 3 cars by Tuesday

Abdul – I have got two cars already packed from last week’s

demo, but I do not have another functional petrol engine

right now.  Can you manage with two-petrol engine and one

diesel engine car?

For time-critical messages, starting with URGENT is a good idea

(especially if we know the person gets a lot of e-mails):
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Subject : URGENT : Need petrol engine cars

I need to have another petrol engine car for the Mumbai

demo, by tomorrow afternoon.  Ramesh only has two, and I

have to have three. Therefore, if anyone could help in this

regard I would really appreciate it!

For requests, starting with REQ : can signal that action is needed:

Subject : REQ : Petrol cars required

Abdul’s call for a petrol engine car. Please check in your

garage. You have seven of them with you that you are no

longer using. Please take a moment to look around your

area for petrol engine cars that you are no longer using, and

get them back to Ramesh.

If we are offering non-urgent information that requires no response
from the other person, prefacing the subject line with FYI: (For Your
Information) is not a bad idea, as in

Subject : FYI : Sweets in break room

Arti has left some sweets downstairs in the break room.

First come, first served!

8.3.2 INFORMATION

We should eliminate the word “information” from the subject lines
(and may be from the body of the message as well) since it may be
misleading to the reader. An example to explain the point:

Subject : information

Please send me information about Indian Institutes of

Technology (IIT).

This gave the reader very little clue as to what the person wanted
to know: admission, application or deadlines? The number of students?
The number of buildings? Was the reader supposed to send paper
documents or give URLs? The only thing one could do with an e-mail
like this was ask for further context. Mail like this would have been
much better as:

Subject : Indian Institutes of Technology Admissions Process (IIT)

Are there any web pages about admission process to IITs?

8.3.3 QUOTING DOCUMENTS

If we are referring to previous e-mail, we should explicitly quote that
document to provide context. Instead of sending e-mail that says:

Did we get all the information that we required?
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Say :

> Did we get all the information that we required?

The greater-than sign (>) is the most conventional way to quote
someone else’s e-mail words, but different e-mail software may use a
different convention. Even if there are a fair number of words in our
response, we still might need to quote the previous message.

Key Points

We may know what we are talking about, but our readers may not. Give them
the proper context by:

• Giving useful subject lines
• Avoiding pronouns in the first few lines
• Quoting the previous message or document that has been used or referred to.

Use simple and clear words that directly indicate the purpose instead of
ambiguous phrases that have the chance of being understood differently.

8.3.4 IDENTIFICATION

When one gets an e-mail from strangers, more care should be taken
about what connection they have with the reader than how the reader
is addressed in the mail. For instance when we send an e-mail to
someone who does not know us, it would be good if we would immediately
answer these questions:

• How did we learn about our correspondent?
• What do we want from our correspondent?
• Who are we?
• Why should our correspondent pay attention to us? (If we cannot

answer this question, we should wonder if we should even send
the e-mail).

Putting some of that information in a signature is better than
nowhere at all, but putting it at the top is better for several reasons:

• Our identity is an important clue to the context of the message.
• If there is a problem with the transmission of the e-mail, the end is

much more likely to get lost than the beginning.
• Many people get more than twenty messages per day, and so read

them quickly. If we do not quickly establish our identity, our
correspondent may delete our message before they find the
underlying cause of the mail.

Good answers to the questions can take several forms:

Dear Ms Suman, I am an editor at Very Large Publishing

Company, Inc. I sat next to your brother on Air India last week,

and he mentioned that you are interested in publishing a book
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based on your e-mail guide. I have read your guide, and would
be very much interested in receiving a proposal from you.

Alternatively:

My name is Vijay and I am the legal counsel for Suraksha
Security Services.  We are deeply disturbed at the allegations

that you cast upon us in your e-mail guide.  Therefore, we
order you to immediately cease and desist using any
reference to Suraksha Security Services in your e-mail guide.
If you do not, we will be forced to file suit against you or
your descendants.

Another form of e-mail could be:

Hi - I am a novice e-mail user and just read your e-mail
guide.

I don’t know if you are the right person to ask or not, but do

you know what the French word for “Mister” is If you can tell

me the answer, I will send you a funny postcard.

Signatures

Many e-mail programs allow setting up a default signature to be
included at the end of every message. Many people use these
signatures as an easy way to give their name and alternate ways of
reaching them. For example:

Hi - when do you want to go for lunch?

Suresh Gupta,

Managing Director,

Suraksha Security Services,

Wilson Street,

Delhi – 110001

Telephones: +91 11 –12346578/79

Fax: +91 11- 12345689

E-mail: suresh.g@suraksha.sec.com

Website: www.surakshasecurities.com

Such an extensive amount of signature information in contrast to
such a short question looks unwanted. If they got the e-mail from you,
they can reply by e-mail. So they do not need our FAX number or street
address. (If they have to send a FAX or package, they can ask for address
information.) They already have one e-mail address in the message we
sent, and don’t need our other e-mail addresses.
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The name is perfectly reasonable to include, especially if

• Our e-mail messages do not include our full name in the From:

line. (Send yourself an e-mail to see if our name is there or not.)

• The name in the From: line doesn’t match the name we actually

use

• The e-mail account is shared by multiple users (two persons having

a joint e-mail account, for example).

The telephone number is also a reasonable thing to include - if we

are willing to be interrupted by phone calls. Emotions are easier to

convey over the phone, and some people prefer phone to e-mail for all

circumstances.

If the message is business related, including the company name is

a reasonable thing to do - even if the message is going to someone else

in the same company.

One thing that is important from Vijay Gupta’s signature above is

that one would like to see is his job title. Is he the vice-president of

sales or the shipping clerk? That may have more of an influence on the

correspondent than anything else may. That signature is still overkill

for arranging lunch, but it is not always convenient to switch between

having our signature included or not.

Some people put things purely for entertainment in their signature:

artwork, philosophical sayings, jokes, and/or quotations in their

signature. This may be all sight, but do not overdo it.

After setting up a signature that is included automatically, it is

easy to forget about it. Therefore, whenever a piece of contact information

changes, make sure to revisit the signature to make sure that it is still

up-to-date. In addition, if there is an entertainment piece in signature,

change it occasionally. It will not be as funny the fiftieth time our

coworker saw it as it will be the first time.

One final note on signatures : there is a good way to let our

correspondent know that the entire message was transmitted properly.

There is no body language to signal that we are “done talking” and,

unfortunately, e-mail transmissions are sometimes interrupted.

Separators

Many people put pretty separators – lines, horizontal bars, and so on –

around their signatures. For example:

Vijay Gupta – – – – – | Company Secretary, Suraksha Security Services.

+91 11- 12346578/79 voice | +91 11 123465789-fax
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These are very pretty for normal (sighted) person, but imagine what
it would be like for people who are visually challenged and that they
have their computer read their e-mail to them: “hyphen hyphen hyphen
hyphen hyphen hyphen...”

That said, some e-mail programs recognise “—” as a signature
separator, and so can process the signature differently. Technically,
the signature is supposed to be two hyphens plus a space, but it is
very common to see just two hyphens without the space.

While sending e-mails to familiar people, some people often avoid
the signature mentioned above, and simply end with words like Regards

followed by their name.

Key Points

If we are well known to our correspondent, we can probably get away without
including extra identification. In other cases, we should provide our correspondent
with enough clues to figure out who we are, why we are writing, and why he or she
should pay attention to us. Preferably, this information will be at the top of the
message.

Greetings are difficult to do well, especially if we are crossing cultures and/or
languages.

8.3.5 AUTO MESSAGE RESPONDER

Many times, it is seen that there is an unprecedented delay in
responding to the mail due to travelling or non-availability. It is essential
to activate our auto e-mail responder option, while we are away and
we cannot check our inbox. This will inform the e-mail sender about
our availability status and he/she can then act accordingly, instead of
impatiently waiting for a reply from our end and suffering. An example
could explain it more clearly:

To:

From : Self

Subject : Away for an assignment to Manali

Dear All,

I will be away on an assignment to Manali for five days and

would be unable to access my mailbox. I would respond to

your mail when I get back. In case of an urgency, please get

in touch with Mr. Sameer Singh at

sameer.s@suraksha.sec.com

Regards

Vijay
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This will help the sender in making his/her decisions accordingly.

Some thumb rules for writing an effective e-mail (net etiquette):

1. Think before writing.
2. Keep the message concise.
3. Remember that e-mail is not necessarily confidential. Some companies retain

the right to monitor employees’ messages.
4. Do not attempt to “discipline” the reader. It is unprofessional to lose control

in person – to do so in writing usually just makes the situation worse.
5. Do not “spam”. Do not send unnecessary or frivolous messages. Soon, people

will quit opening any message from you.
6. Do not type in all caps! It looks like we are yelling at the reader!
7. Do not type in all lower cases. If we violate the rules of English grammar and

usage, we make it difficult for the reader to read.
8. Use indicative “Subject” line to get the readers’ attention. e.g.” Information

on XYZ Project,” or “Status Report Q1”
9. Take the time to proof read the document before sending it.

8.3.6 E-MAIL ATTACHMENT SIZE

E-mails are used for a host of purposes, for exchanging information in
the form of images and other multimedia files. Due to this, many times
senders attach heavy files in the form of photographs or MP3s that
clog the inbox of the receiver. As an effective e-mail user, one should
always see and assess the size of attachments that should be sent
along with the mails. In unavoidable circumstances, it is best to confirm
with the receiver before we send a heavy attachment.

8.4 TIMELINES AND CULTURAL DIVERSITY

E-mails are now one of the fastest media of communication globally. In
this section, we will try to understand the importance of co-existence
of various cultures and time-lines within which we function. For
instance, in some cultures it is appropriate to be to the point in a
conversation; while in others we may be required to include the
greetings and salutations and the background before we actually come
to the main point of conversation.

An effective e-mail communicator always keeps in mind the comfort
of the receiver of the e-mail. Keeping the timelines in mind is not
necessary while writing an e-mail but one should keep timelines in
mind while making a phone call. For instance, it would be inappropriate
to call someone in US while it is morning in India, since it will be late
night in the US.

8.5 GREETINGS AND SALUTATIONS

Interestingly, even in the Indian context, we find cultural diversity.
There are different ways in which people greet and acknowledge each
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other. So an effective communication would include careful usage of
greetings and salutations even if we are sending some documents or
information from north to south or from, east to west of our own country.
A careful selection of openers and closers of a document makes the
whole document more interesting and effective at the same time.

Every new medium develops its own protocols or rules for opening

and closing. Telephone conversations start with “Hello” and end with

“Goodbye”. Letters open with “Dear” and end with “Sincerely”. However,

even though e-mail is so often used for communication, there is no

firm custom on how to open and close the same. Many people do not

give either a salutation or a signature. After all, while a letter can be

separated from its envelope easily, it is difficult to separate the body of

an e-mail message from its addressing information. The e-mail message

itself says who it is for and from whom.

In this chapter, we will learn some of the commonly practiced

thoughts on openers and closers, but we need to think carefully

about what we are trying to convey both explicitly and implicitly. We

also need to take the culture and customs of all parties into

consideration.

Salutations are tricky, especially if we are crossing cultures.

Frequently, titles are different for men and women, and we may not be

able to decide how to  address. The family name is first in some cultures

and last in others. Honorific may vary based on status or age. So do

not feel bad if we have trouble figuring out which salutation to use: it

is a difficult problem.

In some countries, it is a bad idea to use “Sir” or “Mr.” unless we

are certain that our correspondent is male. While in some others, a

‘Dear Sir’ is an accepted salutation. Similarly, it is probably safer to

use “Ms” instead of “Miss” or “Mrs.” unless we know the preference of

the woman in question.

In non-formal e-mail transaction, we often use “Hi” or “Dear” to

address the recipient along with their first name.

Given that e-mail is relatively informal, frequently there is no

problem in dispensing with names and titles altogether, especially if

we are in a position of higher status than our correspondent:

Hello - I saw your website and wanted to mention that

I invented the fountain pen on Apr 29, 1803, *not* on Apr

28, 1802.

Many people use a simple “Hi” for those they already know:

Hi - Are you going to school next week?  I can bring all my

project reports there…… .
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“Good Morning” and “Good Afternoon” do not make a lot of sense
with e-mail, as the sun may have moved significantly by the time our
correspondent gets around to it.

8.6 REMOVING BARRIERS AT ALL THESE STAGES

To deliver our messages effectively, we must commit to breaking down
the barriers that exist in each stage of the communication process. Let
us begin with the message itself. If our message is too lengthy,
disorganised, or contains errors, we can expect the message to be
misunderstood and misinterpreted.

Barriers in context tend to stem from senders offering too much
information too fast. It is best to be mindful of the demands on other
people’s time, especially in today’s ultra-busy society. Once we
understand this, we need to work to understand our audience’s culture,
making sure we can converse and deliver our message to people of
different backgrounds and cultures within our own organisation, in
our country and even abroad.

8.7 WRITING SKILLS

Many people are intimidated by writing. Even so, there are times when
writing is the best way to communicate, and often the only way to get
our message across. While writing, remember that once something is
sent in written form, it cannot be taken back. This presents written
communicators with additional challenges, including spelling,
grammar, punctuation, even writing style and actual wording.

Thankfully, today’s technology makes memo, letter and proposal
writing much easier by providing reliable tools like word processors
that check and even correct misspellt words and incorrect grammar.

8.7.1 THE IMPORTANCE OF “ETIQUETTE”

Some of the most basic tips to remember when writing include:

• Avoid slang words
• Try not to use abbreviations (unless appropriately defined or widely

accepted)
• Steer away from symbols (such as ampersands [&])
• Clichés should be avoided, or at the very least, used with caution
• Brackets are used to play down words or phrases
• Dashes are generally used for emphasis
• Care should ALWAYS be taken to spell the names of people and

companies correctly
• Numbers should be expressed in words when the number is less

than 10 or is used to start a sentence (example : Ten years ago,
my brother and I…). The number 10, or anything greater than 10,
should be expressed as a figure (example : My brother has
13 matchbox cars.)
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• Quotation marks should be placed around any directly quoted speech
or text and around titles of publications

• Keep sentences short.

While these tips cover the most common mistakes made when
writing letters, memos and reports, they in no way cover everything
we need to know or ensure that our written communications are
accurate and understood.

Netiquette primarily involves any communication we may send out or receive from
the Net.

8.7.2 LETTER WRITING SKILLS

When writing letters, it is best to address the letter to an individual.
Moreover, when beginning the letter with a personal name, be sure to
end it with an appropriate closing, such as ‘yours sincerely’. If we
cannot obtain an individual’s name, consider ending it with a more
generic (less personal) closing, such as ‘yours faithfully’.

Normal business letters should start with an overall summary,
showing in the first paragraph why the letter is relevant to the reader.
It is not a good practice to make the reader go past the first paragraph
to find out why the letter was sent to them.

The body of the letter needs to explain the reason for the
correspondence, including any relevant background and current
information. Make sure the information flows logically, ensuring that
we are making our points effectively. The closing of the letter is the
final impression we leave with the reader. End with an action point,
such as ‘I will call later this week to discuss this further’.

8.8 THE IMPORTANCE OF CAREFUL PROOFING

Perhaps the most important thing to remember when writing a letter
is to check it thoroughly after it is completed. This “unwritten” rule
holds true for everything we write – memos, letters, proposals, etc.

We should use both the grammar and spell check on our computer,
paying close attention to every word highlighted. We should not place
total faith on our computer. Instead, we should have both a dictionary
and thesaurus (printed or online) handy to double-check everything
our computer’s editing tools highlight, as these tools are certainly not
always reliable in a given context.

Is our written communication well organised? Does each idea proceed
logically to the next? Would some additional headings help? We should
make sure our written communications are easy to read and contain
the necessary information, using facts where needed and avoiding
information that is not relevant. We should also, outline the course of
action we expect, such as a return call or visit.
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Finally, we should close appropriately, making sure to include our contact
information. While this may seem obvious, it is sometimes overlooked and
can make our written communications look amateurish. This can
diminish our chances of meeting our written communication’s goals.

8.9 AUDIOVISUAL COMMUNICATION SKILLS

Computer and Communication Technology have empowered us to digitise
our audio and video inputs and communicate across long and far-reaching
destinations. In most of the audio communications, many users do not
keep in mind certain essential aspects of audio communication and this
results in either miscommunication or no communication. Similarly, in
using a tool for video communication some things should be kept in
mind so that the communication is effective and there is minimal loss of
information intended to be conveyed.

Audio Communication Skills

• Always have a sufficient knowledge of the issue that we are dealing with in the

audio communication and the key points that we have to discuss. (always

remember that the person on the other side can only hear us and respond to our

details).
• Do not use very long sentences, since it is difficult to grasp if the sentences are

too long.

• Always have a modulated pitch of voice, we should stress and emphasise on the

words that we want to convey more strongly than the rest of our communication.

• Make use of key words and terms that are related to the issue in consideration,
this will minimise the understanding time of the receiver of the information.

• Never speak in a jet speed fashion; always speak clearly voicing out each word

and do not leave it for the receiver to understand it on its own.

• Always give sufficient time to listen to what the person on the other side is

saying. Allow the other person also to speak his/her part and then respond to

him/her after s/he has finished.
• Always have a note-book and pen/pencil marker to note some information given

immediately by the receiver

• If we are on multi-people conference call then we should first introduce ourselves

and then deliver the message.

• Use of correct salutation is also important depending upon the regional/global

context of the person/s we are communicating with.
• Summarise the discussion at the end of the meeting.

Video Communication Skills

• In a video communication to one or many person(s), one should always keep in
mind that audio is integrated with video. Hence most points mentioned above
are relevant.

• Dressing up for the occasion is also a part of the communication, since many
times video conferences are formal in nature.
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8.10  ACTIVE LISTENING

Hear What People Are Really Saying

It is obvious that if we have poor interpersonal communications skills
(which include active listening), our productivity will suffer. This is
simply because we do not have the tools needed to influence, persuade
and negotiate – all necessary for workplace success. Lines of
communications must be open between people who rely on one another
to get work done.

Considering this, we must be able to listen attentively if we are to
perform up to expectations, avoid conflicts and misunderstandings,
and to succeed. Following are a few short tips to help us enhance our
communication skills and to ensure that we are an active listeners.

8.10.1  START BY UNDERSTANDING OUR OWN COMMUNICATION STYLE

Good communication skills require a high level of self-awareness.
Understanding our personal style of communicating will go a long way
towards helping us create good and lasting impression on others. By
becoming more aware of how others perceive us, we can adapt more
readily to their styles of communicating. This does not mean we have
to be a chameleon, changing with every personality we meet. Instead,
we can make another person more comfortable with us by selecting
and emphasising certain behaviours that fit within our personality
and resonate with another. In doing this, we will prepare ourselves to
become active listeners.

8.10.2  BE AN ACTIVE LISTENER

People speak at 100 to 175 words per minute but they can listen
intelligently to up to 300 words per minute. Since only a part of our
mind is paying attention, it is easy to go into mind drift - thinking
about other things while listening to someone. The cure for this is
active listening - which involves listening with a purpose. It may be to
gain information, obtain directions, understand others, solve problems,
share interest, see how another person feels, show support, etc. If we
are finding it particularly difficult to concentrate on what someone is
saying, we should try to repeat their words mentally as they say it -
this will reinforce their message and help us control mind drift.

• There should be enough preparation for the occasion so that while communicating,
we should not be looking for any information that is sought by person(s) on the
other end.

• Greeting every one and introducing our selves is essential in video communication
especially when there is more than one person on board.

• Always give an opportunity to others to express themselves in the communication
and allow participation of all.
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8.10.3  USE NONVERBAL COMMUNICATION

Use nonverbal behaviours to raise the channel of interpersonal
communication. Nonverbal communication is facial expressions like
smiles, gestures, eye contact, and even our posture. This shows our
interest to the person we are communicating with.  This will prompt
further communication while keeping costly, time-consuming
misunderstandings at a minimum.

8.10.4  GIVE FEEDBACK

Remember that what someone says and what we hear can be amazingly
different! Our personal filters, assumptions, judgments, and beliefs can
distort what we hear. Repeat or summarise to ensure that we understand.
Restate what we think we heard and ask, “Have I understood you
correctly?” If we find ourself responding emotionally to what someone
said, say so, and ask for more information: “I may not understand you

correctly, and I find myself taking what you said personally”.

8.11  CHUNKING

Grouping information so it is more easily understood

Effective communication is possible when the sender and receiver are

able to exchange desirable information with each other at a timely
rate. Therefore, where the relevant information is and how is it stored

forms a significant component of effective soft-skills in communication.
Think about the amount of information we have to process each day. We
read reports and meeting notes, we discuss problems, we hold team

briefings, and we chat by the water cooler. Some of the information we
receive is easy to understand and retain; some of it is not. The difference

is often in how the information is presented. 

Imagine we are playing the memory game “what’s missing!” In this

game, we simply have to memorise all items that are presented to us
on a tray – then work out which one has been removed. If the items on
the tray are presented in a jumble, will we be able to figure out what is

missing? Instead, if the items are organised according to size, colour
or shape, it will be so much easier to spot what is missing this time!

When the items are categorised, the “information” on the tray is
much easier to make sense of and retain the same. We can skim the
tray and grasp exactly what is being presented. This process of grouping

information so that the intended audience easily understands it is
known as “chunking”.

Evidence that chunking works is all around us:

• Phone numbers and credit card numbers are typically chunked.

Both types of numbers are usually chunked in groups of three or
four numbers.
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Summary

• Soft skills are personal attributes that enhance an individual’s interactions, job
performance and career prospects.

• Soft skills not only include personal skills but also include interpersonal skills.

• Communication is the process of transferring information from a sender to a receiver
with the use of a medium.

• E-mail is one of the most popular communication methods.

• While using e-mails we should be careful about the subject line, content and
identification.

• While writing e-mails we should keep in mind the cultural diversity.

• Active  listening is a way of listening and responding to another person in a way that
improves mutual understanding.

• When we encounter a phone number that is chunked differently
than the way we are used to, it can be much harder to remember it.

• Rather than memorising the letters O – T – M – E – E – R, clubbing
them to the word “REMOTE” makes the task much easier.

When written or verbal information is chunked effectively, it is
logical, organised, and consistent. This enhances the audience’s ability
to understand what is going on. A written format that is chunked gives
readers quick access to the big picture. From there they can get into
the details as needed. And a verbal format that is well structured and
logically chunked helps listener follow and remember key ideas or
details as necessary.

An example of how the mind processing happens:

fi yuo can raed tihs, yuo hvae a sgtrane mnid too Cna yuo raed
tihs? Olny 55 plepoe out of 100 can. i cdnuolt blveiee taht I cluod
aulaclty uesdnatnrd waht I was rdanieg. The phaonmneal pweor of the
hmuan mnid, aoccdrnig to a rscheearch at Cmabrigde Uinervtisy, it
dseno’t mtaetr in waht oerdr the ltteres in a wrod are, the olny iproamtnt
tihng is taht the frsit and lsat ltteer be in the rghit  pclae. The rset can
be a taotl mses and wecan sitll raed it whotuit a pboerlm. Tihs is
bcuseae the huamn mnid deos not raed ervey lteter by istlef, but the
wrod as a wlohe. Azanmig huh? yaeh and I awlyas tghuhot slpeling
was ipmorantt.
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EXERCISES

SHORT ANSWER TYPE QUESTIONS

1. Name some of the stages of communication in which errors may crop in.

2. What is the importance of feedback in communication?

3. List some factors responsible for misinterpretation of messages by the receiver.

4. What is meant by context in relation to communication?

5. What is the use of subject line in e-mails?

6. Why should one be careful about cultural diversity while writing salutation in
an e-mail?

7. What is meant by signature in an e-mail?

8. What is auto message responder?

9. What is an e-mail attachment?

10. Why is proofing important?

LONG ANSWER TYPE QUESTIONS

1. What is the need for effective communication? Elucidate some of the key aspects
by having a group discussion with our fellow classmates.

2. Do we agree that if one has best knowledge of computer tools and techniques
he/she will be a good communicator also? Support our answer with examples
from your experience.

3. What are the various cultural diversities we should be sensitive towards in
our communication with others? Support your answers with examples from
the Indian context or global context.

4. What are the key things that we should keep in mind while sending an e-mail
to a person who requires attachments of multi-media contents.

5. Discuss some etiquette that one should follow while writing.

6. What are the key points that one should remember while video-conferencing?

7. Discuss the importance of listening.

8. With a suitable example, elucidate the meaning of Chunking?

Activities

1. Form two groups with the names “Sender” and “Receiver” and bring out the main points
of effective computer communication technology.

2. Within a group of not more than eight members share examples of “effective e-mail” and
“ineffective e-mail” in your class.

3. If we are making a video-call to a person in Washington, what are the key things that we
should keep in mind? Have a discussion within your peer group to establish the importance
of time-lines and cultural diversity in communication.


